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safety information
These warnings and precautions are included in order to prevent injury to you and others, as well as preventing any 
potential damage to your machine. Be sure to read and understand all of these instructions before using the machine.
Use common sense for operating any electrical appliance and whenever using your machine. Also, follow all warnings and 
instructions marked on the machine and in the accompanying literature. After reading this section, keep it in a safe place 
for future reference.

Important safety symbols

This section explains the meanings of all icons and signs in the user's guide. These safety symbols are in order, according to the degree of 
danger.

Explanation of all icons and signs used in the user’s guide:

Warning Hazards or unsafe practices that may result in severe personal injury or death.

Caution Hazards or unsafe practices that may result in minor personal injury or property damage.

Do not attempt.

Do not disassemble.

Do not touch.

Unplug the power cord from the wall socket.

Make sure the machine is grounded to prevent electric shock.

Call the service center for help.

Follow directions explicitly.

Operating environment

 Warning

Do not use if the power cord is damaged or if the 
electrical outlet is not grounded.
► This could result in electric shock or fire. 

Do not bend, or place heavy objects on the power 
cord. 
► Stepping on or allowing the power cord to be 
crushed by a heavy object could result in electric 
shock or fire. 

Do not place anything on top of the machine (water, 
small metal or heavy objects, candles, lit cigarettes, 
etc.).
► This could result in electric shock or fire. 

Do not remove the plug by pulling on the cord; do not 
handle the plug with wet hands. 
► This could result in electric shock or fire. 
Safety information_ 1



 Caution

During an electrical storm or for a period of 
non-operation, remove the power plug from the 
electrical outlet. 
► This could result in electric shock or fire. 

If the plug does not easily enter the electrical outlet, do not 
attempt to force it in. 
► Call an electrician to change the electrical outlet, or this 
could result in electric shock.

Be careful, the paper output area is hot. 
► Burns could occur. 

Do not allow pets to chew on the AC power, telephone or PC 
interface cords.
► This could result in electric shock or fire and/or injury to your 
pet. 

If the machine has been dropped, or if the cabinet appears 
damaged, unplug the machine from all interface connections 
and request assistance from qualified service personnel.
► Otherwise, this could result in electric shock or fire.

If the machine does not operate properly after these 
instructions have been followed, unplug the machine from all 
interface connections and request assistance from qualified 
service personnel.
► Otherwise, this could result in electric shock or fire.

If the machine exhibits a sudden and distinct change in 
performance, unplug the machine from all interface 
connections and request assistance from qualified service 
personnel.
► Otherwise, this could result in electric shock or fire.

Operating method

 Caution

Do not forcefully pull the paper out during printing. 
► It can cause damage to the machine.

When printing large quantities, the bottom part of the 
paper output area may get hot. Do not allow children 
to touch. 
► Children may be burned.

Be careful not to put your hand between the machine 
and paper tray.
► You may get injured.

When removing jammed paper, do not use tweezers 
or sharp metal objects. 
► It can cause damage to the machine.

Do not block or push objects into the ventilation opening.
► This could result in elevated component temperatures which 
can cause damage or fire.

Do not allow too many papers to stack up in the paper output 
tray.
► It could cause damage to the machine. 

Use care to avoid paper cuts when replacing paper or removing 
jammed paper. 
► You may get hurt.

This machine's power interception device is the power cord. 
► To switch off the power supply, remove the power cord from 
the electrical outlet. 

If the machine gets overheated, it releases smoke, 
makes strange noises, or generates an odd odor, 
immediately turn off the power switch and unplug the 
machine.
► This could result in electric shock or fire. 
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Installation / Moving

 Warning

Do not place the machine in an area with dust, 
humidity or water leaks. 
► This could result in electric shock or fire. 

 Caution

When moving the machine, turn the power off and 
disconnect all cords; then lift the machine with at 
least two people.
► The machine could fall, causing human injury or 
machine damage.

Do not put a cover over the machine or place it in an airtight 
location, such as a closet.
► If the machine is not well-ventilated, this could result in fire.

Do not place the machine on an unstable surface.
► The machine could fall, causing human injury or machine 
damage.

Make sure you plug the power cord into a grounded electrical 
outlet.
► Otherwise, this could result in electric shock or fire.

The machine should be connected to 
the power level which is specified on the label.
► If you are unsure and want to check the power level you are 
using, contact the electrical utility company.

Do not overload wall outlets and extension cords.
► This can diminish performance, and could result in electric 
shock or fire.

Use only No.26 AWGa

a.  AWG: American Wire Gauge

 or larger, telephone line cord, if 
necessary.
► Otherwise, it can cause damage to the machine.

Use the power cord supplied with your machine for safe 
operation. If you are using a cord which is longer than 2 meters 
(79”) with a 140V machine, then the gauge should be 16 AWG 
or larger.
► Otherwise, it can cause damage to the machine, and could 
result in electric shock or fire.

Maintenance / Checking

 Caution

Unplug this product from the wall outlet before 
cleaning the inside of the machine. Do not clean the 
machine with benzene, paint thinner or alcohol; do 
not spray water directly into the machine. 
► This could result in electric shock or fire. 

Keep cleaning supplies away from children. 
► Children may get hurt.

When you are working inside the machine replacing 
supplies or cleaning the inside, do not operate the 
machine.
► You may get injured.

Do not disassemble, repair or rebuild the machine by 
yourself. 
► It can cause damage to the machine. Call a 
certified technician when the machine needs repair.
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Supply usage

 Caution

Do not disassemble the toner cartridge.
► Toner dust can be dangerous to humans.

When storing supplies such as toner cartridges, keep 
them away from children.
► Toner dust can be dangerous to humans.

Do not burn any of the supplies such as toner 
cartridge or fuser unit.
► It can cause an explosion or fire.

Using recycled supplies, such as toner, can cause damage to 
the machine.
► In case of damage due to the use of recycled supplies, a 
service fee will be charged.

When changing the toner cartridge or removing jammed paper, 
be careful not to let toner dust touch your body or clothes.
► Toner dust can be dangerous to humans.

Keep the power cable and the contact surface of the plug clean 
from dust or water.
► This could result in electric shock or fire. 

To clean and operate the machine, strictly follow the user's 
guide provided with the machine.
► Otherwise, it can cause damage to the machine.

Do not remove any covers or guards that are fastened with 
screws. 
► The machine should only be repaired by Samsung service 
technician.
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regulatory information
This machine is certified with several regulatory statements.

Laser Safety Statement

The printer is certified in the U.S. to conform to the requirements of DHHS 21 CFR, chapter 1 Subchapter J for Class I(1) laser products, and 
elsewhere is certified as a Class I laser product conforming to the requirements of IEC 60825-1:1993 + A1:1997 + A2:2001.
Class I laser products are not considered to be hazardous. The laser system and printer are designed so there is never any human access to 
laser radiation above a Class I level during normal operation, user maintenance or prescribed service condition.
• Wavelenght: 800 nm
• Beam divergence

- Paraller: 11 degrees
- Perpendicular: 35 degrees

• Maximum power or energy output: 12 mW

WARNING 
Never operate or service the printer with the protective cover removed from Laser/Scanner assembly. The reflected beam, although invisible, 
can damage your eyes.
When using this product, these basic safety precautions should always be followed to reduce risk of fire, electric shock, and injury to persons:

Taiwan only
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Ozone Safety

During normal operation, this machine produces ozone. The ozone produced does not present a hazard to the operator. However, it is 
advisable that the machine be operated in a well ventilated area.
If you need additional information about ozone, request your nearest Samsung dealer.

Mercury Safety

Contains Mercury, Dispose According to Local, State or Federal Laws. (U.S.A. only)

Power Saver

This printer contains advanced energy conservation technology that reduces power consumption when it is not in active use.
When the printer does not receive data for an extended period of time, power consumption is automatically lowered. 
ENERGY STAR and the ENERGY STAR mark are registered U.S. marks. 
For more information on the ENERGY STAR program see http://www.energystar.gov.

Recycling

Recycle or dispose of the packaging material for this product in an environmentally responsible manner.

China only
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Correct Disposal of This Product (Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European countries with separate collection systems)
This marking on the product, accessories or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB 
cable) should not be disposed of with other household waste at the end of their working life. To prevent possible harm to the environment or 
human health from uncontrolled waste disposal, please separate these items from other types of waste and recycle them responsibly to 
promote the sustainable reuse of material resources. 
Household users should contact either the retailer where they purchased this product, or their local government office, for details of where and 
how they can take these items for environmentally safe recycling.
Business users should contact their supplier and check the terms and conditions of the purchase contract. This product and its electronic 
accessories should not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product

(Applicable in the European Union and other European countries with separate battery return systems.)
This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed of with other household 
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to 
human health or the environment. 
To protect natural resources and to promote material reuse, please separate batteries from other types of waste and recycle them through your 
local, free battery return system.

Radio Frequency Emissions

FCC Information to the User
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
• This device may not cause harmful interference, and
• This device must accept any interference received, including interference that may cause undesired operation.
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one or more of the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or experienced radio TV technician for help.

 

Change or modifications not expressly approved by the manufacturer responsible for compliance could void the user's authority to 
operate the equipment.

Canadian Radio Interference Regulations
This digital apparatus does not exceed the Class A limits for radio noise emissions from digital apparatus as set out in the interference-causing 
equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry and Science Canada.
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe A prescrites dans la 
norme sur le matériel brouilleur: “Appareils Numériques”, ICES-003 édictée par l’Industrie et Sciences Canada.
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UNITED STATES OF AMERICA

Federal Communications Commission (FCC)
Intentional emitter per FCC Part 15
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. This section is only applicable if these devices are present. Refer to the system label to verify the 
presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the United States of America if an FCC ID number is on the system 
label.
The FCC has set a general guideline of 20 cm (8 inches) separation between the device and the body, for use of a wireless device near the 
body (this does not include extremities). This device should be used more than 20 cm (8 inches) from the body when wireless devices are on. 
The power output of the wireless device (or devices), which may be embedded in your printer, is well below the RF exposure limits as set by 
the FCC.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Operation of this device is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired operation of the device.

 

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

FCC Statement for Wireless LAN use:

 

While installing and operating this transmitter and antenna combination the radio frequency exposure limit of 1m W/cm2 may be 
exceeded at distances close to the antenna installed. Therefore, the user must maintain a minimum distance of 20cm from the antenna at 
all times. This device cannot be colocated with another transmitter and transmitting antenna.

Taiwan only

Turkey only
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Russia only

Fax Branding

The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer or other electronic device to send any 
message via a telephone facsimile machine unless such message clearly contains in a margin at the top or bottom of each transmitted page or 
on the first page of the transmission the following information:
1. the date and time of transmission
2. identification of either business, business entity or individual sending the message; and
3. telephone number of either the sending machine, business, business entity or individual.
The Telephone Company may make changes in its communications facilities, equipment operations or procedures where such action is 
reasonably required in the operation of its business and is not inconsistent with the rules and regulations in FCC Part 68. If such changes can 
be reasonably expected to render any customer terminal equipment incompatible with telephone company communications facilities, or require 
modification or alteration of such terminal equipment, or otherwise materially affect its use or performance, the customer shall be given 
adequate notice in writing, to allow the customer an opportunity to maintain uninterrupted service

Ringer Equivalence Number

The Ringer Equivalence Number and FCC Registration Number for this machine may be found on the label located on the bottom or rear of the 
machine. In some instances you may need to provide these numbers to the telephone company.
The Ringer Equivalence Number (REN) is a measure of the electrical load placed on the telephone line, and is useful for determining whether 
you have “overloaded” the line. Installing several types of equipment on the same telephone line may result in problems making and receiving 
telephone calls, especially ringing when your line is called. The sum of all Ringer Equivalence Numbers of the equipment on your telephone 
line should be less than five in order to assure proper service from the telephone company. In some cases, a sum of five may not be usable on 
your line. If any of your telephone equipment is not operating properly, you should immediately remove it from your telephone line, as it may 
cause harm to the telephone network.
The equipment complies with Part 68 of the FCC rules and the requirements adopted by the ACTA. On the rear of this equipment is a label that 
contains, among other information, a product identifier in the format US:AAAEQ##TXXXX. If requested, this number must be provided to the 
telephone company.

 

FCC Regulations state that changes or modifications to this equipment not expressly approved by the manufacturer could void the user’s 
authority to operate this equipment. In the event that terminal equipment causes harm to the telephone network, the telephone company 
should notify the customer that service may be stopped. However, where prior notice is impractical, the company may temporarily cease 
service, providing that they:
a)promptly notify the customer.
b)give the customer an opportunity to correct the equipment problem.
c)inform the customer of the right to bring a complaint to the Federal Communication Commission pursuant to procedures set out in FCC 

Rules and Regulations Subpart E of Part 68.
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You should also know that:
• Your machine is not designed to be connected to a digital PBX system.
• If you intend to use a computer modem or fax modem on the same phone line as your machine, you may experience transmission and 

reception problems with all the equipment. It is recommended that no other equipment, except for a regular telephone, share the line with 
your machine.

• If your area experiences a high incidence of lightning or power surges, we recommend that you install surge protectors for both the power 
and the telephone lines. Surge protectors can be purchased from your dealer or telephone and electronic specialty stores.

• When programming emergency numbers and/or making test calls to emergency numbers, use a non-emergency number to advise the 
emergency service dispatcher of your intentions. The dispatcher will give you further instructions on how to actually test the emergency 
number.

• This machine may not be used on coin service or party lines.
• This machine provides magnetic coupling to hearing aids.
You may safely connect this equipment to the telephone network by means of a standard modular jack, USOC RJ-11C.

Replacing the Fitted Plug (for UK Only)

Important
The mains lead for this machine is fitted with a standard (BS 1363) 13 amp plug and has a 13 amp fuse. When you change or examine the 
fuse, you must re-fit the correct 13 amp fuse. You then need to replace the fuse cover. If you have lost the fuse cover, do not use the plug until 
you have another fuse cover. 
Contact the people from you purchased the machine.
The 13 amp plug is the most widely used type in the UK and should be suitable. However, some buildings (mainly old ones) do not have normal 
13 amp plug sockets. You need to buy a suitable plug adaptor. Do not remove the moulded plug.

 

If you cut off the moulded plug, get rid of it straight away.

You cannot rewire the plug and you may receive an electric shock if you plug it into a socket.

Important warning: 
You must earth this machine.
The wires in the mains lead have the following color code:
• Green and Yellow: Earth
• Blue: Neutral
• Brown: Live

If the wires in the mains lead do not match the colors marked in your plug, do the following:
You must connect the green and yellow wire to the pin marked by the letter “E” or by the safety ‘Earth symbol’ or colored green and yellow or 
green.
You must connect the blue wire to the pin which is marked with the letter “N” or colored black.
You must connect the brown wire to the pin which is marked with the letter “L” or colored red.
You must have a 13 amp fuse in the plug, adaptor, or at the distribution board.
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Declaration of Conformity (European Countries)

Approvals and Certifications
The CE marking applied to this product symbolizes Samsung Electronics Co., Ltd. Declaration of Conformity with the following applicable 
93/68/EEC Directives of the European Union as of the dates indicated:

Hereby, Samsung Electronics declare that this product is in compliance with the essential requirements and other relevant provisions of:
R&TTE Directive (1999/5/EC)
The declaration of conformity may be consulted at www.samsung.com/printer, go to Support > Download center and enter your printer (MFP) 
name to browse the EuDoC. 
January 1, 1995: Council Directive 2006/95/EC Approximation of the laws of the member states related to low voltage equipment.
January 1, 1996: Council Directive 2004/108/EC (92/31/EEC), approximation of the laws of the Member States related to electromagnetic 
compatibility.
March 9, 1999: Council Directive 1999/5/EC on radio equipment and telecommunications terminal equipment and the mutual recognition of 
their conformity. A full declaration, defining the relevant Directives and referenced standards can be obtained from your Samsung Electronics 
Co., Ltd. representative.

EC Certification
Certification to 1999/5/EC Radio Equipment & Telecommunications Terminal Equipment Directive (FAX)
This Samsung product has been self-certified by Samsung for pan-European single terminal connection to the analogue public switched 
telephone network (PSTN) in accordance with Directive 1999/5/EC. The product has been designed to work with the national PSTNs and 
compatible PBXs of the European countries:
In the event of problems, you should contact the Euro QA Lab of Samsung Electronics Co., Ltd. in the first instance.
The product has been tested against TBR21. To assist in the use and application of terminal equipment which complies with this standard, the 
European Telecommunication Standards Institute (ETSI) has issued an advisory document (EG 201 121) which contains notes and additional 
requirements to ensure network compatibility of TBR21 terminals. The product has been designed against, and is fully compliant with, all of the 
relevant advisory notes contained in this document.

European Radio Approval Information (for products fitted with EU-approved radio devices)
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz band, may be 
present (embedded) in your printer system which is intended for home or office use. This section is only applicable if these devices are present. 
Refer to the system label to verify the presence of wireless devices.
Wireless devices that may be in your system are only qualified for use in the European Union or associated areas if a CE mark with a Notified 
Body Registration Number and the Alert Symbol is on the system label.
The power output of the wireless device or devices that may be embedded in you printer is well below the RF exposure limits as set by the 
European Commission through the R&TTE directive.

European States qualified under wireless approvals:
EU Austria, Belgium, Cyprus, Czech Republic, Denmark, Estonia, Finland, France (with frequency restrictions), Germany, Greece, 

Hungary, Ireland, Italy, Latvia, Lithuania, Luxembourg, Malta, The Netherlands, Poland, Portugal, Slovakia, Slovenia, Spain, 
Sweden and the U.K.

EEA/EFTA 
countries

Iceland, Liechtenstein, Norway and Switzerland

European States with restrictions on use:
EU In France, the frequency range is restricted to 2446.5-2483.5 MHz for devices above 10 mW transmitting power such as 

wireless
In Italiy, if used outside of own premises, general authorization is required
In Russian, only for indoor applications

EEA/EFTA 
countries

No limitations at this time.
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REGULATORY COMPLIANCE STATEMENTS

Wireless Guidance
Low power, Radio LAN type devices (radio frequency (RF) wireless communication devices), operating in the 2.4 GHz/5 GHz Band, may be 
present (embedded) in your printer system. The following section is a general overview of considerations while operating a wireless device.
Additional limitations, cautions, and concerns for specific countries are listed in the specific country sections (or country group sections). The 
wireless devices in your system are only qualified for use in the countries identified by the Radio Approval Marks on the system rating label. If 
the country you will be using the wireless device in, is not listed, contact your local Radio Approval agency for requirements. Wireless devices 
are closely regulated and use may not be allowed.
The power output of the wireless device or devices that may be embedded in your printer is well below the RF exposure limits as known at this 
time. Because the wireless devices (which may be embedded into your printer) emit less energy than is allowed in radio frequency safety 
standards and recommendations, manufacturer believes these devices are safe for use. Regardless of the power levels, care should be taken 
to minimize human contact during normal operation.
As a general guideline, a separation of 20 cm (8 inches) between the wireless device and the body, for use of a wireless device near the body 
(this does not include extremities) is typical. This device should be used more than 20 cm (8 inches) from the body when wireless devices are 
on and transmitting.
This transmitter must not be collocated or operation in conjunction with any other antenna or transmitter.
Some circumstances require restrictions on wireless devices. Examples of common restrictions are listed below:

 

Radio frequency wireless communication can interfere with equipment on commercial aircraft. Current aviation regulations require 
wireless devices to be turned off while traveling in an airplane. IEEE 802.11 (also known as wireless Ethernet) and Bluetooth 
communication devices are examples of devices that provide wireless communication.

 

In environments where the risk of interference to other devices or services is harmful or perceived as harmful, the option to use a wireless 
device may be restricted or eliminated. Airports, Hospitals, and Oxygen or flammable gas laden atmospheres are limited examples where 
use of wireless devices may be restricted or eliminated. When in environments where you are uncertain of the sanction to use wireless 
devices, ask the applicable authority for authorization prior to use or turning on the wireless device.

 

Every country has different restrictions on the use of wireless devices. Since your system is equipped with a wireless device, when 
traveling between countries with your system, check with the local Radio Approval authorities prior to any move or trip for any restrictions 
on the use of a wireless device in the destination country.

 

If your system came equipped with an internal embedded wireless device, do not operate the wireless device unless all covers and 
shields are in place and the system is fully assembled.

 

Wireless devices are not user serviceable. Do not modify them in any way. Modification to a wireless device will void the authorization to 
use it. Contact manufacturer for service.

 

Only use drivers approved for the country in which the device will be used. See the manufacturer System Restoration Kit, or contact 
manufacturer Technical Support for additional information.

OpenSSL License

Copyright (c) 1998-2001 The OpenSSL Project. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes 

software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)."
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without 

prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written 

permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the 

OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)".
THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
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SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) 
ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
This product includes cryptographic software written by Eric Young(eay@cryptsoft.com). This product includes software written by Tim Hudson 
(tjh@cryptsoft.com).

Original SSLeay License

Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with 
Netscapes SSL.
This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to 
all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this 
distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, 
and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given 
attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation 
(online or textual) provided with the package.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:
1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the 

documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes 

cryptographic software written by Eric Young (eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library 
being used are not cryptographic related.

4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an 
acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)".

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 
WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF 
THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
The licence and distribution terms for any publically available version or derivative of this code cannot be changed. i.e. this code cannot simply 
be copied and put under another distribution licence [including the GNU Public Licence.
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about this user’s guide
This user’s guide provides information about how to use the machine. Both novice and professional users can refer to this 
as a guide for installing and using the machine.

 

•Read the safety information before using the machine.
•If you have a problem using the machine, refer to the troubleshooting chapter (See "Troubleshooting" on page 1).
•Terms used in this user’s guide are explained in the glossary chapter (See "Glossary" on page 1).
•All illustrations in this user’s guide may differ from your machine depending on its options or models.
•The procedures in this user’s guide are mainly based on Windows XP.

Convention
Some terms in this guide are used interchangeably, as below:
• Document is synonymous with original.
• Paper is synonymous with media, or print media.
• Machine refers to printer or MFP.
The following table offers the conventions of this guide:

Convention Description Example

Bold For texts on the display or button names on the machine. Start

Note Provides additional information or detailed specification of the machine function 
and feature.  

The date format may differ from country 
to country.

Caution Gives users information to protect the machine from possible mechanical 
damage or malfunction.  

Do not touch the green surface of the 
toner cartridge. 

Footnote Provides additional more detailed information on certain words or a phrase. a. pages per minute

(“Cross-reference”) Guides users to a reference page for the additional detailed information. (See Finding more information)
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Finding more information
You can find information for setting up and using your machine from the following resources, either as a print-out or on screen.

Material name Description

Quick Install Guide This guide provides basic information on setting up your machine.

User’s Guide This guide provides you with step-by-step instructions for using your machine’s full features, and contains information for maintaining 
your machine, troubleshooting and replacing supplies. 

Driver Help This help provides you with help information on printer driver and instructions for setting up the options for printing (See "Using help" on 
page 3).

Samsung website If you have Internet access, you can get help, support, machine drivers, manuals, and order information from the Samsung website, 
www.samsung.com/printer.

Downloadable 
software

You can download useful software from the Samsung website. 
• SyncThru™ Web Admin Service: convenient for network administrators who need to manage many machines simultaneously. 

This program is for network model only. (http://solution.samsungprinter.com)
• Samsung AnyWeb Print: helps personal users to screen-capture the website screen in Windows Internet Explorer easily. 

(http://solution.samsungprinter.com/personal/anywebprint)
• Samsung Easy Color Manager: helps Samsung color laser printer users to adjust color as they like. 

(http://solution.samsungprinter.com/personal/colormanager)
• XPS printer driver: used to print documents in XPS print path. XPS printer driver can be installed only on Windows Vista or higher.
• (http://www.samsung.com/printer)
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features of your new product
Your new machine is equipped with a number of special features that improve the quality of the documents you print.

Special Features

Print with excellent quality and speed
* Zoran IPS Emulation compatible with PostScript 3: 
• You can print in a full range of colors using cyan, magenta, 
yellow, and black.

• You can print with a resolution of up to 9,600 x 600 dpi 
effective output.

• CLX-6220 Series prints up to 20 ppm, A4-sized paper or up 
to 21 ppm, letter sized paper. 

• CLX-6250 Series prints up to 24 ppm, A4-sized paper or up 
to 25 ppm, letter sized paper.

Handle many different types of printable material

• The multi-purpose tray supports envelopes, labels, 
custom-sized media, postcards, and heavy paper. 

• The tray 1 and optional tray support plain paper in various 
sizes (See "Print media specifications" on page 3).

Create professional documents (Windows only)

• Print Watermarks. You can customize your documents with 
words, such as “Confidential” (See "Using watermarks" on 
page 5).

• Print Posters. The text and pictures of each page of your 
document are magnified and printed across the sheet of 
paper and can then be taped together to form a poster (See 
"Printing posters" on page 3).

• You can use preprinted forms with plain paper (See"Using 
overlay (PCL driver only)" on page 5).

Save time and money

• To save paper, you can print multiple pages on one single 
sheet of paper (See "Printing multiple pages on one sheet of 
paper" on page 3).

• This machine automatically conserves electricity by 
substantially reducing power consumption when not in use.

• To save paper, you can print on both sides of the paper 
(double-sided printing) (See "Printing on both sides of paper" 
on page 4).

Expand your machine’s capacity

• Your machine has an extra memory slot to expand the 
memory (See "Available accessories" on page 2).

• Zoran IPS Emulation* compatible with PostScript 3 (PS) 
enables PS printing.
Features of your new product_
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Print in various environments

• You can print with various operating system such as 
Windows, Linux, Macintosh and UNIX systems (See 
"System requirements" on page 2).

• Your machine is equipped with a USB interface and a 
network interface.

Copy originals in several formats

• Your machine can copy multiple image copies from the 
original document on a single page (See "2-up or 4-up 
copying (N-up)" on page 3).

• The print quality and image size may be adjusted and 
enhance at the same time.

Scan the originals and send it right away

• Scan in color and use the precise compressions of JPEG, 
TIFF and PDF formats.

• Quickly scan and send files to multiple destinations using 
Networks scanning (See "Sending a scanned image to 
several destinations as an email attachment" on page 2).

Set a specific time to transmit a Fax

• You can specify a certain time to transmit the fax and also 
send the fax to several stored destinations.

• After the transmission, the machine may print out the fax 
reports according to the setting.

Use USB flash memory devices

If you have a USB memory device, you can use it in various 
ways with your machine.
• You can scan documents and save them to the device.
• You can directly print data stored to the device.



IPv6

This machine supports IPv6. 

Features by Models
The machine is designed to support all of your document needs from printing and copying to more advanced networking solutions for your business. 
Some features and optional goods may not be available depending on models or countries.
Features by models include:

FEATURES CLX-6220 Series CLX-6250 Series

USB 2.0 ● ●

USB Memory Interface ● ●

Document Feeder ● ●

Hard Disk ○

Network Interface Ethernet 10/100 BaseTX wired LAN ● ●

Network Interface 802.11 b/g wireless LANa

a.Depending on your country, wireless LAN cards may not be available. Contact your local Samsung dealer or the retailer 
where you bought your printer.

○

Duplex (2-sided) printing ● ●

FAX ● ●

Optional Tray 2 ○ ○

( ●: Included, ○: Optional, Blank: Not available) 
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1.introduction
This chapter gives you an overview of your machine:
This chapter includes:
• Machine overview
• Control panel overview

• Understanding the Status LED
• Introducing the useful buttons

  

Machine overview
Front view

 

1 Document feeder cover
 

12 Front door
 

2 Document feeder width 
guides

 

13 Document output tray
 

3 Document feeder input tray
 

14 Control panel
 

4 Document feeder output tray
 

15 Multi-purpose tray paper 
width guides

 

5 USB memory port
 

16 Toner cartridges
 

6 Front door handle
 

17 Paper transfer belt
 

7 Multi-purpose tray handle
 

18 Scanner lid
 

8 Paper level indicator
 

19 Scanner lock switch

 

9 Optional tray 2a

a.Optional device.

 

20 Scanner glass
 

10 Tray 1
 

21 Scan unit
 

11 Multi-purpose tray
 

22 Inner cover of the reverse 
unit. 
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Rear view
 

1 Control board cover
 

7 Extension telephone socket 
(EXT)

 

2 Rear door
 

8 Telephone line socket
 

3 Cable organizer
 

9 Optional tray 2 cable connector
 

4 Power receptacle
 

10 Network port
 

5 Power-switch
 

11 USB port
 

6 Handle
 

12 IEEE 802.11 b/g Wireless LANa

a.Optional device.
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Control panel overview
 

1 ID Copy You can copy both sides of an ID Card such as a driver’s license to a single side of paper (See "ID card copying" on page 2).
 

2 Direct USB Allows you to directly print files stores on a USB memory device when it is inserted into the USB memory port on your 
machine (See "About USB memory device" on page 1).

 

3 Duplex Allows you to print documents on both sides of the paper. 
 

4 Display screen Shows the current status and prompts during an operation.
 

5 Toner colors Show the status of each toner cartridge.
 

6 Status Shows the status of your machine (See "Understanding the Status LED" on page 5).
 

7 Fax Activates fax mode.
 

8 Copy Activates copy mode.
 

9 Scan/Email Activates scan mode.
 

10 OK Confirms the selection on the screen.
 

11 Arrow Scroll through the options available in the selected menu, and increase or decrease values.
 

12 Menu Enters Menu mode and scrolls through the available menus (See "Machine status and advanced feature" on page 1).
 

13 Back Sends you back to the upper menu level.
 

14 Numeric keypad Dials fax number, and enters the number value for document copies or other options.

 

15
Address 
Book  Allows you to store frequently used fax numbers and email addresses or search for stored fax numbers or email addresses.

 

16 Redial/Pause In standby mode, redials the last number. Also in edit mode, inserts a pause into a fax number.
 

17 On Hook Dial  Enable you dial a number with the receiver on the hook.

 

18 Stop/Clear Stops an operation at any time. The pop-up window appears on the screen showing the current job that the user can stop or 
resume.

 

19 Power Saver Sends the machine into power saver mode. If you press and hold this button, you can also turn the power on and off (See 
"Power Saver button" on page 5).
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20 Start Starts a job in black or color mode.
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Understanding the Status LED
The color of the Status indicates the machine's current status.

Status Description

Off • The machine is off-line.

Green Blinking • When the backlight slowly blinks, the machine 
is receiving data from the computer.

• When the backlight blinks rapidly, the 
machine is printing data. 

On The machine is on-line and can be used.

Red Blinking • A minor error has occurred and the machine is 
waiting for the error to be cleared. Check the 
display message. When the problem is 
cleared, the machine resumes. 

• A small amount of toner is left in the cartridge. 
The estimated cartridge lifea

a.Estimated cartridge life means the expected or estimated toner 
cartridge life, which indicates the average capacity of print-outs and is 
designed pursuant to ISO/IEC 19798. The number of pages may be 
affected by operating environment, printing interval, graphics, media 
type and media size. Some amount of toner may remain in the cartridge 
even when Replace new [ccc] toner appears and the printer stops 
printing.

 of toner is close. 
Prepare a new cartridge for replacement. You 
may temporarily increase the printing quality 
by redistributing the toner (See "Replacing the 
toner cartridge" on page 2, "Redistributing 
toner" on page 1).

On • A toner cartridge has almost reached its 
estimated cartridge lifea. It is recommended to 
replace the toner cartridge (See "Replacing 
the toner cartridge" on page 2).

• A paper jam has occurred (See "Clearing 
paper jams" on page 3).

• The cover is opened. Close the cover.
• There is no paper in the tray. Load paper in 

the tray.
• The machine has stopped due to a major 

error. Check the display message (See 
"Understanding display messages" on 
page 8). 

 

Samsung does not recommend using non-genuine Samsung toner 
cartridge such as one that is refilled or remanufactured. Samsung 
cannot guarantee a non-genuine Samsung toner cartridge's quality. 
Service or repair required as a result of using non-genuine Samsung 
toner cartridges will not be covered under the machine warranty. 

 

•All printing errors will be appear in the Smart Panel program window. 
If the problem persists, call for service.

•Check the message on the display screen. Follow the instructions in 
the message or refer to troubleshooting part (See "Understanding 
display messages" on page 8). If the problem persists, call for 
service.

Introducing the useful buttons
Menu button 

When you want to know the machine status and set your machine to use an 
advanced feature, click Menu button (See "Machine status and advanced 
feature" on page 1).

Stop/Clear button 

By pressing the  , you can: 

Function Description

Cancel print job Press  during printing.

Power Saver button 

When the machine is not in use, save electricity by pressing the Power 
Saver button. Pressing this button for one second puts the machine into 
power save mode (See "Using the power saving mode" on page 3).
If you press this button for more than three seconds, a pop-up appears, 
asking if you want to turn the power off. If you choose Yes, the power is 
turned off. This button must then be used to turn the button on.

Status Description

Off The machine is not in the power save mode.

Blue On The machine is in the power save mode.

 

In the following cases, the machine wakes up from the power save 
mode.
•Data is received.
•Front door or scan unit is opened.
•Control panel key is pressed.
•Power-switch turn the power on and off.
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1.getting started
This chapter gives you step-by-step instructions for setting up the USB connected machine and software.
This chapter includes:
• Setting up the hardware
• Printing a demo page
• Supplied software

• System requirements
• Installing USB connected machine’s driver
• Sharing your machine locally

  

Setting up the hardware
This section shows the steps to set up the hardware, as is explained in the 
Quick Install Guide. Make sure you read the Quick Install Guide first and 
follow the steps below:
1. Select a stable location.

Select a level, stable place with adequate space for air circulation. Allow 
extra space to open covers and trays. 
The area should be well ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to the 
edge of your desk or table.

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to the 
altitude setting to optimize your printing (See "Altitude adjustment" on 
page 1).
Place the machine on a flat, stable surface so that there is no incline 
greater than 2 cm (0.79 inch). Otherwise, printing quality may be 
affected.

2. Unpack the machine and check all the enclosed items.
3. Remove all the tapes.
4. Install the toner cartridges.
5. Load paper (See "Loading paper in the tray" on page 3).
6. Make sure that all cables are connected to the machine. 
7. Turn the machine on.

 

This equipment will be inoperable when mains power fails.

Printing a demo page
Print a demo page to make sure that the machine is operating correctly.
To print a demo page:
In ready mode, press and hold the OK for about 3 seconds, then release.

Supplied software
After you have set up your machine and connected it to your computer, you 
must install the printer software. If you are a Windows or Macintosh OS, 
install the software from the supplied CD and if you are a Linux OS user or 
UNIX OS user, download the software from the Samsung website 
(www.samsung.com/printer) and install.

 

Machine software are occasionally updated due to release of new 
operating system and etc. If needed, download the latest version from 
the Samsung website. (www.samsung.com/printer)
Getting started_ 1
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OS Contents

Windows • Printer driver: Use this driver to take full advantage of 
your machine’s features.

• PostScript Printer Driver: Use the PostScript driver to 
print documents with complex fonts and graphics in the PS 
language. (PostScript printer description file is included.)

• Scanner driver: TWAIN and Windows Image Acquisition 
(WIA) drivers are available for scanning documents on 
your machine.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• SmarThru Officea: 

a.Allows you to edit a scanned image in various ways using a powerful 
image editor and to send the image by email. You can also open another 
image editor program, such as Adobe Photoshop, from SmarThru Office. 
For details, refer to the on screen help supplied on the SmarThru Office 
program (See "Smarthru Office" on page 3).

This program is the accompanying 
Windows-based software for your multifunctional machine. 

• Samsung Scan and Fax Manager: You can find out 
about scan and fax manager program information and 
installed scan driver's condition.

• Samsung Network PC Fax: You can find out about fax 
manager program information. You can send a fax from 
your computer without going to the machine.

• Printer Settings Utility: This program allows you to set 
up printer’s other options from your computer desktop.

• Direct Printing Utility (CLX-6250 Series only): This 
program allows you to print PDF files directly.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Macintosh • PostScript Printer Driver: Use this driver to run your 
machine from a Macintosh computer and print documents. 
(PostScript printer description file is included.)

• Scanner driver: TWAIN driver and Image Capture driver 
are available for scanning documents on your machine.

• Smart Panel: This program allows you to monitor the 
machine’s status and alerts you when an error occurs 
during printing.

• Samsung Scan and Fax Manager: You can find out 
about scan and fax manager program information and 
installed scan driver's condition.

• Printer Settings Utility: This program allows you to set 
up printer’s other options from your computer desktop.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

Linux • Unified Linux Driver: Use this driver to take full 
advantage of your machine’s features.

• PostScript Printer Driver: Use this driver to run your 
machine from a Linux computer and print documents. 
(PostScript printer description file is included.)

• SANE: Use this driver to scan documents.
• Smart Panel: This program allows you to monitor the 

machine’s status and alerts you when an error occurs 
during printing.

• Printer Settings Utility: This program allows you to set 
up printer’s other options from your computer desktop.

• SetIP: Use this program to set your machine’s TCP/IP 
addresses.

UNIX • UNIX Printer Driver: Use this driver to print documents 
from the UNIX system.

System requirements
Before you begin, ensure that your system meets the following 
requirements:

Microsoft® Windows®
Your machine supports the following Windows operating systems.

OPERATING 
SYSTEM

Requirement (recommended)

CPU RAM free HDD 
space

Windows® 2000 Intel® Pentium® II 400 
MHz (Pentium III 933 
MHz)

64 MB  
(128 MB)

600 MB

Windows® XP Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB  
(256 MB)

1.5 GB

Windows 
Server® 2003

Intel® Pentium® III 933 
MHz (Pentium IV 1 GHz)

128 MB  
(512 MB)

1.25 GB to  
2 GB

Windows 
Server® 2008

Intel® Pentium® IV 1 GHz 
(Pentium IV 2 GHz)

512 MB  
(2048 MB)

10 GB

Windows 
Vista®

Intel® Pentium® IV 3 GHz 512 MB  
(1024 MB)

15 GB

Windows® 7 Intel® Pentium® IV 1 GHz 
32-bit or 64-bit processor 
or higher

1 GB (2 
GB)

16 GB

• Support for DirectX® 9 graphics with 128 MB memory 
(to enable the Aero theme).

• DVD-R/W Drive

Windows 
Server® 2008 
R2

Intel® Pentium® IV 1 GHz 
(x86) or 1.4 GHz (x64) 
processors (2 GHz or 
faster)

512 MB  
(2048 MB)

10 GB

 

•Internet Explorer® 5.0 or higher is the minimum requirement for all 
Windows operating systems.

•Administrator rights are required to install the software.
•Windows Terminal Services is compatible with this machine.
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Macintosh

OPERATING 
SYSTEM

Requirements (recommended)

CPU RAM free HDD 
space

Mac OS X 
10.3 ~ 10.4

• Intel 
Processors

• PowerPC G4/ 
G5

• 128 MB for a 
PowerPC based 
Mac (512 MB)

• 512 MB for a 
Intel-based Mac 
(1 GB)

1 GB

Mac OS X 
10.5

• Intel 
Processors

• 867 MHz or 
faster Power 
PC G4/ G5

512 MB (1 GB) 1 GB

Mac OS X 
10.6

• Intel 
Processors

1 GB (2 GB) 1 GB

Linux

Item Requirement (recommended)

Operating 
system

RedHat® Enterprise Linux WS 4, 5 (32/64 bit)
Fedora Core 2~10 (32/64 bit)
SuSE Linux 9.1 (32 bit)
OpenSuSE® 9.2, 9.3, 10.0, 10.1, 10.2, 10.3, 11.0, 
11.1 (32/64 bit) 
Mandrake 10.0, 10.1 (32/64 bit)
Mandriva 2005, 2006, 2007, 2008, 2009 (32/64 bit) 
Ubuntu 6.06, 6.10, 7.04, 7.10, 8.04, 8.10 (32/64 bit)
SuSE Linux Enterprise Desktop 9, 10 (32/64 bit)
Debian 3.1, 4.0, 5.0 (32/64 bit) 

CPU Pentium IV 2.4 GHz (Intel Core™2)

RAM 512 MB (1024 MB)

Free HDD space 1 GB (2 GB)

 

•It is necessary to claim swap partition of 300 MB or larger for working 
with large scanned images.

•The Linux scanner driver supports the optical resolution at maximum.

UNIX

Item Requirements

Operating 
system

Sun Solaris / SPARC
Sun Solaris / x86
HP-UX / PA-RISC
HP-UX / Itanium
IBM AIX / Power

Free HDD space Up to 100 MB

Installing USB connected machine’s driver
A locally connected machine is a machine directly attached to your 
computer using the USB cable. If your machine is attached to a network, 
skip the following steps below and go on to installing network connected 
machine’s driver (See "Installing network connected machine’s driver" on 
page 3).

 

Only use an USB cable no longer then 3 m (10 ft. ).

Windows
You can install the machine software using the typical or custom method.
The following steps below are recommended for most users who use a 
machine directly connected to your computer. All components necessary for 
machine operations will be installed.
1. Make sure that the machine is connected to your computer and powered 

on.

 

If the “Found New Hardware Wizard” window appears during the 
installation procedure, click Cancel in close the window.

2. Insert the supplied software CD into your CD-ROM drive.
•The software CD should automatically run and an installation window 

appears.
•If the installation window does not appear, click Start and then Run. 

Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, Windows 7 and 
Windows 2008 Server R2, click Run Setup.exe in Install or run 
program field, and click Continue or Yes in the User Account 
Control windows.

3. Select Install now.

If necessary, select a language from the drop-down list.

 

•For CLX-6250 Series installation window, you can see Wireless 
Setting and Installation menu. You can use this menu if an 
optional wireless network card is installed and/or the machine 
is connected to your computer with a USB cable. 
Install the optional wireless network card. Instructions for 
Wireless Setting and Installation, refer to the wireless 
network installation guide provided with the optional wireless 
network card. 

•The Advanced Installation has two options, Custom 
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Installation and Install Software Only. The Custom 
Installation allows you to select the machine’s connection and 
choose individual components to install. The Install Software 
Only allows you to install the supplied software, such as Smart 
Panel. Follow the instruction in the window.

•Administrator Installation provides convenient installation 
methods useful for administrators (See "Administrator’s Guide 
(Windows only)" on page 1).

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

The program searches the machine.

 

If your machine is not found in the network or locally, the following 
window will appear.

•Check if you want to install the software without connecting 
the printer to the network or locally.
-Check this option to install this program without a machine 

connected. In this case, the print a test page window will be 
skipped, and completes the installation.

•Search again
When you press this button, the firewall notice window 
appears;
-Turn off the firewall and Search again. For Window operating 

system, click Start > Control Panel > Windows Firewall, 
and inactivate this option. For other operating systems, 
refer to their guide.

-Turn off the firewall from the third party's program beside the 

operating system. Refer to the manual provided by 
individual programs.

•Direct Input
The Direct Input allows you to search for a specific machine 
on the newtwork.
-Search by IP address: Enter the IP address or the host 

name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report (See "Printing a machine report" on 
page 1).

-Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

•Help
If your machine is not connected to the computer or network, 
This help button gives detailed information about the how to 
connect the machine.

5. The searched machines will be shown on the screen. Select the one you 
want to use and click Next.

 

When the driver finds only one machine, the confirmation window 
appears.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 8.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. To register as a user of the machine in order to receive information from 
Samsung, click On-line Registration.

9. Click Finish.

 

If the printer driver does not work properly, follow the steps below to 
repair or reinstall the driver. 
a)Make sure that the machine is connected to your computer and 

powered on.
b)From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > Maintenance.
c)Select the option you want, follow the instruction on the window.

Macintosh
The software CD that came with your machine provides you with the PPD 
file that allows you to use the CUPS driver or Apple LaserWriter driver (only 
available when you use a machine which supports the PostScript driver) for 
printing on a Macintosh computer. 
1. Make sure that the machine is connected to your computer and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
If you select Custom Install, you can choose individual components to 
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install.
11. When the message which warns that all applications will close on your 

computer appears, click Continue.
12. Select Typical installation for a local printer and then click OK.

 

If you select Typical installation for a network printer during the 
machine driver installation, the SetIP program automatically runs. 
If the machine has already configured network infomation, close 
the SetIP program. Go to the next step.

13. After the installation is finished, click Quit.
14. Open the Applications folder > Utilities > Print Setup Utility.

•For Mac OS X 10.5~10.6, open the Applications folder > System 
Preferences and click Print & Fax.

15. Click Add on the Printer List.
•For Mac OS X 10.5~10.6, click the “+” icon; a display window will pop 

up. 
16. For Mac OS X 10.3, select the USB tab. 

•For Mac OS X10.4, click Default Browser and find the USB 
connection.

•For Mac OS X 10.5~10.6, click Default and find the USB connection.
17. For Mac OS X 10.3, if Auto Select does not work properly, select 

Samsung in Printer Model and your machine name in Model Name.
•For Mac OS X 10.4, if Auto Select does not work properly, select 

Samsung in Print Using and your machine name in Model. 
•For Mac OS X 10.5~10.6, if Auto Select does not work properly, select 

Select a driver to use... and your machine name in Print Using. 
Your machine appears on the Printer List, and is set as the default 
machine.

18. Click Add.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a)Make sure that the machine is connected to your computer and 

powered on.
b)Insert the supplied software CD into your CD-ROM drive.
c)Double-click CD-ROM icon that appears on your Macintosh desktop.
d)Double-click the MAC_Installer folder.
e)Double-click the Installer OS X icon.
f)Enter the password and click OK.
g)The Samsung Installer window opens. Click Continue.
h)Select Uninstall and click Uninstall. 
i)When the message which warns that all applications will close on 

your computer appears, Click Continue.
j)When the uninstall is done, click Quit.

Linux
You need to download the Linux software package from the Samsung 
website to install the printer software. 
Follow the steps below to install the software.

Installing the Linux Unified Driver
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 

administrator.

3.From the Samsung website, download the Unified Linux Driver 
package to your computer.

4.Right click the Unified Linux Driver package and extract the package. 
5.Double click cdroot > autorun.
6.When the welcome screen appears, click Next.

7.When the installation is complete, click Finish.
The installation program has added the Unified Driver Configurator 
desktop icon and the Unified Driver group to the system menu for your 
convenience. If you have any difficulties, consult the on screen help that 
is available through your system menu or can otherwise be called from 
the driver package Windows applications, such as Unified Driver 
Configurator or Image Manager.

Installing the SmartPanel
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download the Smart Panel package to 
your computer.

4.Right click the Smart Panel package and extract the package. 
5.Double click cdroot > Linux > smartpanel > install.sh.

Installing the Printer Setting Utility
1.Make sure that the machine is connected to your computer and 

powered on.
2.When the Administrator Login window appears, type in root in the 

Login field and enter the system password.

 

You must log in as a super user (root) to install the machine 
software. If you are not a super user, ask your system 
administrator.

3.From the Samsung website, download the Printer Setting Utility 
package to your computer.

4.Right click the Printer Setting Utility package and extract the 
package. 

5.Double click cdroot > Linux > psu > install.sh.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it again. 
Follow the steps below to uninstall the driver for Linux.
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a)Make sure that the machine is connected to your computer and 
powered on.

b)When the Administrator Login window appears, type in “root” 
in the Login field and enter the system password.
You must log in as a super user (root) to uninstall the printer 
driver. If you are not a super user, ask your system 
administrator.

c)Click the icon at the bottom of the desktop. When the Terminal 
screen appears, type in:
[root@localhost root]#cd /opt/Samsung/mfp/uninstall/
[root@localhost uninstall]#./uninstall.sh

d)Click Uninstall.
e)Click Next. 
f)Click Finish.

Sharing your machine locally
Follow the steps below to set up the computers to share your machine 
locally.
If the Host computer is directly connected to the machine with a USB cable 
and is also connected to the local network environment, the client computer 
connected to the local network can use the shared machine through the 
host computer to print. 

 

1
Host computer A computer which is directly connected to 

the machine by USB cable.
 

2
Client computers Computers which use the machine shared 

through the host computer. 

Windows
Setting up a host computer
1.Install your printer driver (See "Installing USB connected machine’s 

driver" on page 3, "Installing network connected machine’s driver" on 
page 3).

2.Click the Windows Start menu. 
3.For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
4.Right click your printer icon. 
5.For Windows XP/2003/2008/Vista, press Properties.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.

 

If Printer properties item has ► mark, you can select other 
printer drivers connected with selected printer.

6.Select the Sharing tab.

7.Check the Change Sharing Options.
8.Check the Share this printer.
9.Fill in the Share Name field. Click OK.

Setting up a client computer
1.Install your printer driver (See "Installing USB connected machine’s 

driver" on page 3).
2.Click the Windows Start menu. 
3.Select All programs > Accessories > Window Explorer.
4.Enter in the IP address of the host computer and press Enter. 

 

In case host computer requires User name and Password, fill 
in User ID and password of the host computer account.

5.Right click the printer icon you want to share and select Connect.
6.When the set up complete message appears, click OK. 
7.Open the file you want to print and start printing. 

Macintosh

 

The following steps are for Mac OS X 10.5~10.6. Refer to Mac Help 
for other OS versions. 

Setting up a host computer
1.Install your printer driver (See "Macintosh" on page 4, "Macintosh" on 

page 5).
2.Open the Applications folder > System Preferences and click Print 

& Fax. 
3.Select the printer to share in the Printer List. 
4.Select Share this printer.

Setting up a client computer
1.Install your printer driver (See "Installing USB connected machine’s 

driver" on page 3).
2.Open the Applications folder > System Preferences and click Print 

& Fax. 
3.Press the “+” icon. 

A display window showing the name of your shared printer appears.
4.Select your machine and click Add. 



1.network setup
This chapter gives you step-by-step instructions for setting up the network connected machine and software.
This chapter includes:
• Network environment
• Introducing useful network programs
• Using a wired network

• Installing network connected machine’s driver
• IPv6 Configuration

  

Network environment
You need to set up the network protocols on the machine to use it as your 
network machine. You can set up the basic network settings through the 
machine's control panel.
The following table shows the network environments supported by the 
machine:

Item Requirements

Network interface • Ethernet 10/100 Base-TX
• 802.11 b/g Wireless LAN (Optional)

Network operating system • Windows 
2000/XP/2003/2008/Vista/7/2008 
Server R2

• Various Linux OS
• Mac OS X 10.3 ~ 10.6
• UNIX

Network protocols • TCP/IPv4
• DHCP, BOOTP
• DNS, WINS, Bonjour, SLP, UPnP
• Standard TCP/IP Printing (RAW), LPR, 

IPP, WSD
• SNMPv 1/2/3, HTTP (S), Telnet, SMTP 

(S), LDAP (S), IPSec
• SMB, FTP, Kerberos
• TCP/IPv6 (DHCP, DNS, RAW, LPR, 

SNMPv 1/2/3, HTTP (S), IPSec)
(See "IPv6 Configuration" on page 6.)

Wireless security 
(Optional)

• Authentication: Open System, Shared 
Key, WPA Personal, WPA2 Personal 
(PSK)

• Encryption: WEP64, WEP128, TKIP, 
AES

Introducing useful network programs
There are several programs available to setup the network settings easily in 
network environment. For the network administrator especially, managing 
several machines on the network is possible.

 

Before using the programs below, set the IP address first.

SyncThru™ Web Service
Web server embedded on your network machine, which allows you to:
• Configure the network parameters necessary for the machine to connect 

to various network environments.
• Customize machine settings.

(See "Using SyncThru™ Web Service" on page 1.)

SyncThru™ Web Admin Service
A web-based machine management solution for network administrators. 
SyncThru™ Web Admin Service provides you with an efficient way of 
managing network devices and lets you remotely monitor and troubleshoot 
network machines from any site with corporate internet access. Download 
this program from http://solution.samsungprinter.com.

SetIP
This utility program allows you to select a network interface and manually 
configure the IP addresses for use with the TCP/IP protocol (See "IPv4 
setting using SetIP Program (Windows)" on page 2 , "IPv4 setting using 
SetIP Program (Macintosh)" on page 2 or "IPv4 setting using SetIP Program 
(Linux)" on page 3).

 

TCP/IPv6 is not supported by this program.

Using a wired network
You must set up the network protocols on your machine to use it on your 
network. This chapter will show you how this is easily accomplished.
You can use network after connecting network cable to a corresponding 
port on your machine. 

Printing configuration report
You can print a Network Configuration Report from the machine’s control 
panel that will show the current machine’s network settings. This will help 
you to set up a network and troubleshoot problems.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Report and press OK.
4. Press the up/down arrow to highlight Network Info. and press OK.
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5. Press OK when Yes highlights to confirm printing. 
The Network Configuration Report prints.

Using this Network Configuration Report, you can find your machine MAC 
address and IP address.
For example:
• MAC Address : 00:15:99:41:A2:78
• IP Address : 192.0.0.192

Setting IPv4 address
You must set up an IPv4 address for network printing and management. In 
most cases a new IP address will be automatically assigned by a DHCP 
(Dynamic Host Configuration Protocol) server located on the network.

 

If you use IPv6 address, refer to "IPv6 Configuration" on page 6

In a few situations the IP address must be set manually. This is called a 
static IP and is often required in corporate Intranets for security reasons.
• DHCP IP assignment: Connect your machine to the network, and wait a 

few minutes for the DHCP server to assign an IP address to the 
machine. Then, print the Network Configuration Report as explained 
above. If the report shows that the IP address has changed, the 
assignment was successful. You will see the new IP address in the 
report.

• Static IP assignment: Use the SetIP program to change the IP address 
from your computer. If your machine has a control panel, you can also 
change the IP address using the machine's control panel.

In an office environment, we recommend that you contact a network 
administrator to set this address for you.

IPv4 setting using control panel
1.Connect your machine to the network with an network cable.
2.Turn on the machine.
3.Press Menu on the control panel.
4.Press the up/down arrow to highlight Network and press OK.
5.Press the up/down arrow to highlight TCP/IP (IPv4) and press OK.
6.Press the up/down arrow to highlight Static and press OK.
7.Press the up/down arrow to highlight IP Address and press OK.
8.Enter the IP address using numeric keypad and press OK.
9.Enter other parameters, such as the Subnet Mask and Gateway and 

press OK.
10.After entering all parameters, press Stop/Clear to return to ready 

mode.
Now go to "Installing network connected machine’s driver" on page 3.

IPv4 setting using SetIP Program (Windows)
This program is for manually setting the network IP address of your 
machine using its MAC address to communicate with the machine. A 
MAC address is the hardware serial number of the network interface and 
can be found in the Network Configuration Report.
For using SetIP program, disable the computer firewall before continuing 
by performing the following:
1.Open Control Panel.
2.Double click Security Center.
3.Click Windows Firewall.
4.Disable the firewall.

Installing the program
1.Insert the Printer Software CD-ROM provided with your machine. 

When the driver CD runs automatically, close that window.
2.Start a web browser such as Internet Explorer and open the X drive. (X 

represents your CD-ROM drive.)
3.Double-click Application > SetIP.
4.Double-click Setup.exe to install this program.
5.Click OK. If necessary, select a language from the drop-down list.
6.Follow the instructions in the window and complete the installation.

Starting the program
1.Connect your machine and the computer using network cable.
2.Turn on the machine.
3.From the Windows Start menu, select All Programs > Samsung 

Printers > SetIP > SetIP.
4.Click on the  icon (third from left) in the SetIP window to open the 

TCP/IP configuration window.
5.Enter the machine’s new information into the configuration window as 

follows:

•MAC Address : Find the machine’s MAC address on the Network 
Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

 

A MAC address is a hardware serial number of the machine’s 
network interface and can be found in the Network 
Configuration Report.

•IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

•Subnet Mask: Enter a new Subnet Mask for your machine.
•Default Gateway: Enter a new Gateway for your machine.

6.Click Apply, and then click OK. The machine will automatically print 
the Network Configuration Report. Confirm that all of the settings 
are correct.

7.Click Exit to close the SetIP program.
8.If necessary, restart the computer’s firewall.

IPv4 setting using SetIP Program (Macintosh)
For using SetIP program, disable the computer firewall before continuing 
by performing the following:

 

The path and UIs may differ by Mac OS version. Refer to the Mac 
OS manul to turn firewall off.

1.Open System Preferences.
2.Click Security.
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3.Click the Firewall menu.
4.Turn the firewall off.

 

The following instructions may vary for your model.

Perform the following to configure the IP address:
1.Connect your machine and the computer using network cable.
2.Insert the Installation CD-ROM, and open the disk window. Open the 

MAC_Installer > MAC_Printer > SetIP > SetIPApplet.html.
3.Double click the file and Safari will automatically open, then select 

Trust. The browser will open the SetIPApplet.html page that shows 
the printer’s name and IP address information. 

4.Click on the  icon (third from left) in the SetIP window to open the 
TCP/IP configuration window.

5.Enter the printer’s new information into the configuration window as 
follows. In a corporate intranet, you may need to have this 
information assigned by a network manager before proceeding.
•MAC Address: Find the machine’s MAC address from the Network 

Configuration Report and enter it without the colons. For 
example, 00:15:99:29:51:A8 becomes 0015992951A8.

 

The MAC address is the hardware serial number of the 
on-board network interface and can be found on the 
Network Configuration Report.

•IP Address: Enter a new IP address for your printer.
For example, if your computer’s IP address is 192.168.1.150, 
enter 192.168.1.X. (X is number between 1 and 254 other than 
the computer’s address.)

•Subnet Mask: Enter a new Subnet Mask for your machine.
•Default Gateway: Enter a new Gateway for your machine.

6.Select Apply, then OK, and OK again. The printer will automatically 
print the configuration report. Confirm that all of the settings are 
correct. Quit Safari. You may close and eject the installation 
CD-ROM. If necessary, restart the computer’s firewall. You have 
successfully changed the IP address, subnet mask, and gateway.

IPv4 setting using SetIP Program (Linux)
The SetIP program should be automatically installed during the printer 
driver installation.

 

The path and UIs may differ by Linux OS version. Refer to the 
Linux OS manual to turn firewall off.

1.Print the machine’s network configuration report to find your machine’s 
MAC address. 

2.Open the /opt/Samsung/mfp/share/utils/.
3.Double click the SetIPApplet.html file. 
4.Click to open the TCP/IP configuration window. 
5.Enter the MAC address, IP address, subnet mask, default gateway, 

and then click Apply. 

 

When you enter the MAC address, enter it without a colon(:).

6.The machine prints the network information. Confirm all of the settings 
are correct. 

7.Close the SetIP program. 

Network parameter setting
You can also set up the various network settings through the network 
administration programs such as SyncThru™ Web Admin Service and 
SyncThru™ Web Service.

Restoring factory default settings using SyncThru™ 
Web Service
1.Start a web browser such as Internet Explorer, Safari or Firefox and 

enter your machine’s new IP address in the browser window.
For example,

2.Click Go to access the SyncThru™ Web Service.
3.Click Login on the upper right of the SyncThru™ Web Service 

website.
A log-in page appears. 

4.Type in the ID and Password then click Login .
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

5.When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Restore Default.

6.Click Clear for network.
7.Turn off and restart machine to apply settings.

Installing network connected machine’s driver
You must install the printer driver software for printing. The software 
includes drivers, applications, and other user friendly programs.
Make sure that the network setup for your machine is completed. All 
applications should be closed on your computer before beginning 
installation. 

Windows
This is recommended for most users. All components necessary for 
machine operations will be installed.
Follow the steps below:
1. Make sure that the machine is connected to the network and powered 

on.
2. Insert the supplied software CD into your CD-ROM drive.

•The software CD should automatically run and an installation window 
appear.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2, 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, Windows 7 and 
Windows 2008 Server R2, click Run Setup.exe in Install or run 
program field, and click Continue or Yes in the User Account 
Control windows.
Network setup_ 3



3. Select Install now.

If necessary, select a language from the drop-down list.

 

•For CLX-6250 Series installation window, you can see Wireless 
Setting and Installation menu. You can use this menu if an 
optional wireless network card is installed and/or the machine 
is connected to your computer with a USB cable. 
Install the optional wireless network card. Instructions for 
Wireless Setting and Installation, refer to the wireless 
network installation guide provided with the optional wireless 
network card. 

•The Advanced Installation has two options, Custom 
Installation and Install Software Only. Custom Installation 
allows you to select the machine’s connection and choose 
individual component to install. Install Software Only allows 
you to install the supplied software, such as Smart Panel. 
Follow the guide in the window.

•Administrator Installation provides convenient installation 
methods useful for administrators (See "Administrator’s Guide 
(Windows only)" on page 1).

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

The program searches for the machine.

 

If your machine is not found in the network or locally, the following 

window will appear.

•Check if you want to install the software without connecting 
the printer to the network or locally.
-Check this option to install this program without a machine 

connected. In this case, the print a test page window will be 
skipped, and completes the installation.

•Search again
When you press this button, the firewall notice window 
appears;
-Turn off the firewall and Search again. For Window operating 

system, click Start > Control Panel > Windows Firewall, 
and inactivate this option. For other operating systems, 
refer to their on-line guides.

-Turn off all firewall from the third party's program beside the 
operating system. Refer to the manual provided by 
individual programs.

•Direct Input
The Direct Input allows you to search a specific machine on 
the network.
-Search by IP address: Enter the IP address or the host 

name. Then click Next.
To verify your machine’s IP address, print a network 
configuration report (See "Printing a machine report" on 
page 1).

-Search by network path: To find a shared machine (UNC 
Path), enter the shared name manually or find a shared 
printer by clicking the Browse button. Then click Next.

•Help
If your machine is not connected to the computer or network, 
This help button gives detailed information about the how to 
connect the machine.

5. The searched machines will be shown on the screen. Select the one you 
wish to use and click Next.

 

If the driver searched only one machine, the confirmation window 
appears.

6. After the installation is finished, a window asking you to print a test page 
appears. If you want to print a test page, click Print a test page.
Otherwise, just click Next and skip to step 8.

7. If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8. To register as a user of the machine in order to receive information from 
Samsung, click On-line Registration.
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9. Click Finish.

 

•After the driver setup, you may enable firewall.
•If the printer driver does not work properly, follow the steps below to 

repair or reinstall the driver. 
a)Make sure that the machine is connected to your machine and 

powered on.
b)From the Start menu, select Programs or All Programs > 

Samsung Printers > your printer driver name > 
Maintenance.

c)Select the option as you wish, follow the instruction on the 
window.

Macintosh
1. Make sure that the machine is connected to your network and powered 

on. Also, your machine’s IP address should have been set. 
2. Insert the supplied software CD into your CD-ROM drive.
3. Double-click the CD-ROM icon that appears on your Macintosh desktop.
4. Double-click the MAC_Installer folder.
5. Double-click the Installer OS X icon.
6. Enter the password and click OK.
7. The Samsung Installer window opens. Click Continue.
8. Read the license agreement and click Continue.
9. Click Agree to agree to the license agreement.
10. The Samsung Installer window opens. Click Continue.
11. Select Easy Install and click Install. Easy Install is recommended for 

most users. All components necessary for machine operations will be 
installed. 
•If you select Custom Install, you can choose individual components to 

install.
12. The message which warns that all applications will close on your 

computer appears. Click Continue.

 

If you select Typical installation for a network printer during the 
machine driver installation, the SetIP program automatically runs. 
If the machine has already configured network information, close 
the SetIP program. Go to the next step.

13. After the installation is finished, click Quit.
14. Open the Applications folder > Utilities > Print Setup Utility.

•For Mac OS X 10.5~10.6, open the Applications folder > System 
Preferences and click Print & Fax.

15. Click Add on the Printer List.
•For Mac OS X 10.5~10.6, click the “+” icon; a display window will pop 

up. 
16. For Mac OS X 10.3, select the IP Printing tab. 

•For Mac OS X 10.4, click IP Printer.
•For Mac OS X 10.5~10.6, click IP.

17. Select Socket/HP Jet Direct in Printer Type.

 

When printing a document containing many pages, printing 
performance may be enhanced by choosing Socket for Printer 
Type option.

18. Enter the machine’s IP address in the Printer Address field.
19. Enter the queue name in the Queue Name field. If you cannot determine 

the queue name for your machine server, try using the default queue 
first.

20. For Mac OS X 10.3, if Auto Select does not work properly, select 
Samsung in Printer Model and your machine name in Model Name.

•For Mac OS X 10.4, if Auto Select does not work properly, select 
Samsung in Print Using and your machine name in Model. 

•For Mac OS X 10.5~10.6, if Auto Select does not work properly, select 
Select a driver to use... and your machine name in Print Using. 

Your machine appears on the Printer List, and is set as the default 
machine.

21. Click Add.

 

If the printer driver does not work properly, uninstall the driver and 
reinstall it. 
Follow steps below to uninstall the driver for Macintosh.
a)Make sure that the machine is connected to your computer and 

powered on.
b)Insert the supplied software CD into your CD-ROM drive.
c)Double-click CD-ROM icon that appears on your Macintosh 

desktop.
d)Double-click the MAC_Installer folder.
e)Double-click the Installer OS X icon.
f)Enter the password and click OK.
g)The Samsung Installer window opens. Click Continue.
h)Select Uninstall and click Uninstall. 
i)When the message which warns that all applications will close on 

your computer appears, Click Continue.
j)When the uninstall is done, click Quit.

Linux
Install Linux Driver
1.Make sure that the machine is connected to your network and 

powered on. Also, your machine’s IP address should have been set. 
2.From the Samsung website, download the Unified Linux Driver 

package to your computer.
3.Right click the Unified Linux Driver package and extract the package. 
4.Double click cdroot > autorun.
5.The Samsung Installer window opens. Click Continue.
6.The Add printer wizard window opens. Click Next.
7.Select Network printer and click Search button.
8.The Printer’s IP address and model name appears on list field.
9.Select your machine and click Next.
10.Input the printer description and Next.
11.When the add printer is done, click Finish.
12.When the install is done, click Finish.

Add network Printer
1.Double-click the Unified Driver Configurator.
2.Click Add Printer…
3.The Add printer wizard window opens. Click Next.
4.Select Network printer and click the Search button.
5.The printer’s IP address and model name appears on list field.
6.Select your machine and click Next.
7.Input the printer description and Next
8.When the add printer is done, click Finish.

UNIX
To use UNIX Printer Driver, you have to install the UNIX printer driver 
package first, then setup the printer. You can download the UNIX Printer 
Driver package from the Samsung website.
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Installing the UNIX printer driver package
Installation procedure is common for all variants of UNIX OS mentioned 
(See "UNIX" on page 3).
1.From the Samsung website, download and unpack the UNIX Printer 

Driver package to your computer.
2.Acquire root privileges. 

su -
3.Copy appropriate driver archive to the target UNIX computer.

 

See administration guide of your UNIX OS for details.

4.Unpack the UNIX printer driver package archive.
For example, on IBM AIX use the following commands.
cd /tmp
gzip –dc /cdrom/unix/packages/aix_power/aix_power.tar.gz | tar 
–xvf –
The “binaries” folder consists of binz, install, share files and folders

5.Copy the “binaries” folder to any local folder.
6.Change to the driver’s “binaries” directory.

cd aix_power/binaries
7.Run the install script.

./install
install is the installer script file which is used to install or uninstall the 
UNIX Printer Driver package.
Use “chmod 755 install” command to give the permission to the 
installer script.

8.Execute the “. /install –c” command to verify install results.
9.Run ‘installprinter’ from the command line. This will bring up the Add 

Printer Wizard window. Setup the printer in this window referring the 
procedure next.

 

On some UNIX OS, for example on Solaris 10 just added 
printer may not be enabled and/or may not accept jobs. In this 
case run the following two commands on the root terminal:
accept <printer_name>
enable <printer_name>

Uninstalling the printer driver package

 

The uninstalling printer utility should be used to delete the printer 
installed in the system.
a)Run “uninstallprinter” command from the terminal.

It will open the Uninstall Printer Wizard
The installed printers are listed in the drop-down list

b)Select the printer to be deleted.
c)Click Delete to delete the printer from the system.
d)Execute the “. /install –d” command to uninstall the whole 

package.
e)To verify uninstall results, execute the “. /install –c” command.

To reinstall it again, use the command “. /install” to reinstall the binaries.

Setting up the printer
To add the printer to your UNIX system, run ‘installprinter’ from the 
command line. This will bring up the Add Printer Wizard window. Setup 
the printer in this window according to the following steps:
1.Type the name of the printer.
2.Select appropriate printer model from model list.
3.Enter any decsription corresponding to the type of the printer in the 

Type field. This is optional.

4.Specify any printer description in the Description field. This is 
optional.

5.Specify printer location in the Location field.
6.Type the IP address or DNS name of the printer in the Device textbox 

for network-connected printers. On IBM AIX with jetdirect Queue 
type only DNS name is possible, numeric IP address is not allowed.

7.Queue type shows the connection as lpd or jetdirect in the 
corresponding list box. Additionally usb type is available on Sun 
Solaris OS.

8.Select Copies to set the number of copies.
9.Check the Collate option to receive copies already sorted.
10.Check the Reverse Order option to receive copies in the reverse 

order.
11.Check the Make Default option to set this printer as default.
12.Click OK to add the printer.

IPv6 Configuration

 

TCP/IPv6 is supported properly only in Windows Vista or higher.

 

If the IPv6 network seems to not be working, set all the network setting 
to the factory defaults and try again (See "Restoring factory default 
settings using SyncThru™ Web Service" on page 3).

To use the IPv6 network environment, follow the next procedure to use the 
IPv6 address:
1. Connect your machine to the network with a network cable.
2. Turn on the machine.
3. Print a Network Configuration Report from the machine’s control 

panel that will check IPv6 addresses.

 

a)Press Menu on the control panel.
b)Press the up/down arrow to highlight Network and press OK.
c)Press the up/down arrow to highlight Network Info. and press 

OK.
4. Select Start > Control Panel > Hardware and Sound > Printers > Add 

Printer.
5. Click Add a local printer on the Add Printer windows.
6. Follow the instruction on the window.

 

If the machine does not work in the network environment, activate 
IPv6. Refer to the next section followed by.

Activating IPv6
1. Connect your machine to the network with a network cable.
2. Turned on the machine.
3. Press Menu on the control panel.
4. Press up/down arrow to highlight Network and press OK.
5. Press up/down arrow to highlight TCP/IP (IPv6) and press OK.
6. Press up/down arrow to highlight IPv6 Activate and press OK.
7. Press up/down arrow to highlight On and press OK.

 

On is set as a default.

8. Turn the machine off and turn it on again.
9. Print a Network Configuration Report from the machine’s control 

panel that will check IPv6 addresses.

 

1.Press Menu on the control panel.
2.Press up/down arrow to highlight Network and press OK.
3.Press up/down arrow to highlight Network Info. and press OK.
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Setting IPv6 addresses
Machine supports following IPv6 addresses for network printing and 
managements.
• Link-local Address: Self-configured local IPv6 address. (Address starts 

with FE80.)
• Stateless Address: Automatically configured IPv6 address by a 

network router.
• Stateful Address: IPv6 address configured by a DHCPv6 server.
• Manual Address: Manually configured IPv6 address by a user.

DHCPv6 address configuration (Stateful)
If you have a DHCPv6 server on your network, you can set one of the 
following option for default dynamic host configuration:
1.Press Menu on the control panel.
2.Press up/down arrow to highlight Network and press OK.
3.Press up/down arrow to highlight TCP/IP (IPv6) and press OK.
4.Press up/down arrow to highlight DHCPv6 Config and press OK.
5.Press up/down arrow to access the required value.

•Routers: Use DHCPv6 only when requested by a router.
•DHCPv6 Addresses: Always use DHCPv6 regardless of router 

request.
•DHCPv6 Off: Never use DHCPv6 regardless of router request.

6.Press OK.

Manual address configuration
1.Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL (See "Connecting SyncThru™ Web Service" 
on page 7).

 

For IPv4, enter the IPv4 address (http://xxx.xxx.xxx.xxx) in the 
address field and press the Enter key or click Go.

2.Click Login on the upper right of the SyncThru™ Web Service 
website.
A log-in page appears. 

3.Type in the ID and Password then click Login .
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

4.When the SyncThru™ Web Service window opens, click Settings > 
Network Settings.

5.Click TCP/IPv6.
6.Enable the Manual Address In the TCP/IPv6 section.

 

IPv6 Protocol should enable.

7.Select the Address / Prefix and click the Add button, then the router 
prefix will automatically be entered into the address field. 
Enter the rest of address. (ex: 3FFE:10:88:194::AAAA. “A” is the 
hexadecimal 0 through 9, A through F.)

8.Click the Apply button.

Installing printer driver
Driver installation for network printer in IPv6 network environment is same 
as TCP/IPv4 (See "Installing network connected machine’s driver" on 
page 3).
Select TCP/IP Port and when the list of machines are displayed, simply 
select your machine's IPv6 address.

Connecting SyncThru™ Web Service
1. Start a web browser such as Internet Explorer that supports IPv6 

addressing as a URL .
2. Click Go to access the SyncThru™ Web Service.
3. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
4. Type in the ID and Password then click Login .

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

5. Select one of the IPv6 addresses (Link-local Address, Stateless 
Address, Stateful Address, Manual Address) from Network 
Configuration Report.

6. Enter the IPv6 addresses. (ex: http://[FE80::215:99FF:FE66:7701]) 

 

Address must be enclosed in '[]' brackets.



1.basic setup
After installation is complete, you may want to set the machine’s default settings. Refer to the next section if you would like 
to set or change values. This chapter gives you step-by-step instructions for setting up the machine.
This chapter includes:
• Altitude adjustment
• Changing the display language
• Setting the date and time
• Changing the clock mode
• Changing the default mode
• Setting sounds
• Entering characters using the number keypad
• Using the power saving mode

• Setting job timeout
• Auto continue
• Paper substitution
• Net accounting
• Setting the color report
• Setting the default tray and paper
• Changing the font setting

  

Altitude adjustment
The print quality is affected by atmospheric pressure, which is determined 
by the height of the machine above sea level. The following information will 
guide you on how to set your machine to the best print quality or best quality 
of print.
Before you set the altitude value, determine the altitude where you are.

0

1 High 3
2 High 2
3 High 1
4 Normal

In the control panel
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Altitude Adjust and press OK.
5. Press the up/down arrow until the setting option you want appears.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

In the computer
1. Double-click the Smart Panel icon on the Windows task bar (or 

Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X (See "Understanding Smart Panel" on page 2).
Or, if you are a Windows user, you can launch it from the Start menu, 
select Programs or All Programs > Samsung Printers > your printer 
driver name > Smart Panel.

2. Click Printer Setting.
3. Click Setting > Altitude Adjustment. Select the appropriate value from 

the dropdown list, and then click Apply.

 

If your machine is connected to a network, SyncThru™ Web Service 
screen appears automatically. Click Settings > Machine Settings > 

System > Setup > Altitude Ad.. Select the appropriate altitude value, 
and then click Apply.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

Changing the display language
To change the language that appears on the display, follow the steps below:
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Language and press OK.
5. Press the up/down arrow to display the language you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting the date and time
When you set the time and date, they are used in delay fax and delay print. 
They are printed on reports. If, however, they are not correct, you need to 
correct it to the present date and time.

 

If the machine’s power is cut off, you need to reset the correct time 
and date once the power has been restored.

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Date & Time and press OK.
5. Enter the correct time and date using up/down, left/right arrow or 

numeric keypad.
Month = 01 to 12,
Day = 01 to 31,
Year = requires four digits,
Hour = 01 to 12,
Minute = 00 to 59
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6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Changing the clock mode
You can set your machine to display the current time using either a 12-hour 
or 24-hour format.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Clock Mode and press OK.
5. Press the up/down arrow to select the other mode and press OK.
6. Press Stop/Clear to return to ready mode.

Changing the default mode
Your machine is preset to Copy mode. You can switch this default mode 
between Fax mode and Copy mode.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Default Mode and press OK.
5. Press the up/down arrow to select the mode you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting sounds
You can control the following sounds:
• Key Sound: Turns the key sound On or Off. With this option set to On, 

a tone sounds each time a key is pressed.
• Alarm Sound: Turns the alarm sound On or Off. With this option set to 

On, an alarm tone sounds when an error occurs or fax communication 
ends.

• Speaker: Turns On or Off the sounds from the telephone line through 
the speaker, such as a dial tone or a fax tone. With this option set to 
Comm. which means “Comm.”, the speaker is on until the remote 
machine answers.

 

You can adjust the volume level using On Hook Dial.

• Ringer: Adjusts the ringer volume. For the ringer volume, you can 
select Off, Low, Mid, and High.

Speaker, ringer, key sound, and alarm sound
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Sound/Volume and press OK.
4. Press the up/down arrow until the sound option you want highlights and 

press OK.
5. Press the up/down arrow until the desired status or volume for the sound 

you have selected highlights and press OK.
6. If necessary, repeat steps 4 through 5 to set other sounds.
7. Press Stop/Clear to return to ready mode.

Speaker volume
To adjust the volume using On Hook Dial:

1. Press On Hook Dial. A dial tone sounds from the earpiece.
2. Press the left/right arrow until you hear the volume you want.
3. Press On Hook Dial to save the change and return to ready mode.

Entering characters using the number keypad
As you perform various tasks, you may need to enter names and numbers. 
For example, when you set up your machine, you enter your name or your 
company’s name, and the fax number. When you store fax numbers or 
email addresses in memory, you may also enter the corresponding names.

Entering alphanumeric characters
1. When you are prompted to enter a letter, locate the button labeled with 

the character you want. Press the button until the correct letter appears 
on the display. 
For example, to enter the letter O, press 6, labeled with MNO.
Each time you press 6, the display shows a different letter, M, N, O, m, 
n, o and finally 6.
You can enter special characters, such as space, plus sign, and etc. For 
details, see the below section.

2. To enter additional letters, repeat step 1.
If the next letter is printed on the same button, move the cursor by 
pressing the left/right arrow button and then press the button labeled 
with the letter you want. The cursor will move to the right and the next 
letter will appear on the display.
You can enter a space by pressing 1 twice.

3. When you have finished entering letters, press OK.

Keypad letters and numbers

 

Some of the follow key values may not appear depending on the job 
you are doing.

Key Assigned numbers, letters, or characters

1 @ / . ‘ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0_

* *
% ^ ~ ! # $ ( ) [ ] (These symbols are available when you type 
for network authentication.)

# #
= | ? " : { } < > ; (These symbols are available when you type for 
network authentication.)



Correcting numbers or names
If you make a mistake while entering a number or name, press the left/right 
arrow button to delete the last digit or character. Then enter the correct 
number or character.

Inserting a pause
With some telephone systems, you must dial an access code (9, for 
example) and listen for a second dial tone. In such cases, you must insert a 
pause in the telephone number. You can insert a pause while you are 
setting up speed dial numbers.
To insert a pause, press Redial/Pause at the appropriate place while 
entering the telephone number. A dash(-) appears on the display at the 
corresponding location.

Using the power saving mode
When you are not using the machine for a while, use this feature to save 
power. 
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Power Save and press OK.
5. Press the up/down arrow to select the time you want.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting job timeout
When there is no input for a certain period of time, the machine exits the 
current menu and goes in to the default settings. You can set the amount of 
time the machine will wait.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Job Timeout and press OK.
5. Enter the time using up/down arrow or numeric keypad.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Auto continue
This is the option to set the machine to continue printing or not, in case that 
the paper size you have set and the paper in the tray mismatches.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Auto Continue and press OK.
5. Press the up/down arrow until the setting option you want appears.

•On: Automatically prints after set time passes, when the paper size 
mismatches the tray paper size.

•Off: Waits until you press Start on the control panel, when the paper 
size mismatches the tray paper size.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Paper substitution
This option is to prevent the paper mismatch between tray and the printer 
driver. For example, if you have A4 paper in the tray but you set the paper 
size to Letter in the printer driver, the machine prints on A4 paper and vice 
versa. 

 

This option only works for mismatch between A4 and Letter paper. 

1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Paper Substitution and press OK.
5. Press the up/down arrow to highlight On and press OK.
6. Press Stop/Clear to return to ready mode.

Net accounting
This is the option limits the number of use for fax, printer, copy and scan. 
First, the administrator needs to install the Job account Plug-in from 
SyncThru™ Web Admin Service. Then, create user accounts by entering 
user ID and Password in SyncThru™ Web Admin Service.
If you are not registered, request Administrator for a registration.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Net Accounting and press OK.
5. Press the up/down arrow until the setting option you want appears.

•Protect: Select the option for which you want to enable or disable net 
accounting. 

•Change Password: The access password code can be changed.
6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.

Setting the color report
This menu allows you to print reports in color. 
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Color Report and press OK.
5. Press the up/down arrow to highlight On and press OK.
6. Press Stop/Clear to return to ready mode.

Setting the default tray and paper
You can select the tray and paper you would like to keep using for printing 
job.

 

Wide A4 is useful when printing in DOS mode. This option prints 80 
charactors in a line, which printing 78 charactors in a line is usual in 
DOS mode.

In the control panel
Setting the paper size
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Paper Setup and press OK.
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4.Press the up/down arrow to highlight Paper Size and press OK.
5.Press the up/down arrow to select the paper tray you want and press 

OK.
6.Press the up/down arrow to select the paper size you want.
7.Press OK to save the selection.
8.Press Stop/Clear to return to ready mode.

Setting the paper type
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Paper Setup and press OK.
4.Press the up/down arrow to highlight Paper Type and press OK.
5.Press the up/down arrow to select the paper tray you want and press 

OK.
6.Press the up/down arrow to select the paper type you want.
7.Press OK to save the selection.
8.Press Stop/Clear to return to ready mode.

Setting the paper source
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Paper Setup and press OK.
4.Press the up/down arrow to highlight Paper Source and press OK.
5.Press the up/down arrow to highlight Copy Tray or Fax Tray and 

press OK.
6.Press the up/down arrow to select the paper tray you want.
7.Press OK to save the selection.
8.Press Stop/Clear to return to ready mode.

In the computer
Windows
1.Click the Windows Start menu. 
2.For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3.Right-click your machine.
4.For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printing Preferences.

 

If Printing Preferences item has ► mark, you can select other 
printer drivers connected with selected printer.

5.Click Paper tab. 
6.Select tray and its options, such as paper size and type.
7.Press OK.

 

If you want to use special-sized paper such as a billing paper, 
select Paper tab > Size > Edit... in the Printing Preferences (See 
"Opening printing preferences" on page 2).

Macintosh
Macintosh does not support this function. Macintosh users need to 
change the default setting manually each time they want to print using 
other settings. 

1.Open a Macintosh application and select the file you want to print.
2.Open the File menu and click Print.
3.Go to Paper Feed pane.
4.Set appropriate tray from which you want to print.
5.Go to Paper pane.
6.Set paper type to correspond to the paper loaded in the tray from 

which you want to print.
7.Click Print to print. 

Linux
1.Open Terminal Program
2.When the Terminal screen appears, type in the following: 

[root@localhost root]# lpr [FileName]
3.Select Printer and click Properties…
4.Click Advanced tab.
5.Select tray (source) and its options, such as paper size and type.
6.Press OK.

Changing the font setting 
Your machine has preset the font for your region or country.
If you want to change the font or set the font for special condition, such as 
the DOS environment, you can change the font setting as follows:
1. Double-click the Smart Panel icon on the Windows task bar (or 

Notification Area in Linux). You can also click Smart Panel on the status 
bar in Mac OS X. 
Or, if you are a Windows user, you can launch it from the Start menu, 
select Programs or All Programs > Samsung Printers > your printer 
driver name > Smart Panel.

2. Click Printer Setting.
3. Click Emulation.
4. Confirm if PCL is selected in Emulation Setting.
5. Click Apply.

 

Following information shows the proper font list for corresponding 
languages.
•Russian: CP866, ISO 8859/5 Latin Cyrillic
•Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
•Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
•Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
•OCR: OCR-A, OCR-B
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1.media and tray
This chapter provides information on how to load originals and print media into your machine.
This chapter includes:
• Preparing originals
• Loading originals
• Selecting print media
• Changing the tray size

• Loading paper in the tray
• Printing on special media
• Setting the paper size and type
• Selecting an output location

  

Preparing originals
• Do not load paper smaller than 142 x 148 mm (5.6 x 5.8 inches) or 

larger than 216 x 356 mm (8.5 x 14 inches). 
• Do not attempt to load the following types of paper, in order to prevent 

paper jam, low print quality and machine damage.
-Carbon-paper or carbon-backed paper
-Coated paper
-Onion skin or thin paper
-Wrinkled or creased paper
-Curled or rolled paper
-Torn paper
-Used paper (Something previously printed on side one)

• Remove all staples and paper clips before loading.
• Make sure any glue, ink, or correction fluid on the paper is completely 

dry before loading.
• Do not load originals that include different sizes or weights of paper.
• Do not load booklets, pamphlets, transparencies, or documents with 

other unusual characteristics.

Loading originals
You can use the scanner glass or the automatic document feeder to load an 
original for copying, scanning and sending a fax.

On the scanner glass
Make sure that no originals are in the document feeder. If an original is 
detected in the document feeder, the machine gives it priority over the 
original on the scanner glass. To get the best scan quality, especially for 
colored or gray-scaled images, use the scanner glass.

1. Lift and open the scanner lid.

2. Place the original face down on the scanner glass. And align it with the 
registration guide at the top left corner of the glass.

3. Close the scanner lid.

 

•Leaving the scanner lid open while copying will create a black 
copy, and consume a great deal of toner.

•Dust on the scanner glass may cause black spots on the printout. 
Always keep it clean (See "Cleaning the scan unit" on page 3).

•If you are copying a page from a book or magazine, lift the 
scanner lid until its hinges are caught by the stopper and then 
close the lid. If the book or magazine is thicker than 30 mm, 
start copying with the lid open.



 

•Be careful not to break the scanner glass. You may get hurt.
•Do not put hands while closing the scanner lid. The scanner lid 

may fall on your hands and get hurt.
•Do not look the light from inside of the scanner while copying or 

scanning. It is harmful to eyes.

In the document feeder
Using the document feeder, you can load up to 40 sheets of paper (80 g/m2, 
20 lb bond) for one job. 
1. Flex or fan the edge of the paper stack to separate the pages before 

loading originals.

2. Load the original face up into the document feeder. Make sure that the 
bottom of the original stack matches the paper size marked on the 
document input tray.

3. Adjust the document width guides to the paper size.

 

Dust on the document feeder glass may cause black lines on the 
printout. Always keep the glass clean (See "Cleaning the scan 
unit" on page 3).

Selecting print media
You can print on a variety of print media, such as plain paper, envelopes, 
labels. Always use print media that meet the guidelines for use with your 
machine. 

Guidelines to select the print media
Print media that does not meet the guidelines outlined in this user’s guide 
may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear on the machine.
Properties, such as weight, composition, grain and moisture content, are 
important factors that affect the machine’s performance and the output 
quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described in print media specifications (See "Print media specifications" 
on page 3).

• Desired outcome: The print media you choose should be appropriate for 
your project.

• Brightness: Some print media are whiter than others and produce 
sharper, more vibrant images.

• Surface smoothness: The smoothness of the print media affects how 
crisp the printing looks on the paper.

 

•Some print media may meet all of the guidelines in this section and 
still not produce satisfactory results. This may be the result of 
improper handling, unacceptable temperature and humidity levels, 
or other variables over which cannot be controlled.

•Before purchasing large quantities of print media, ensure that it 
meets the requirements specifications in this user’s guide and 
meets your output requirements. 

 

Using print media that does not meet these specifications may cause 
problems, requiring repairs. Such repairs are not covered by the 
warranty or service agreements.

The amount of paper put into the tray may differ according to media type 
used (See "Print media specifications" on page 3).

Media sizes supported in each mode

Mode Size Source

Copy mode Letter, A4, Legal, 
Oficio, Folio, 
Executive, ISO B5, JIS 
B5, A5, A6

• Tray 1
• Optional tray 2
• Multi-purpose tray

Print mode All sizes supported by 
the machine.

• Tray 1
• Optional tray 2
• Multi-purpose tray

Fax mode Letter, A4, Legal • Tray 1
• Optional tray 2

Duplex printinga

a.75 to 105 g/m2 (20~28 lb bond) only 

Letter, A4, Legal, Folio, 
Oficio

• Tray 1
• Optional tray 2
• Multi-purpose tray
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Changing the tray size
The tray is preset to Letter or A4 size, depending on your country. To 
change the size, you need to adjust the paper guides.

1 Tray extend lever
2 Paper length guide
3 Paper width guide

1. Hold the tray with one hand, and with the other hand squeeze and slide 
the paper length guide to locate them in the correct paper size slot 
marked at the bottom of the tray.

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3. After inserting paper into the tray, squeeze the paper width guides and 
paper length guide. Then slide them to the desired paper size marked at 
the bottom of the tray.

1 Paper length guide
2 Paper width guide

 

•Do not push the paper width guide too far causing the media to 
warp. 

•If you do not adjust the paper width guide, it may cause paper 

jams.

Loading paper in the tray
Tray 1/optional tray 2
Load the print media you use for the majority of your print jobs into tray 1. 
Tray 1 can hold a maximum of 250 sheets of plain paper. 
You can purchase an optional tray and attach it below the standard tray to 
load an additional 500 sheets of plain paper (See "Available accessories" 
on page 2).

 

Using photographic paper or coated paper may cause problems, 
requiring repairs. Such repairs are not covered by the warranty or 
service agreements.

1. Pull out tray. And adjust the tray size to the media size you are loading 
(See "Changing the tray size" on page 3).

2. Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3. Place paper with the side you want to print facing up.

1 Paper limit mark
2 Paper level 

indicator

 



Paper quantity indicator shows the amount of paper in the tray. 

1 Full
2 Empty

4. When you print a document, set the paper type and size for the tray.
For information about setting the paper type and size on the control 
panel (See "Setting the paper size and type" on page 7).

 

•If you experience problems with paper feeding, check whether the 
paper meets the media specification. Then, try placing one 
sheet at a time in the multi-purpose tray (See "Print media 
specifications" on page 3).

•The settings made from the machine driver override the settings 
on the control panel.

a)To print in application, open an application and start the print 
menu.

b)Open Printing Preferences (See "Opening printing 
preferences" on page 2).

c)Press the Paper tab in Printing Preferences, and select an 
appropriate paper type. 

d)Select tray in paper source, then press OK.
e)Start printing in application.

Multi-purpose tray
The multi-purpose tray can hold special sizes and types of print material, 
such as postcards, note cards and envelopes. It is useful for single page 
printing on colored paper.

Tips on using the multi-purpose tray
•Load only one type, size and weight of print media at a time in the 

multi-purpose tray.
•To prevent paper jams, do not add paper while printing when there is 

still paper in the multi-purpose tray. This also applies to other types 
of print media.

•Always load the specified print media only to avoid paper jams and print 
quality problems (See "Print media specifications" on page 3).

•Flatten any curl on postcards, envelopes and labels before loading 
them into the multi-purpose tray.

1.Grab the handle of multi-purpose tray and pull it down to open.

2.Flex or fan the edge of the paper stack to separate the pages before 
loading papers.

3.Load the paper with the side to be printed on facing down.

4.Squeeze the multi-purpose tray paper width guides and adjust them to 
the width of the paper. Do not force too much, or the paper will bent 
resulting in a paper jam or skew.

 

•When printing the special media, you must follow the loading 
guideline (See "Printing on special media" on page 5).

•When paper does not feed well while printing, push the paper 
in manually until it starts feeding automatically. 
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5.When you print a document, set the paper type and size for the 
multi-purpose tray.
For information about setting the paper type and size on the control 
panel (See "Setting the paper size and type" on page 7).

 

The settings made from the machine driver override the 
settings on the control panel.
a)To print in application, open an application and start the print 

menu.
b)Open Printing Preferences (See "Opening printing 

preferences" on page 2).
c)Press the Paper tab in Printing Preferences, and select an 

appropriate paper type. 
For example, if you want to use a label, set the paper type 
to Label.

d)Select Manual Feeder in paper source, then press OK.
e)Start printing in application.
f)After printing, close the multi-purpose tray.

Printing on special media
The table below shows the available special media for each tray. 

 

When using special media, we recommend you feed one paper at a 
time. Check the maximum input number of media for each tray (See 
"Print media specifications" on page 3).

Types Tray 1 Optional tray Multi-purpose 
tray

Plain ● ● ●

Thick ● ● ●

Thicker ●

Extra Thick ●

Thin ● ● ●

Cotton ● ● ●

Color ● ● ●

Preprinted ● ● ●

Recycled ● ● ●

Envelope ●

Labels ●

CardStock ●

Bond ●

Archive ●

Glossy Photo ●

Matte Photo ●

( ●: Supported, Blank: Not supported) 
The media types are shown in the Printing Preferences. This paper type 
option allows you to set the type of paper to be loaded in the tray. This 
setting appears in the list, so that you can select it. This will let you get the 
best quality printout. If not, the desired print quality may not be achieved.
• Plain: 70 to 90 g/m2 (19 to 24 lb) Normal plain paper.

• Thick: 90 to 105 g/m2 (24 to 28 lb) thick paper.
• Thicker: 106 to 120 g/m2 (28 to 32 lb) thicker paper.
• Extra Thick: 120 to 170 g/m2 (32 to 46 lb) extra thick. 
• Thin: 60 to 70 g/m2 (16 to 19 lb) thin paper.
• Cotton: 75 to 90 g/m2 (20 to 24 lb) cotton paper.
• Color: 75 to 90 g/m2 (20 to 24 lb) color-backgrounded paper.
• Preprinted: 75 to 90 g/m2 (20 to 24 lb) preprinted/letterhead paper.
• Recycled: 70 to 90 g/m2 (19 to 24 lb) recycled paper.

 

When you use recycled paper as a used paper, printouts might be 
wrinkled and/or jamming may occur due to excessive curl.

• Envelope: 75 to 90 g/m2 (20 to 24 lb) envelope.
• Labels: 120 to 150 g/m2 (32 to 40 lb) label.
• CardStock: 171 to 220 g/m2 (46 to 59 lb) cardstock. 
• Bond: 105 to 120 g/m2 (28 to 32 lb) bond. 
• Archive: 70 to 90 g/m2 (19 to 24 lb). If you need to keep the print-out for 

a long period time, such as archives, select this option. 
• Glossy Photo: 111 to 130 g/m2 (30 to 35lb), 131 to 175 g/m2 (35 to 

47lb), 176 to 220 g/m2 (47 to 59lb) glossy photo paper. 
• Matte Photo: 111 to 130 g/m2 (30 to 35lb), 131 to 175 g/m2 (35 to 47lb), 

176 to 220 g/m2 (47 to 59lb) matte photo paper. 

Envelope
Successful printing on envelopes depends upon the quality of the 
envelopes. 
To print an envelope, place it flap side up with the stamp area bottm the top 
right side.

• When selecting envelopes, consider the following factors:
-Weight: The weight of the envelope paper should not exceed 90 g/m2 

otherwise, jam may occur.
-Construction: Prior to printing, envelopes should lie flat with less than 

6 mm curl, and should not contain air.
-Condition: Envelopes should not be wrinkled, nicked, either damaged.
-Temperature: Use envelopes that are compatible with the heat and 

pressure of the machine during operation.
• Use only well-constructed envelopes with sharp-and well-creased folds.
• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, windows, coated lining, 

self-adhesive seals, or other synthetic materials.
• Do not use damaged or poorly made envelopes.
• Be sure the seam at both ends of the envelope extends all the way to 

the corner of the envelope.
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1  Acceptable
2  Unacceptable

• Envelopes with a peel-off adhesive strip or with more than one flap that 
folds over to seal must use adhesives compatible with the machine’s 
fusing temperature about 170°C (338 °F) for 0.1 second. The extra flaps 
and strips might cause wrinkling, creasing, or jams and may even 
damage the fuser.

• For the best print quality, position margins no closer than 15 mm from 
the edges of the envelope.

• Avoid printing over the area where the envelope’s seams meet.

Labels
To avoid damaging the machine, use only labels designed for use in laser 
machines.

• When selecting labels, consider the following factors:
-Adhesives: The adhesive material should be stable at your machine’s 

fusing temperature about 170°C (338 °F).
-Arrangement: Only use labels with no exposed backing between 

them. Labels can peel off sheets that have spaces between the 
labels, causing serious jams.

-Curl: Prior to printing, labels must lie flat with no more than 13 mm of 
curl in any direction.

-Condition: Do not use labels with wrinkles, bubbles, or other 
indications of separation.

• Make sure that there is no exposed adhesive material between labels. 
Exposed areas can cause labels to peel off during printing, which can 
cause paper jams. Exposed adhesive can also cause damage to 
machine components.

• Do not run a sheet of labels through the machine more than once. The 
adhesive backing is designed for only a single pass through the 
machine.

• Do not use labels that are separating from the backing sheet or are 
wrinkled, bubbled, or otherwise damaged.

Card stock/Custom-sized paper

• Do not print on media smaller than 98 mm (3.9 inches) wide or 148 mm 
(5.8 inches) long.

• In the software application, set margins at least 6.4 mm (0.25 inches) 
away from the edges of the material.

Letterhead/Preprinted paper
Single-sided double-sided

Tray1
Optional tray

Face up Face down

Multi-purpose 
tray

Face down Face up

• Letterhead/ Preprinted paper must be printed with heat-resistant ink that 
will not melt, vaporize, or release hazardous emissions when subjected 
to the machine’s fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing temperature about 170°C (338 
°F).

• Letterhead/ Preprinted paper ink must be non-flammable and should not 
adversely affect machine rollers.

• Forms and letterhead should be sealed in a moisture-proof wrapping to 
prevent changes during storage.

• Before you load letterhead/preprinted paper, verify that the ink on the 
paper is dry. During the fusing process, wet ink can come off preprinted 
paper, reducing print quality.

Used paper
When loading used paper, printed side should be facing up with an uncurled 
edge at the front. If you experience problems with paper feed, turn the paper 
around. Note that print quality is not guaranteed.

• Used paper must be printed with heat-resistant ink that will not melt, 
vaporize, or release hazardous emissions when subjected to the 
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machine’s fusing temperature for 0.1 second. Check your machine’s 
specification to view the fusing temperature about 170°C(338 °F). 

• Used paper ink must be non-flammable and should not adversely affect 
machine rollers.

• Before you load used paper, verify that the ink on the paper is dry. 
During the fusing process, wet ink can come off used paper, reducing 
print quality.

Photo
• Make sure not to use the inkjet photo paper with this machine. It could 

cause damage to the machine. 

Glossy photo

 

Load one paper to the multi-purpose tray at a time, glossy side facing 
down. 

• Recommended media: Glossy paper (Letter) for this machine by HP 
Brochure Paper (Product: Q6611A) only.

• Recommended media: Glossy paper (A4) for this machine by HP 
Superior Paper 160 glossy (Product: Q6616A).

Matte photo

 

Load one paper to the multi-purpose tray at a time, side to be printed 
facing down. 

Setting the paper size and type
After loading paper in the paper tray, set the paper size and type using the 
control panel. These settings will apply to copy and fax modes. For 
computer printing, select the paper size and type in the application program 
you use on your computer (See "Opening printing preferences" on page 2).

 

The settings made from the machine driver override the settings on 
the control panel.

Setting the paper size
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Paper Setup and press OK.
4. Press the up/down arrow to highlight Paper Size and press OK.
5. Press the up/down arrow to select the paper tray you want and press 

OK.
6. Press the up/down arrow to select the paper size you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

 

If you want to use special-sized paper-such as a billing paper, select 
Custom in the Paper tab in the Printing Preferences (See "Opening 
printing preferences" on page 2).

Setting the paper type
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Paper Setup and press OK.
4. Press the up/down arrow to highlight Paper Type and press OK.
5. Press the up/down arrow to select the paper tray you want and press 

OK.
6. Press the up/down arrow to select the paper type you want.
7. Press OK to save the selection.

8. Press Stop/Clear to return to ready mode.

Setting the paper source
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Paper Setup and press OK.
4. Press the up/down arrow to highlight Paper Source and press OK.
5. Press the up/down arrow to highlight Copy Tray or Fax Tray and press 

OK.
6. Press the up/down arrow to select the paper tray you want.
7. Press OK to save the selection.
8. Press Stop/Clear to return to ready mode.

 

If you want to use special-sized paper-such as a billing paper, select 
Edit.. in the Paper tab in the Printing Preferences (See "Opening 
printing preferences" on page 2).

Selecting an output location

 

The surface of the output tray may become hot if you print a large 
number of pages at once. Make sure that you do not touch the 
surface, and do not allow children near it.

The printed pages stack on the output tray, and the output support will help 
the printed pages to align. For the output support to correctly align the 
pages, you need to pull it out appropriately depending on the paper size.

1 Output support
2 Extension

 

•If paper coming out of the output try has problems, such as excessive 
curl, try printing to the rear door.

•If the output support is incorrectly adjusted, printed pages may be 
mis-aligned or fall.
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For Letter-sized paper
Pull out the output support to the location indicated LTR as shown, and 
unfold the extension.

For A4- or Legal-sized paper
Pull out the output support to the location indicated A4, LGL as shown, and 
unfold the extension.



1.printing
This chapter explains common printing tasks.
This chapter includes:
• Introducing useful software programs
• Printer driver features
• Basic printing
• Opening printing preferences
• Using help
• Using special print features
• Postscript options
• Using direct printing utility (CLX-6250 Series only)

• Changing the default print settings
• Setting your machine as a default machine
• Printing to a file (PRN)
• Using the job accounting option
• Macintosh printing
• Linux printing
• UNIX printing

  

 

The procedures in this chapter are mainly based on Windows XP.

Introducing useful software programs
Samsung AnyWeb Print
This tool helps you to screen-capture, preview, scrap and print the screen of 
Windows Internet Explorer more easily, than when you use the ordinary 
program. Click Start > All programs > Samsung Printers > Samsung 
AnyWeb Print > Download the lastest version to link the website where 
the tool is available for the download. This tool is available only for Windows 
operating systems.

Samsung Easy Color Manager
This program helps users to adjust color as they like. Users can adjust the 
printout color as they see them on the monitor. The adjusted color can be 
stored on the printer driver and applied to printouts. Download this program 
from http://solution.samsungprinter.com/personal/colormanager.

Printer driver features
Your printer drivers support the following standard features:
• Paper orientation, size, source and media type selection
• Number of copies
In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers:

 

Some models or operating system may not support the certain 
feature(s) in the following table.

PCL Printer driver
Feature Windows

Machine quality option ●
Booklet printing ●
Poster printing ●
Multiple pages per sheet ●
Fit to page printing ●
Reduce and enlarge printing ●
Different source for first page ●
Watermark ●
Overlay ●
Double-sided printing (duplex) ●

( ●: Supported, Blank: Not supported) 

PostScript Printer driver 
Feature Windows Linux Macintosh

Machine quality option ● ● ●

Poster printing ●

Multiple pages per sheet ● ●
(2, 4)

●

Fit to page printing ● ● ●

Reduce and enlarge 
printing

● ●

Different source for first 
page

● ●

Watermark ●

Overlay ●

Double-sided printing 
(duplex)a

a.The machine with duplex feature prints both side of a paper.

● ● ●

( ●: Supported, Blank: Not supported) 
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Basic printing
Your machine allows you to print from various Windows, Macintosh, Linux 
or UNIX applications. The exact steps for printing a document may vary 
depending on the application you use.

 

•Your Printing Preferences window that appears in this user’s guide 
may differ depending on the machine in use. However, the 
composition of the Printing Preferences window is similar. Check 
the operating system(s) that are compatible with your machine 
(See "System requirements" on page 2).

•When you select an option in Printing Preferences, you may see a 
warning mark, , or . An exclamation mark ( ) means you 
can select that certain option but it is not recommended, and ( ) 
mark means you cannot select that option due to the machine’s 
setting or environment.

The following procedure describes the general steps required for 
printing from various Windows applications. 

 

•Macintosh basic printing (See "Macintosh printing" on page 9).
•Linux basic printing (See "Linux printing" on page 10).
•UNIX basic printing (See "UNIX printing" on page 12).

The following Printing Preferences window is for Notepad in Windows XP. 
Your Printing Preferences window may differ, depending on your 
operating system or the application you are using. 
1. Open the document you want to print.
2. Select Print from the File menu. The Print window appears. 
3. Select your machine from the Select Printer list.

The basic print settings including the number of copies and print range 
are selected within the Print window. 

 

To take advantage of the printer features provided by your printer 
driver, click Properties or Preferences in the application’s Print 
window to change the print setting (See "Opening printing 
preferences" on page 2).

4. To start the print job, click OK or Print in the Print window.

 

•The PostScript driver is recommended for best print image quality 
from PostScript-based applications such as Acrobat Reader®, 
Adobe Illustrator®, Adobe Photoshop®, etc.

•If you are using Windows Internet Explorer, the Samsung AnyWeb 
Print too will save your time for screen-captured images or printing 
the image. Click Start > All programs > Samsung Printers > 
your machine name > Samsung AnyWeb > Download the 
lastest version to link the website where the tool is available for 
the download.

Canceling a print job
If the print job is waiting in a print queue or print spooler, cancel the job as 
follows:
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. For Windows 2000, XP, 2003, Vista and 2008, double-click your 

machine.
For Windows 7 and Windows Server 2008 R2, right click your printer 
icon > context menus > See what’s printing.

 

If See what’s printing item has ► mark, you can select other 
printer drivers connected with selected printer.

4. From the Document menu, select Cancel.

 

You can also access this window by simply double-clicking the 
machine icon ( ) in the Windows task bar. 

You can also cancel the current job by pressing Stop/Clear on the 
control panel.

Opening printing preferences
You can preview the settings you selected on the upper right of the Printing 
Preferences.

 

The following windows may differ, depending on your operating 
system , printer models or the application you are using.

1. Open the document you want to print.
2. Select Print from the file menu. The Print window appears. 
3. Select your machine from the Select Printer. 
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4. Click Properties or Preferences. 

Using a favorite setting
The Presets option, which is visible on each preferences tab except for 
Samsung tab, allows you to save the current preferences settings for future 
use. 
To save a Presets item:
1. Change the settings as needed on each tab. 
2. Enter a name for the item in the Presets input box. Click Add. 

3. When you save Presets, all current driver settings are saved.
If you click Add, the Add button changes to Update button. Select more 
options and click Update, settings will be added to the Presets you made.
To use a saved setting, select it from the Presets drop down list. The 
machine is now set to print according to the setting you selected.
To delete saved setting, select it from the Presets drop down list and click 
Delete. 
You can also restore the printer driver’s default settings by selecting Default 
Preset from the Presets drop down list.

Using help
Click the question mark from the upper-right corner of the window and click 
on any option you want to know about. Then a pop up window appears with 
information about that option's feature which is provided from the driver. 

If you want to search information via a keyword, click the Samsung tab in 
the Printing Preferences window, and enter a keyword in the input line of 
the Help option. To get information about supplies, driver update or 
registration and so on, click appropriate buttons.

Using special print features
Special print features include:
• "Printing multiple pages on one sheet of paper" on page 3.
• "Printing posters" on page 3.
• "Printing booklets" on page 4.
• "Printing on both sides of paper" on page 4.
• "Change percentage of your document" on page 4.
• "Fitting your document to a selected paper size" on page 4.
• "Using watermarks" on page 5.
• "Using overlay (PCL driver only)" on page 5.
• "Job Setting (CLX-6250 Series only)" on page 6.
• "Graphics tab options" on page 6.
• "Enhancing glossiness (Windows only)" on page 7.

Printing multiple pages on one sheet of paper
You can select the number of pages to print on a single sheet of paper. To 
print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one 
sheet. 
1. To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on page 2).
2. Click the Basic tab, select Multiple Pages Per Side in the Type 

drop-down list.
3. Select the number of pages you want to print per sheet (2, 4, 6, 9, or 16) 

in the Pages per Side drop-down list.
4. Select the page order from the Page Order drop-down list, if necessary. 
5. Check Print Page Border to print a border around each page on the 

sheet.
6. Click the Paper tab, select the Size, Source and Type.
7. Click OK or Print until you exit the Print window.

Printing posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form one 
poster-size document.
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1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2)

2. Click the Basic tab, select Poster Printing in the Type drop-down list.
3. Select the page layout you want.

Specification of the page layout:
•Poster 2x2: Document will be enlarged and be divided into 4 pages.
•Poster 3x3: Document will be enlarged and be divided into 9 pages.
•Poster 4x4: Document will be enlarged and be divided into 16 pages.

4. Select the Poster Overlap value. Specify Poster Overlap in millimeters 
or inches by selecting the radio button on the upper right of Basic tab to 
make it easier to paste the sheets together.

5. Click the Paper tab, select the Size, Source and Type.
6. Click OK or Print until you exit the Print window.
7. You can complete the poster by pasting the sheets together.

Printing booklets
This feature prints your document on both sides of a paper and arranges the 
pages so that the paper can be folded in half after printing to produce a 
booklet.

 

If you want to make a booklet, you need to print on Letter, Legal, A4, 
US Folio, or Oficio sized print media. 

8 9

1. To change the print settings from your software application, access the 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Basic tab, select Booklet Printing from the Type drop-down 
list.

3. Click the Paper tab, select the Size, Source and Type.

 

The Booklet Printing option is not available for all paper sizes. In 
order to find out the available paper size for this feature, select the 
available paper size in the Size option on the Paper tab.
If you select an unavailable paper size, this option can be 
automatically canceled. Select only available paper. (paper without 

 or  mark).
4. Click OK or Print until you exit the Print window.
5. After printing, fold and staple the pages.

Printing on both sides of paper
You can print on both sides of a paper; duplex. Before printing, decide how 
you want your document oriented. You can use this feature with Letter, 
Legal, A4, US Folio, or Oficio sized paper. 

 

We recommend not to print on both sides of the special media, such 
as labels, envelopes, or thick paper to print on both sides of paper. It 
may cause a paper jam or damage the machine. 

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Basic tab.
3. From the Double-Sided Printing section, select the binding option you 

want.
•Printer Default: If you select this option, this feature is determined by 

the setting you’ve made on the control panel of the machine. 
•None 
•Long Edge: This option is the conventional layout used in 

bookbinding.

•Short Edge: This option is the conventional layout used in calendars.

•Reverse Double-Sided Printing: Check this option to reverse the 
print order when duplex printing.

4. Click the Paper tab, select the Size, Source and Type.
5. Click OK or Print until you exit the Print window.

Change percentage of your document
 You can change the size of a document to appear larger or smaller on the 
printed page by typing in a percentage you want.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Paper tab.
3. Enter the scaling rate in the Percentage input box.

You can also click the up/down arrows to select the scaling rate. 
4. Select the Size, Source and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Fitting your document to a selected paper size
This printer feature allows you to scale your print job to any selected paper 
size regardless of the document size. This can be useful when you want to 
check fine details on a small document. 

A
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1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Paper tab.
3. Select the paper size you want from the Fit to Page.
4. Select the Size, Source and Type in Paper Options. 
5. Click OK or Print until you exit the Print window.

Using watermarks
The watermark option allows you to print text over an existing document. 
For example, you use it when you want to have large gray letters reading 
“DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all 
pages of a document. 

There are several predefined watermarks that come with the machine. They 
can be modified, or you can add new ones to the list. 

Using an existing watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Advanced tab and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark in 
the preview image. 

3.Click OK or Print until you exit the print window. 

Creating a watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.From the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Enter a text message in the Watermark Message box. You can enter 
up to 256 characters. The message displays in the preview window.
When the First Page Only box is checked, the watermark prints on 
the first page only.

4.Select watermark options. 
You can select the font name, style, size and shade from the Font 
Attributes section, as well as set the angle of the watermark from 
the Message Angle section. 

5.Click Add to add a new watermark to the Current Watermarks list.
6.When you have finished editing, click OK or Print until you exit the 

Print window.
To stop printing the watermark, select None from the Watermark 
drop-down list. 

Editing a watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Select the watermark you want to edit from the Current Watermarks 
list and change the watermark message and options. 

4.Click Update to save the changes.

5.Click OK or Print until you exit the Print window. 

Deleting a watermark
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Advanced tab, select Edit from the Watermark drop-down 
list. The Edit Watermarks window appears. 

3.Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4.Click OK or Print until you exit the Print window.

Using overlay (PCL driver only)
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than 
using preprinted letterhead, you can create an overlay containing exactly 
the same information that is currently on your letterhead. To print a letter 
with your company’s letterhead, you do not need to load preprinted 
letterhead paper in the machine just print the letterhead overlay on your 
document.

Creating a new page overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.
1.Create or open a document containing text or an image for use in a 

new page overlay. Position the items exactly as you wish them to 
appear when printed as an overlay.

2.To save the document as an overlay, access Printing Preferences 
(See "Opening printing preferences" on page 2).

3.Click the Advanced tab, and select Edit from the Text drop-down list. 
Edit Overlay window appears.

4.In the Edit Overlay window, click Create. 
5.In the Save As window, type a name of up to eight characters in the 

File name box. Select the destination path, if necessary. (The 
default is C:\Formover.)

6.Click Save. The name appears on the Overlay List. 
7.Click OK or Print until you exit the Print window.
8.The file is not printed. Instead, it is stored on your computer hard disk 

drive.

 

The overlay document size must be the same as the document 
you print with the overlay. Do not create an overlay with a 
watermark.

Using a page overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:
1.Create or open the document you want to print.
2.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

3.Click the Advanced tab. 
4.Select the desired overlay from the Text drop-down list. 
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5.If the overlay file you want does not appear in the Text drop-down list, 
select Edit from the list and click Load. Select the overlay file you 
want to use. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Load 
window. 
After you select the file, click Open. The file appears in the Overlay 
List box and is available for printing. Select the overlay from the 
Overlay List box. 

6.If necessary, check Confirm Page Overlay When Printing box. If this 
box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm your wish to print an 
overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7.Click OK or Print until you exit the Print window. 
The selected overlay prints on your document. 

 

The resolution of the overlay document must be the same as that 
of the document you will print with the overlay.

Deleting a page overlay
You can delete page overlays that you no longer use. 
1.In the Printing Preferences window, click the Advanced tab. 
2.Select Edit in the Overlay drop down list. 
3.Select the overlay you want to delete from the Overlay List box. 
4.Click Delete. 
5.When a confirming message window appears, click Yes.
6.Click OK or Print until you exit the Print window.

Job Setting (CLX-6250 Series only)
This option allows you to choose how to print the printing file by using the 
512 MB optional memory or hard disk. 

 

Store, Spool, Normal, Proof and Print Schedule mode is available 
only if you have installed the optional hard disk. 

• Print Mode: The default Print Mode is Normal, which is for printing 
without saving the printing file in the memory. 
-Normal: This mode prints without storing your document in the 

optional memory. 
-Proof: This mode is useful when you print more than one copy. You 

can print one copy first to check, then print the rest of copies later. 
-Confidential: This mode is used for printing confidential document. 

You need to enter a password to print. 
-Store: Select this setting to save a document in the hard disk without 

printing. 
-Spool: This option can be useful to handle large amount of data. If you 

select this setting, the print spools the document into the hard disk 
and then prints it from the hard disk queue, decreasing the 
computer’s work load.

-Print Schedule: Select this setting to print the document at a specified 
time.

• User ID: This option is used when you need to find a saved file using 
the control panel. 

• Job Name: This option is used when you need to find a saved file using 
the control panel. 

Graphics tab options
Use the following Graphics options to adjust the print quality for your 
specific printing needs.

Adjusting color
If you feel the color difference between the printout and monitor, you 
may change the color setting such as color contrast or color level.
The printer driver provides graphic options to adjust the print quality for 
specific printing needs.

 

•If the option is grayed out or not shown, that option is not 
applicable with the printer language you are using.

•This options you can select may vary depending on your printer 
model. 

1.To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Graphics tab. Refer to the online help for each option’s 
information provided from the Printing Preferences.
•Color Mode: You can choose color options between Color or 

Grayscale. Setting to Color typically produces the best possible 
print quality for color document. If you want to print a color 
document in gray scale, select Grayscale. 

 

BlackOptimization allows you to print in high quality black. 
If you use this option, it might take longer to print.

To adjust color manually, select Advanced in Color Mode. 
Simply slide the color balance slider in the Levels tab to adjust 
color, or select Matching tab for driver provided color correction 
for general image processing.

•Font/ Text: Select Darken Text to print texts darker than on a 
normal document. Use All Text Black to prints solid black, 
regardless of the color it appears on the screen.
You can set advanced settings by clicking the Advanced button. 

-True Type Options: This option determines what the driver 
tells the printer about how to image the text in your 
document. Select the appropriate setting according to the 
status of your document. 

-Use Printer Fonts: When Use Printer Fonts is checked, 
the printer uses the fonts that are stored in its memory 
(resident fonts) to print your document, rather than 
downloading the fonts used in your document. Because 
downloading fonts takes time, selecting this option can 
speed up your printing time. When using Printer fonts, the 
printer will try to match the fonts used in your document to 
those stored in its memory. If, however, you use fonts in 
your document that are very different from those resident 
in the printer, your printed output will appear very different 
from what it looks like on the screen.

•Raster Compression: This option determines the compression 
level of images for transferring data from computer to a printer. If 
you set this option to Maximum, the printing speed will be high, 
but the printing quality will be low. (PCL driver only)

•Graphic Controller: It allows user to emphasize edges of texts 
and fine lines for improving readability and align each color 
channel registration in color printing mode.
-Grayscale Enhancement: It allows users to preserve the 

details of nature photos, and improve contrast and readability 
among gray scaled colors, when printing color documents in 
grayscale. (PCL driver only)

-Fine Edge: It allows users to emphasize edges of texts and fine 
lines for improving readability.

•Toner Save: Selecting this option extends the life of your toner 
cartridge and reduces your cost per page without a significant 
reduction in print quality.

3.Select Apply after completing the settings.
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Adjusting the sharpness and smoothness
Screen options
This option affect the resolution and clarity of your color output. The 
three screen options are Normal, Enhanced and Detailed.
1.To change the print settings from your software application, access 

Printing Preferences (See "Opening printing preferences" on 
page 2).

2.Click the Graphics tab then select Advanced in Color Mode.
3.Select the Matching tab.

•Printer default: Follows the set value of Screen mode from the 
printer.

•Normal: This mode will generate printouts with smooth tone over 
the entire page.

•Enhanced: This mode will generate printouts with sharp texts and 
smooth graphic/photo objects in the page.

•Detailed: This mode will generate printouts with sharp details over 
the entire page.

4.Select OK.

Enhancing glossiness (Windows only)
You can enhance the glossiness of the printout by using this feature. 

 

•You can only print on one side of paper with this option.
•If you use this option, it might take longer to print.

1. To change the print settings from your software application, access 
Printing Preferences (See "Opening printing preferences" on page 2).

2. Click the Basic tab.
3. Check Glossy Printing in Quality. 
4. Select OK.

Postscript options

 

The following windows may differ, depending on your operating 
system , printer models or the application you are using.

Following options are only supported on the Post Script driver. 
Open the Printing Preferences (See "Opening printing preferences" on 
page 2). Then click Graphic tab > PostScript Options. 

• Output Option: This option allows you to select the output format for 
PostScript files. 
-Optimize for Speed: General format for PostScript files.
-Optimize for Portability: Creates a file that conforms to the Adobe 

Document Structuring Conventions (ADSC). This is a useful format 
to use when you want to create a PostScript file and print it on a 
different machine.

-Encapsulated PostScript(EPS): Creates a file as a image. This is a 
useful format to use if you want include the file as an image in 
another document that will be printed from a different program. 

-Archive Format: Creates a PostScript file you can use it later. 
• PostScript Language: This option allows you to choose the PostScript 

language level. 
• Send PostScript Error Handler: If this options is checked, the 

machine prints an error page when an error occurs during printing. 

Using direct printing utility (CLX-6250 Series 
only)
This chapter explains how to use the Direct Printing Utility to print PDF files 
without having to open the files.

 

•Hard disk drive (HDD) should be installed on your machine, to print 
PDF files using this program. 

•You cannot print PDF files that are restricted to print. Deactivate the 
printing restriction feature, and retry printing.

•You cannot print PDF files that are protected by a password. 
Deactivate the password feature, and retry printing.

•Whether or not a PDF file can be printed using the Direct Printing 
Utility program depends on how the PDF file was created.

•The Direct Printing Utility program supports the PDF version 1.4 and 
below. For a higher version, you must open the file to print it.

What is Direct Printing Utility?
Direct Printing Utility is a program that sends a PDF file directly to your 
machine to print without having to open the file. It sends data through the 
Windows spooler using the port of the printer driver. It only supports PDF 
format.
To install this program, select Custom installation and put a check mark in 
this program when you install the printer driver.

Printing
There are several ways you can print using the Direct Printing Utility.

From the Direct Printing Utility window
1.From the Start menu select Programs or All Programs > Samsung 

Printers > Direct Printing Utility > Direct Printing Utility.
Or, double-click the Direct Printing Utility shortcut icon on your 
desktop.
The Direct Printing Utility window opens.

2.Select your machine from the Select Printer drop-down list and click 
Browse.

3.Select the PDF file you wish to print and click Open.
The PDF file is added in the Selected Files section.

4.Customize the machine settings for your needs. 
5.Click Print. The selected PDF file is sent to the machine.
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Using the shortcut icon
1. Select the PDF file you wish to print, drag and drop it to the Direct Printing 

Utility shortcut icon on your desk top. The selected PDF file is sent to the 
default machine.

 

 If the default machine does not support Direct Printing Utility, the 
message window alerting you to select the appropriate machine 
opens. Select the appropriate machine in the Select Printer section.

2. Customize the machine settings for your needs. 
3. Click Print. The selected PDF file is sent to the machine.

Using the right-click menu
1. Right-click on the PDF file you wish to print and select Direct Printing 

Utility.
The Direct Printing Utility window opens with the PDF file is added.

2. Select the machine you wish to use.
3. Customize the machine settings for your needs. 
4. Click Print. The selected PDF file is sent to the machine.

Changing the default print settings
1. Click the Windows Start menu. 
2. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and Sound > 

Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > Devices 

and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Right-click your machine.
4. For Windows XP/2003/2008/Vista, press Printing Preferences.

For Windows 7 and Windows Server 2008 R2, from context menus, select 
the Printing preferences.

 

If Printing preferences item has ► mark, you can select other 
printer drivers connected with selected printer.

5. Change the settings on each tab. 
6. Click OK.

 

If you want to change the settings for each print job, change it in 
Printing Preferences. 

Setting your machine as a default machine
1. Click the Windows Start menu.
2. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and Sound > 

Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > Devices 

and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
3. Select your machine.
4. Right-click your machine and select Set as Default Printer.

 

For Windows 7 and Windows Server 2008 R2
If Set as default printer item has ► mark, you can select other 

printer drivers connected with selected printer.

Printing to a file (PRN)
You will sometimes need to save the print data as a file. 
To create a file:
1. Check the Print to file box at the Print window.

2. Click Print.
3. Type in the destination path and the file name, and then click OK.

For example c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents.

Using the job accounting option
This option allows you to print with the given permission.
1. Install the driver (See "Installing USB connected machine’s driver" on 

page 3 or "Installing network connected machine’s driver" on page 3).
2. Click the Windows Start menu.
3. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and Sound > 

Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > Devices 

and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
4. Right-click your machine.
5. For Windows XP/2003/2008/Vista, press Properties.

•For PS driver, select PS driver and right-click to open Properties. 
For Windows 7 and Windows Server 2008 R2, from context menus, select 
the Printer properties.

 

If Printer properties item has ► mark, you can select other printer 
drivers connected with selected printer.

6. In printer driver properties, select Device Options. 
7. Click Job Accounting and select one of the options.

•User permission:  If you check this option, only users with user 
permission can start a print job.

•Group permission: If you check this option, only groups with group 
permission can start a print job.
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•If you want to encrypt job accounting password, check Job 
Accounting Password Encryption.

•Administrators can enable job accounting and configure 
permissions in SyncThru™ Web Admin Service.

8. Click OK until you exit the Printer properties window. 

Macintosh printing
This section explains how to print using Macintosh. You need to set the print 
environment before printing. 
• USB connected (See "Macintosh" on page 4).
• Network connected (See "Macintosh" on page 5).

Printing a document
When you print with a Macintosh, you need to check the printer driver 
setting in each application you use. Follow the steps below to print from a 
Macintosh:
1. Open the document you want to print.
2. Open the File menu and click Page Setup (Document Setup in some 

applications).
3. Choose your paper size, orientation, scaling, other options and make 

sure that your machine is selected. Click OK.

4. Open the File menu and click Print. 
5. Choose the number of copies you want and indicate which pages you 

want to print. 
6. Click Print.

Changing printer settings
You can use advanced printing features provided by your machine.
Open an application and select Print from the File menu. The machine 
name, which appears in the printer properties pane may differ depending on 
the machine in use. Except for the name, the composition of the printer 
properties pane is similar to the following.

 

•The setting options may differ depending on printers and Macintosh 
OS version.

•The following panes may differ, depending on your operating system 

or the application you are using.
The following pane is the first pane you will see when you open the printer 
properties pane. Select other advanced features from the drop down list. 

Layout
The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
Select Layout from the drop-down list under Orientation to access the 
following features.
•Pages Per Sheet: This option determines how many pages to be 

printed on one page (See "Printing multiple pages on one sheet of 
paper" on page 10).

•Layout Direction: This option allows you to select the printing 
direction on a page similar to the examples on UI.

•Border: This option allows you to print a border around each page on 
the sheet.

•Two-Sided: This option allows you to print on both sides of a paper 
(See "Printing on both sides of paper" on page 10).

•Reverse Page Orientation: This option allows you to rotate paper 180 
degrees. 

Graphics
The Graphics tab provides options for selecting Quality. Select 
Graphics from the drop-down list under Orientation to access the 
graphic features.
•Quality: This option allows you to select the printing resolution. The 

higher the setting, the sharper the clarity of printed characters and 
graphics. The higher setting also may increase the time it takes to 
print a document.

•Color Mode: You can set the color options. Setting to Color typically 
produces the best possible print quality for color documents. If you 
want to print a color document in grayscale, select Grayscale.

•BlackOptimization: allows you to print in high quality black. If you use 
this option, it might take longer to print.

•Advanced
-Page Color Setting: This option allows you to print some pages in 

color and other pages in mono within a document. For example, 
if you want to print pages 1~4 in color and you have chosen 
Grayscale in the Graphic tab, select Color then type in 1-4. 

Job Accounting
This option allows you to print with the given permission.
•User permission: If you check this option, only users with user 

permission can start a print job.
•Group permission: If you check this option, only groups with group 

permission can start a print job.

 

•If you want to encrypt job accounting password, refer to help 
 on the bottom left coner of the printer properties pane.
Printing_ 9



•Administrators can enable job accounting and configure 
permissions in SyncThru™Web Admin Service.

Job Setting (CLX-6250 Series only)
This option allows you to choose how to print the printing file by using 
the 512 MB optional memory or Hard disk. 

 

Store, Spool, Normal and Print Schedule mode is available only 
if you have installed the optional hard disk. 

•Print Mode: The default Print Mode is Normal, which is for printing 
without saving the printing file in the memory. 
-Normal: This mode prints without storing your document in the 

optional memory. 
-Confidential: This mode is used for printing confidential document. 

You need to enter a password to print. 
-Store: Select this setting to save a document in the hard disk 

without printing. 
-Spool: This option can be useful to handle large amount of data. If 

you select this setting, the print spools the document into the 
hard disk and then prints it from the hard disk queue, decreasing 
the computer’s work load.

-Print Schedule: Select this setting to print the document at a 
specified time.

•User ID: This option is used when you need to find a saved file using 
the control panel. 

•Job Name: This option is used when you need to find a saved file 
using the control panel. 

Paper
Set Paper Type to correspond to the paper loaded in the tray from 
which you want to print. This will let you get the best quality printout. If 
you load a different type of print material, select the corresponding paper 
type.

Printer Features
•Reverse Duplex Printing: This option allows you to select general 

print order compared to duplex print order. If this option does not 
appear, your machine does not have this feature.

•Darken Text: Select this option to print texts darker than on a normal 
document.

•Fit to Page: This option allows you to scale your print job to any 
selected paper size regardless of the document size. This can be 
useful when you want to check fine details on a small document.

•RGB Color: This setting determines how colors are rendered. 
Standard is the most widely used setting which the color tone of this 
mode is the closest to that of standard monitor (sRGB Monitor). 
Vivid mode is appropriate for printing presentation data and charts. 
The color tone of Vivid mode produces more Vivid color images 
than that of Standard mode. Device mode is best used for printing 
fine lines, small characters and color drawings. The color tone of 
Device mode may be different from that of monitor, the pure toner 
colors are used for printing cyan, magenta and yellow colors.

•Screen: This option affect the resolution and clarity of your color 
output.

Printing multiple pages on one sheet of paper
You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft pages.

1. Open an application, and select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. In the Pages 

per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3. Select the other options you want to use.
4. Click Print, then machine prints the selected number of pages you want 

to print on one sheet of paper.

Printing on both sides of paper
You can print on both sides of the paper. Before printing in the duplex mode, 
decide on which edge you will be binding your finished document. The 
binding options are, as follows:
• Long-Edge Binding: This option is the conventional layout used in 

book binding.
• Short-Edge Binding: This option is the type often used with calendars.
1. From your Macintosh application, select Print from the File menu.
2. Select Layout from the drop-down list under Orientation. 
3. Select a binding orientation from Two Sided Printing option.
4. Select the other options you want to use.
5. Click Print, then the machine prints the selected number of pages on a 

side of a paper.

 

If you print more than 2 copies, the last page of the first copy and the 
first page of the second copy might print on same sheet of paper. 
Avoid using this feature when you are printing more than 1 copy. 

Linux printing
Printing from applications

 

The following windows may differ, depending on your operating 
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system , printer models or the application you are using.

There are a lot of Linux applications that allow you to print using Common 
UNIX Printing System (CUPS). You can print on your machine from any 
such application.
1. Open an application, and select Print from the File menu
2. Select Print directly using lpr.
3. In the LPR GUI window, select the model name of your machine from 

the printer list and click Properties.

4. Change the print job properties using the following four tabs displayed at 
the top of the window.

•General: This option allows you to change the paper size, the paper 
type and the orientation of the documents. It enables the duplex 
feature, adds start and end banners and changes the number of 
pages per sheet.

•Text: This option allows you to specify the page margins and set the 
text options, such as spacing or columns.

•Graphics: This option allows you to set image options that are used 
when printing image files, such as color options, image size, or 
image position.

•Advanced: This option allows you to set the print resolution, paper 
source and special print features.

5. Click Apply to apply the changes and close the Properties window.
6. Click OK in the LPR GUI window to start printing.
7. The Printing window appears, allowing you to monitor the status of your 

print job.
To abort the current job, click Cancel.

Printing files
You can print many different types of files on your machine using the 
standard CUPS way, directly from the command line interface. The CUPS 
lpr utility allows you to do that. But the drivers package replaces the 
standard lpr tool by a much more user-friendly LPR GUI program.
To print any document file:
1. Type lpr <file_name> from the Linux shell command line and press 

Enter. The LPR GUI window appears.
When you type only lpr and press Enter, the Select file(s) to print 
window appears first. Just select any files you want to print and click 
Open.

2. In the LPR GUI window, select your machine from the list, and change 
the print job properties.

3. Click OK to start printing.

Configuring Printer Properties
Using the Printer Properties window provided by the Printers 
configuration, you can change the various properties for your machine as 
a printer.
1. Open the Unified Driver Configurator.

If necessary, switch to Printers configuration.
2. Select your machine on the available printers list and click Properties.
3. The Printer Properties window opens.

The following five tabs display at the top of the window:
•General: This option allows you to change the printer location and 

name. The name entered in this tab displays on the printer list in 
Printers configuration.

•Connection: This option allows you to view or select another port. If 
you change the machine port from USB to parallel or vice versa 
while in use, you must re-configure the machine port in this tab.

•Driver: This option allows you to view or select another machine 
driver. By clicking Options, you can set the default device options.

•Jobs: This option shows the list of print jobs. Click Cancel job to 
cancel the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

•Classes: This option shows the class that your machine is in. Click 
Add to Class to add your machine to a specific class or click 
Remove from Class to remove the machine from the selected 
class.

4. Click OK to apply the changes and close the Printer Properties 
window.
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UNIX printing 
Proceeding the print job
After installing the printer, choose any of the image, text, PS or HPGL files 
to print.
1. Execute “printui <file_name_to_print>” command.

For example, you are printing “document1”
printui document1
This will open the UNIX Printer Driver Print Job Manager in which the 
user can select various print options.

2. Select a printer which has been already added.
3. Select the printing options from the window such as Page Selection.
4. Select how many copies needed in Number of Copies.

 

To take advantage of the printer features provided by your printer 
driver, press Properties (See "Changing the printer settings" on 
page 12).

5. Press OK to start the print job.

Changing the printer settings
The UNIX Printer Driver Print Job Manager in which the user can select 
various print options in printer Properties.
The following hot keys may also be used: “H” for Help, “O” for OK and “A” 
for Apply and “C” for Cancel.

General tab
•Paper Size: Set the paper size as A4, Letter or other paper sizes, 

according to your requirements.
•Paper Type: Choose the type of the paper. Options available in the list 

box are Printer Default, Plain, and Thick.
•Paper Source: Select the source of the page. By default, it is Auto 

Selection.
•Orientation: Select the direction in which information is printed on a 

page.
•Duplex: Print on both sides of paper to save paper.
•Multiple pages: Print several pages on one side of paper.
•Page Border: Choose any of the border styles (e.g.: Single-line 

hairline, Double-line hairline)

Image tab
In this tab, you can change the brightness, resolution or an image 
position of your document.

Text  tab
Set the character margin, line space or the columns of the actual print 
output.

HPGL/2 tab
•Use only black pen: To print all graphics in black.
•Fit plot to page: Fit the entire graphic into a single page.
•Pen Width: Change value to increase the thickness of pen lines. By 

default, it is 1000.

Margins tab
•Use Margins: Set the margins for the document. By default, margins 

are not enabled. The user can change the margin settings by 
changing the values in the respective fields. Set by default, these 
values depend on the page size selected.

•Unit: Change the units to points, inches or centimeters.

Samsung Printer tab
Select various options in the JCL and General frames to customize 
various settings. These options are specific to the printer and depend on 
the PPD file.



1.copying
This chapter gives you step-by-step instructions for copying documents.
This chapter includes:
• Basic copy
• Changing the settings for each copy
• Changing the default copy settings

• Using special copy features
• Copying both sides of the originals
• Setting copy timeout

  

Basic copy
This is the normal and usual procedure for copying your originals.
1. Press (Copy) on the control panel.

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. If necessary, adjust the settings for each copy such as Reduce/Enlarge, 
Darkness, Original Type and more (See "Changing the settings for 
each copy" on page 1). 

4. Enter the number of copies using the arrow or number keypad, if 
necessary.

5. Press Start on the control panel to begin copying.

 

To cancel the current copy job, press Stop/Clear on the control panel. 

Changing the settings for each copy
Your machine provides default settings for copying so that you can quickly 
and easily make a copy. However, if you want to change the options for 
each copy, use the copy function buttons on the control panel.

 

If you press Stop/Clear while setting the copy options, all of the 
options you have set for the current copy job will be canceled and 
return to their default status after the machine completes the copy in 
progress.

Changing the darkness
If you have an original containing faint marking and dark images, you can 
adjust the brightness to make a copy that is easier to read.

1. Press (Copy) on the control panel. 

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Copy Feature and press OK.
4. Press the up/down arrow to highlight Darkness and press OK.
5. Press the up/down arrow until the contrast mode you want is highlighted 

and press OK.
•Lightest: Works well with darker print.
•Light: Works well with dark print.
•Normal: Works well with standard typed or printed originals.
•Dark: Works well with light print.
•Darkest: Works well with lighter print or faint pencil markings. 

6. Press Stop/Clear to return to ready mode.

Selecting the type of originals
The original type setting is used to improve the copy quality by selecting the 
document type for the current copy job.
1. Press (Copy) on the control panel. 

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Copy Feature and press OK.
4. Press the up/down arrow to highlight Original Type and press OK.
5. Press the up/down arrow until the image mode you want is highlighted 

and press OK.
•Text: Use for originals containing mostly text.
•Text/Photo: Use for originals with mixed text and photographs.
•Photo: Use when the originals are photographs.
•Magazine: Use when the originals are magazines.

6. Press Stop/Clear to return to ready mode.

Selecting the scan size of originals
You can choose the size to be scanned.

 

The scan size options may vary between document feeder or scanner 
glass. 

1. Press (Copy) on the control panel. 

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Copy Feature and press OK.
4. Press the up/down arrow to highlight Scan Size and press OK.
5. Press the up/down arrow until the scan size you want is highlighted and 

press OK.
6. Press Stop/Clear to return to ready mode.
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Reducing or enlarging copies
You can reduce or enlarge the size of a copied image from 25% to 400% 
when you copy original documents from the scanner glass, or from 25% to 
100% from the document feeder.

To select from the predefined copy sizes:
1.Press (Copy) on the control panel. 

2.Press Menu on the control panel.
3.Press the up/down arrow to highlight Copy Feature and press OK.
4.Press the up/down arrow to highlight Reduce/Enlarge and press OK.
5.Press the up/down arrow until the size setting you want is highlighted 

and press OK.
6.Press Stop/Clear to return to ready mode.

To scale the copy by directly entering the scale rate:
1.Press (Copy) on the control panel. 

2.Press Menu on the control panel.
3.Press the up/down arrow to highlight Copy Feature and press OK.
4.Press the up/down arrow to highlight Reduce/Enlarge and press OK.
5.Press the up/down arrow to highlight Custom and press OK.
6.Press the up/down arrow or numeric keypad to enter the copy size you 

want. Pressing and holding the up/down arrow allows you to quickly 
scroll to the number you want.

7.Press OK to save the selection.
8.Press Stop/Clear to return to ready mode.

 

When you make a reduced copy, black lines may appear at the 
bottom of your copy.

Changing the default copy settings
The copy options, including darkness, original type, copy size, collation and 
number of copies, can be set to those most frequently used. When you copy 
a document, the default settings are used unless they have been changed 
by using the corresponding buttons on the control panel.
1. Press (Copy) on the control panel. 

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Copy Setup and press OK.
4. Press the up/down arrow to highlight Change Default and press OK.
5. Press the up/down arrow until the setup option you want is highlighted 

and press OK.
6. Press the up/down arrow until the setting you want is highlighted and 

press OK.
7. Repeat steps 5 through 6, as needed.
8. Press Stop/Clear to return to ready mode.

 

While you are setting copy options, pressing Stop/Clear cancels the 
changed settings and restores the defaults.

Using special copy features
You can use the following copy features:

ID card copying
Your machine can print 2-sided originals on one sheet of A4-, Letter-, 
Legal-, Folio-, Executive-, B5, A5, or A6-sized paper.
The machine prints one side of the original on the upper half of the paper 
and the other side on the lower half without reducing the size of the original. 
This feature is helpful for copying a small-sized item, such as a business 
card.

 

•This copy feature is available only when you place originals on the 
scanner glass.

•The size of the 2-sided originals should be smaller than A5, if not, 
some of it won’t be copied. 

1. Press ID Copy on the control panel. 
2. Place Front Side Press  appears on the display.
3. Place the front side of an original facing down on the scanner glass 

where arrows indicate as shown, and close the scanner lid. 

4. Press Start on the control panel.
Your machine begins scanning the front side and shows Place Rear 
Side Press .

5. Turn the original over and place it on the scanner glass, where arrows 
indicate as shown then, close the scanner lid.

6. Press Start on the control panel to begin copying.

 

•If the original is larger than the printable area, some portions may not 
be printed.

•If you press Stop/Clear, the machine cancles the copy job and 
returns to ready mode. 

Deciding the form of copy output 
You can set the machine to sort the copy job. For example, if you make 2 
copies of a 3 page original, one complete 3 page document will print 
followed by a second complete document.
1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press OK and enter the number of copies using the number keypad.
4. Press Menu on the control panel.
5. Press the up/down arrow to highlight Copy Setup and press OK.
6. Press the up/down arrow to highlight  Change Default and press OK.
7. Press the up/down arrow to highlight  Collation and press OK.
8. Press the up/down arrow to highlight On and press OK.
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•On: Prints output in sets to match the sequence of originals.

•Off: Prints output sorted into stacks of individual pages.

9. Press Stop/Clear to return to ready mode.
10. Press Start to begin copying.

One complete document will print followed by the second complete 
document.

2-up or 4-up copying (N-up)
The machine reduces the size of the original images and prints 2 or 4 pages 
onto one sheet of paper.
2 or 4-up copying is available only when you load originals into the 
document feeder.

1
2

1 2

3 4

1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Layout and press OK.
6. Press the up/down arrow until 2up or 4up highlights and press OK.
7. Press Stop/Clear to return to ready mode.
8. Press Start to begin copying.

 

You cannot adjust the copy size using Reduce/Enlarge for the N-Up 
feature. 

Poster copying
Your original will be divided into 9 portions. You can paste the printed pages 
together to make one poster-sized document.
This copy feature is available only when you place originals on the scanner 
glass. 

1. Press (Copy) on the control panel. 

2. Place a single original face down on the scanner glass.
3. Press Menu on the control panel.

4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Layout and press OK.
6. Press the up/down arrow to highlight Poster Copy and press OK.
7. Press Stop/Clear to return to ready mode.
8. Press Start to begin copying.

 

Your original is divided into 9 portions. Each portion is scanned and 
printed one by one in the following order:

Clone copying
The machine prints multiple original images on a single page. The number 
of images is automatically determined by the original image and the paper 
size.
This copy feature is available only when you place originals on the scanner 
glass.

1. Press (Copy) on the control panel. 

2. Place a single original face down on the scanner glass.
3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Layout and press OK.
6. Press the up/down arrow to highlight Clone Copy and press OK.
7. Press Stop/Clear to return to ready mode.
8. Press Start to begin copying.

 

You cannot adjust the copy size using Reduce/Enlarge for the Clone 
Copy feature. 

Book copying
The Book Copy feature allows you to copy an entire book. If the book is too 
thick, lift the cover until its hinges are caught by the stopper and then close 
the cover. If the book or magazine is thicker than 30 mm, start copying with 
the cover open.
This copy feature is available only when you place originals on the scanner 
glass.

1. Press (Copy) on the control panel. 

2. Place a single original face down on the scanner glass.
3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Layout and press OK.
6. Press the up/down arrow to highlight Book Copy and press OK.
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7. Press the up/down arrow until the binding option you want is highlighted.
•Off: Does not use this feature.
•Left Page: Use this option to print left page of the book.
•Right Page: Use this option to print right page of the book.
•Both Page: Use this option to print both pages of the book.

8. Press OK.
9. Press Stop/Clear to return to ready mode.
10. Press Start to begin copying.

Adjusting background images
You can set the printer to print an image without its background. This copy 
feature removes the background color and can be helpful when copying an 
original containing color in the background, such as a newspaper or a 
catalog. 
1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Adjust Bkgd. and press OK.
6. Press the up/down arrow until the binding option you want is highlighted.

•Off: Does not use this feature.
•Auto: Optimizes the background.
•Enhance Lev.1 ~ 2: The higher the number is, the more vivid the 

background is.
•Erase Lev.1 ~ 4: The higher the number is, the lighter the background 

is.
7. Press OK.
8. Press Stop/Clear to return to ready mode.
9. Press Start to begin copying.

Margin shift copying
The Margin Shift feature allows you to create a binding edge for the 
document. The image can be adjusted up or down on the page and/or 
shifted to the right or left.

 

The Margin Shift feature can either be used for scanner glass or 
document feeder depending on the set up.
•Auto Center: Scanner glass
•Custom Margin: Scanner glass, Document feeder

1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Margin Shift and press OK.
6. Press the up/down arrow until the binding option you want is highlighted.

•Off: Does not use this feature.
•Auto Center: Automatically copy in the center of the paper.
•Custom Margin: Enter the left, right, top, bottom margin using Number 

keypad.

7. Press OK.
8. Press Stop/Clear to return to ready mode.
9. Press Start to begin copying.

Edge erase copying
Edge erase allows you to erase spots, drill holes, fold creases and staple 
marks along any of the four edges of a document.

 

The Edge Erase feature can either be used for scanner glass or 
document feeder depending on the set up.
•Small Original: Scanner glass
•Hole Punch: Scanner glass, Document feeder
•Book Center: Scanner glass
•Border Erase: Scanner glass, Document feeder

1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Edge Erase and press OK.
6. Press the up/down arrow until the binding option you want is highlighted.

•Off: Does not use this feature.
•Small Original: Erases the edge of the original if it is small.
•Hole Punch: Erases the marks of bookbinding holes.
•Book Center: Erases the middle part of the paper which is black and 

horizontal, when you copy a book.
•Border Erase: Erases the certain amount of the edge of the printout.

7. Press OK.
8. Press Stop/Clear to return to ready mode.
9. Press Start to begin copying.

Gray enhance copying
When you copy the original in gray scale, use this feature for the better 
quality of copy-output. This feature is only for the copy in gray scale.
1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight Gray Enhance and press OK.
6. Press the up/down arrow to select On.
7. Press OK.
8. Press Stop/Clear to return to ready mode.
9. Press Start to begin copying.

Watermark copying
You can copy the original with a watermark. For example, you can use it 
when you want to have large gray letters such as Top Secret or 
Confidential printed diagonally across the first page or all pages of the 
copy.
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1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Menu on the control panel.
4. Press the up/down arrow to highlight Copy Feature and press OK.
5. Press the up/down arrow to highlight WaterMark and press OK.
6. Press the up/down arrow until the binding Message option you want is 

highlighted and OK.
7. Press the up/down arrow until the binding Pages option you want is 

highlighted and OK.
8. Press Stop/Clear to return to ready mode.
9. Press Start to begin copying.

Copying both sides of the originals
You can set the machine to print copies on both sides of paper. 

 

The Duplex options may vary between document feeder or scanner 
glass. 

1. Press (Copy) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Duplex on the control panel.
4. Press the up/down arrow until the binding option you want is highlighted.

•Off: Prints in normal mode.
•1->2Side Short: Prints pages to be read by flipping like a note pad.

2

5
3

•1->2Side Long: Prints pages to be read like a book.

•2->1Side: Scans both sides of the originals and prints each of one on a 
separate sheet.

•2->2Side: Scans both sides of the original and prints on both sides of 
the paper. This function produces exactly the same print out from the 
originals.

•2->1Side ROT2: Scans both sides of the original and prints each one 
on a separate sheet, but the information on the back side of the 

printout is rotated 180°.

5. Press OK to save your selection.
6. Start copying a document.

Setting copy timeout
You can set the time the machine waits before it restores the default control 
panel settings, if you press Start button prior to the control panel restoring 
to default, the previous job will be reprinted.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Machine Setup and press OK.
4. Press the up/down arrow to highlight Timeout and press OK.
5. Press the up/down arrow until the time setting you want is highlighted.

Selecting Off means that the machine does not restore the default 
settings until you press Start to begin copying, or Stop/Clear to cancel.

6. Press OK to save the selection.
7. Press Stop/Clear to return to ready mode.



1.scanning
Scanning with your machine lets you turn pictures and text into digital files that can be stored on your computer.
This chapter includes:
• Basic scanning method
• Scanning originals and sending through email (Scan to Email)
• Scanning originals and sending to your computer (Scan to PC)
• Scanning originals and sending via SMB/FTP (Scan to server)
• Setting authentication for authorized user
• Using Samsung Scan and Fax Manager
• Changing the scan feature settings

• Changing the default scan settings
• Scan on both sides of paper
• Scanning with TWAIN-enabled software
• Scanning using the WIA driver
• Macintosh scanning
• Linux scanning

  

 

The maximum resolution that can be achieved depends upon various 
factors, including computer speed, available disk space, memory, the 
size of the image being scanned, and bit depth settings. Thus, 
depending on your system and what you are scanning, you may not 
be able to scan at certain resolutions, especially using enhanced 
resolution.

Basic scanning method
You can scan the originals with your machine via an USB cable or the 
network. The following methodoloqies can be used for scanning your 
documents:
• Samsung Scan and Fax Manager: Scan the originals from the control 

panel. Then, the scanned data will be stored in the connected 
computers My Documents folder. When you install all the software in 
the supplied CD, the Samsung Scan and Fax Manager is also 
automatically installed on your computer. This feature can be used via 
the local connection or the network connection (See "Using Samsung 
Scan and Fax Manager" on page 5).

• TWAIN: TWAIN is the one of a preset imaging applications. Scanning 
an image launches the selected application, enabling you to control the 
scanning process. This feature can be used via the local connection or 
the network connection (See "Scanning with TWAIN-enabled software" 
on page 6).

• SmarThru Office : This program is the accompanying software for your 
machine. You can use this program to scan images or documents. This 
feature can be used via the local connection or the network connection 
(See "Smarthru Office" on page 3).

• WIA: WIA stands for Windows Images Acquisition. To use this feature, 
your computer must be connected directly with the machine via an USB 
cable (See "Scanning using the WIA driver" on page 6).

• USB Memory: You can scan a document and save the scanned image 
onto an USB memory device (See "Scanning to an USB memory 
device" on page 1).

• Email: You can send the scanned image as an email attachment (See 
"Scanning originals and sending through email (Scan to Email)" on 
page 1).

• FTP: You can scan an image and upload it to an FTP server (See 
"Scanning originals and sending via SMB/FTP (Scan to server)" on 
page 4).

• SMB: You can scan an image and send it to a shared folder on an SMB 
server (See "Scanning originals and sending via SMB/FTP (Scan to 
server)" on page 4).

Scanning originals and sending through email 
(Scan to Email)
You can scan the originals and email the scanned image to several 
destinations from the machine by email. 

Setting up an email account
To scan and send an image as an email attachment, you need to set up 
network parameters using SyncThru™ Web Service.
1. Turn your networked computer on and open the web browser. 
2. Enter your machine's IP address as the URL in a browser.
3. Click Go to access the SyncThru™ Web Service.
4. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
5. Type in the ID and Password then click Login .

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

6. Click Settings > Network Settings and Outgoing Mail Server(SMTP).
7. Enter the IP address in dotted decimal notation or as a host name.
8. Enter the server port number, from 1 to 65535.

The default port number is 25.
9. Check the box next to SMTP Requires Authentication to require 

authentication.
10. Enter the SMTP server login name and password.
11. Click Apply.

 

If the authentication method of SMTP server is POP3 before SMTP, 
put a check mark of SMTP Requires POP3 Before SMTP 
Authentication.
a) Enter the IP address in dotted decimal notation or as a host name. 
b)Enter the server port number, from 1 to 65535. The default port 

number is 110.
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Sending a scanned image to several destinations as 
an email attachment
1. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

2. Press  (Scan/Email) on the control panel. 

3. Press the up/down arrow to highlight Scan To Email and press OK.

 

If you registered My Log in ID, Password and checked Local 
Authentication in User Access Control on SyncThru™ Web 
Service, Login Name and Enter Password appear. Enter the 
Auth ID and Password to your machine. Go to step 5.

4. When From: appears on the top line of the display, enter the sender’s 
email address and press OK.

5. When Destination Email: appears on the top line of the display, enter 
the recipient’s email address and press OK.

6. To enter additional addresses, press the left/right arrow to highlight Yes 
and press OK.
To continue to the next step, press the left/right arrow to highlight No 
and press OK.

7. If the displays asks if you want to send the email to your account, press 
the left/right arrow to highlight Yes or No and press OK.

 

This prompt does not appear if you have activated the Auto Send 
To Self option in the Settings > Scan > Scan To E-mail on 
SyncThru™ Web Service.

8. Enter an email subject and press OK.
9. Press the up/down arrow until the file type you want is highlighted and 

press OK.
When you have finished, select No when Another Page? appears.
The machine begins scanning and then sends the email.

 

While the machine is sending an email, you cannot use the 
machine to copy or to send a fax.

10. Press the Stop/Clear to return to ready mode.

Storing email addresses
You can set up Address Book with the email addresses you use frequently 
via SyncThru™ Web Service and then easily and quickly enter email 
addresses by entering the location numbers assigned to them in Address 
Book.

Storing on your local machine
This method means that you store email addresses on your machine’s 
memory. You can add addresses, as well as group them in particular 
categories.

Individual
1.Turn your networked computer on and open the web browser. 
2.Enter your machine's IP address as the URL in a browser.
3.Click Go to access the SyncThru™ Web Service.
4.Click Login on the upper right of the SyncThru™ Web Service 

website.
A log-in page appears. 

5.Type in the ID and Password then click Login.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

6.Click Address Book > Individual.
7.Click Add.
8.When the Add screen appears, select the Speed No. number and 

enter e-mail address and fax number.

 

If you need to set SMB or FTP sever information, check SMB 
or FTP and set the information. 

9.Click Apply.

Group
1.Turn your networked computer on and open the web browser. 
2.Enter your machine's IP address as the URL in a browser.
3.Click Go to access the SyncThru™ Web Service.
4.Click Login on the upper right of the SyncThru™ Web Service 

website.
A log-in page appears. 

5.Type in the ID and Password then click Login.
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

6.Make sure you have configured individual address book.
7.Click Address Book > E-mail Group .
8.Click Add Group.
9.When the Add Group screen appears, select the Speed No. number 

and enter Group Name.

 

You can easily add individual address if you check Yes for Add 
individual(s) after this group is created.

10.Click Apply.

Searching Address Book for an entry
There are two ways to search for an address in memory. You can either 
scan from 0 to 199 sequentially or search by entering the first letters of 
the name associated with the address.

Searching sequentially through memory
1.Press  (Scan/Email) and Address Book on the control panel.

2.Press the up/down arrow to highlight Search & Dial and press OK.
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3.Press the up/down arrow until the option you want highlights and press 
OK.

4.Press the up/down arrow to highlight All and press OK.
5.Press the up/down arrow until the name and address you want is 

highlighted. You can search upwards or downwards through the 
entire memory in index (numerical) order.

Searching with a particular first letter
1.Press  (Scan/Email) and Address Book on the control panel.

2.Press the up/down arrow to highlight Search & Dial and press OK.
3.Press the up/down arrow until the option you want is highlighted and 

press OK.
4.Press the up/down arrow to highlight ID and press OK.
5.Enter the first few letters of the name you want.
6.Press the up/down arrow until the name you want is highlighted and 

press OK.

Printing Address Book
You can check your Address Book information by printing a list.

1.Press  (Scan/Email) and Address Book on the control panel.

2.Press the up/down arrow to highlight Print and press OK.
3.Press the up/down arrow until the option you want is highlighted and 

press OK.
Your Address Book information prints out.

Scanning originals and sending to your 
computer (Scan to PC)
You can scan an image on the machine via the Samsung Scan and Fax 
Manager program that is installed in your networked computer.

For USB connected machine
This is a basic scanning method for usb connected machine.
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. Press  (Scan/Email) on the control panel. 

4. Press the up/down arrow to highlight Scan To PC and press OK.
5. Press the up/down arrow to highlight Local PC and press OK.

 

If you see Not Available message, check the port connection.

6. Press the up/down arrow until the application program you want is 
highlighted and press OK.
Default setting is My Documents.

 

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Samsung Scan and Fax 
Manager > Properties > Set Scan Button.

7. Press the up/down arrow until the setting you want is highlighted and 
press OK.
•Resolution: Sets the image resolution.
•Scan Color: Sets the color mode.
•Scan Format: Sets the file format in which the image is to be saved.
•Scan Size: Sets the image size.

 

•Scan Format appears only when you selected the Scan 
destination to My Documents.

•If you want to scan from the default setting, press Start.

8. Scanning begins.

 

•Scanned image is saved in computer’s My Documents > My 
Pictures > Samsung folder.

•You can use Twain driver to scan quickly in Samsung Scan and 
Fax Manager program.

•You can also scan by pressing Window’s Start > Control Panel > 
Samsung Scan and Fax Manager > Quick Scan.

For network connected machine
Make sure the scanner printer driver is installed on your computer using the 
software CD, since the printer driver includes the scan program it does not 
need to be installed separartely in most cases (See "Installing network 
connected machine’s driver" on page 3).
1. Make sure that your machine and the computer are connected to a 

network and Samsung Scan and Fax Manager is installed on the 
computer.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.

3. Press  (Scan/Email) on the control panel.

4. Press the up/down arrow to highlight Scan To PC and press OK.
5. Press the up/down arrow to highlight Network PC and press OK.

 

If you see Not Available message, check the port connection.

6. Select your registered computer ID, and enter the Password if 
necessary.

 

•ID is the same ID as the registered Computer ID for Samsung 
Scan and Fax Manager.

•Password is the 4 digit number registered Password for 
Samsung Scan and Fax Manager.

7. Press the up/down arrow until the application program you want 
highlights and press OK.
Default setting is My Documents.

 

To add or delete the folder where the scanned file is saved, add or 
delete the application program in Samsung Scan and Fax 
Manager > Properties > Set Scan Button.

8. Press the up/down arrow until the setting you want is highlighted and 
press OK.
•Resolution: Sets the image resolution.
•Scan Color: Sets the color mode.
•Scan Format: Sets the file format in which the image is to be saved.
•Scan Size: Sets the image size.

 

•Scan Format appears only when you selected the Scan 
destination to My Documents.

•If you want to scan from the default setting, press Start.

9. Scanning begins.

 

•Scanned image is saved in computer’s My Documents > My 
Pictures > Samsung folder.

•You can use Twain driver to scan quickly in using the Samsung 
Scan and Fax Manager program.

•You can also scan by pressing Window’s Start > Control Panel > 



Samsung Scan and Fax Manager > Quick Scan.

Scanning originals and sending via SMB/FTP 
(Scan to server)
You can scan an image and send it to a total of five destinations via the 
SMB or FTP. 

Setting up an FTP server
To use an FTP server, you need to set up parameters to access the FTP 
servers using SyncThru™ Web Service.
1. Turn your networked computer on and open the web browser. 
2. Enter your machine's IP address as the URL in a your web browser.
3. Click Go to access the SyncThru™ Web Service.
4. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
5. Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

6. Click Address Book > Individual.
7. Click Add.
8. Check the box next to Add FTP.
9. Enter the server address in dotted decimal notation or a host name.
10. Enter the server port number, from 1 to 65535.

The default port number is 21.
11. Check the box next to Anonymous if you want the FTP server to permit 

access to unauthorized people. 
This box is unchecked by default.

12. Enter the Login Name and Password.
13. Enter the Path for saving the scanned image.
14. Click Apply.

Setting up an SMB server
To use an SMB server, you need to set up parameters for access to SMB 
servers using SyncThru™ Web Service.
1. Turn your networked computer on and open the web browser. 
2. Enter your machine's IP address as the URL in a your web browser.
3. Click Go to access the SyncThru™ Web Service.
4. Click Login on the upper right of the SyncThru™ Web Service website.

A log-in page appears. 
5. Type in the ID and Password then click Login.

If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

6. Click Address Book > Individual.
7. Click Add.
8. Check the box next to Add SMB.
9. Enter the server address in dotted decimal notation or a host name.
10. Enter the server port number, from 1 to 65535.

The default port number is 139.
11. Enter the server address in dotted decimal notation or a host name.

12. Check the box next to Anonymous if you want to permit unauthorized 
persons to access the SMB server. 
This box is unchecked by default.

13. Enter the Login Name and Password.
14. Enter the Domain. If your server is joined to the certain domain, and you 

are using the domain account to log in, enter the domain name. 
Otherwise, just enter your computer name which is registered to the 
SMB server.

15. Enter the Path for saving the scanned image. The folder (e.g. Scanned 
Images) must be setup on the root and the folder properties need to be 
setup as a share, with you listed as having user rights to the folder.

16. Click Apply.

Scanning and sending to SMB/FTP server
1. Make sure that your machine is connected to a network.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass.

3. Press  (Scan/Email) on the control panel.

4. Press the up/down arrow to highlight Scan To SMB or Scan To FTP, 
and press OK.

5. Press the up/down arrow to highlight the server and file share required 
then press OK.

6. Press the up/down arrow until the scan format you want is highlighted 
and press OK.
The machine begins scanning and then sends the scanned image to the 
specified server.

Setting authentication for authorized user
If you have connected your machine to a network and set up the network 
parameters correctly, you can scan and send images over the network.
To send a scanned image through email or via network server safely, you 
must register account information of authorized users to your local machine 
using SyncThru™ Web Service.

Registering local authorized users
1. Turn your networked computer on and open the web browser. 
2. Enter your machine's IP address as the URL in your web browser.
3. Click Go to access the SyncThru™ Web Service.
4. Click Security > User Access Control > User Authentication.
5. Select Local Authentication in the Authentication Method section.
6. Click Apply.
7. Click OK in the modifying confirmation pop-up window.
8. Click User Profile.
9. Click Add.
10. Enter User Name, Login ID, Password, E-mail Address and Fax 

Number.
You need to enter the registered user ID and password in the machine 
when you start scanning to email from the control panel.

11. Click Apply.
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Using Samsung Scan and Fax Manager
If you have installed the printer driver, the Samsung Scan and Fax Manager 
program is installed too. Start Samsung Scan and Fax Manager program to 
find out about this program information and the installed scan driver's 
condition. Through this program, you can change scan settings and add or 
delete the folders where scanned documents are saved in your computer. 

 

The Samsung Scan and Fax Manager program can only be used in 
the Window and Macintosh system. If you use the Macintosh, See 
"Setting scan information in Scan Manager" on page 7.

1.  From the Start menu, click Control Panel > Samsung Scan and Fax 
Manager.

 

You can open Samsung Scan and Fax Manager by right clicking 
the Smart Panel icon in the Windows task bar and selecting Scan 
Manager.

2. Select the appropriate machine from the Samsung Scan and Fax 
Manager window.

3. Press Properties.
4. The Set Scan Button tab allows you to change the saving destination 

and scan settings, add or delete application program, and format files.
You can change the scanning machine by using the Change Port tab. 
(Local or Network)

5. When setting is done, press OK.

Set Scan Button tab
Scan Destination
•Available Destination List: Shows the list of applications currently 

linked to scanned images in the PC’s registry. Select the program 
you want to use and click the right arrow and add to Front Panel 
Destination List. 

•Front Panel Destination List: Shows the list of applications to open 
scanned images.

•Add Application: Allows you to add an application you want to use to 
the Available Destination List.

•Remove Application: Allows you to remove an item added by the 
user from the Available Destination List. 

•File Format: Allows you to select the format of scanned data to be 
saved. You can choose among BMP, JPEG, PDF and TIFF.

Scan Property
•Computer ID: Shows the ID of your computer. 
•Save Location: Allows you to choose the location of the default saving 

folder.
•Resolution: Allows you to choose the scan resolution. 
•Scan Color: Allows you to choose the scan color. 
•Scan Size: Allows you to choose the scan size. 
•ADF Duplex: Automatically scans both sides. If your model does not 

support this option, it will be grayed out. 
•Show Preview: Checking this box allows you to preview applied scan 

options. You can modify the options before scanning. 
•Default: Allows you to go back to default options. 

Change Port tab
• Local Scanner: Select when your machine is connected via USB or 

LPT port. 
• Network Scanner: Select when your machine is connected via network 

port.
-Auto detection on the network: Automatically detects your machine.
-IP or Host name: Enter in your machine’s IP address or host name to 

detect your machine. 

Scan Assistant
You can scan by pressing Samsung Scan and Fax Manager > Quick 
Scan.
The Scan Assistant window allows you to adjust scan settings and start the 
scanning process.
• Favorites: Allows you to save the current preferences settings for 

future use. When you save Favorites, all current scan settings are 
saved. To use a saved setting, select it from the Favorites drop down 
list. The machine is now set to scan according to the setting you 
selected. To delete saved setting, select it from the Favorites drop 
down list and click Delete. To set a favorite as startup, select the favorite 
you want to set as startup, then click the Set as default button.

• Scan sttings: The following scan options are available:
-Image Type: Allows you to chose the proper color settings for image 

scanning. 
-Resolution: Allows you to choose the image resolution.
-Document Size: Allows you to choose the proper size of the scanned 

image. 
-Document Source: Allows you to choose the device (document 

feeder or scan glass) you want to scan with.
-Prompt for additional pages: If this check box is checked, you can 

scan pages continuously. This option is useful when you scan 
multipage documents and/or when Document Source is set to 
Flatbed (platen glass). In this case a sequence of scanned images is 
processed as a single document

-Pages to Scan: Allows you to specify how many pages are to be 
scanned. This option is available when Document Source is set to 
ADF(Document feeder).

• Preference: The following scan options are available:
-Auto-crop image after preview: If this option is checked, the 

scanning area will be automatically adjusted to the image size.
-Preview on program start: If this option is checked, the scanning 

area will be selected automatically as shown in the preview. 
-Blank page detection: This operation automatically detects whether 

the scanned image is blank or not.
-Delete page: Blank pages will be deleted at the end of the 

scanning process. 
-Separate files: Blank page will work as a scan job separator. That 

is, when multiple pages are scanned at once a blank page will 
divide scanned image sequence into parts. Each part will be 
treated as a separate document (group). 

-Start from scanner: If this option is checked, scanning process is 
managed using scanner touch screen rather than from the computer. 
The option is not available for some scanner models. 

• Advanced: In the Advanced mode, additional options such as Image 
Adjustment, Image Enhancement, and Additional Settings are 
available. 
-Image Adjustment: Allows you to perform some transformations of 

the scanned image. These transformations include automatic 
adjustment of image size, straightening and rotation. 

-Image Enhancement: Allows you to remove various defects of the 
image and improve its quality.

-Additional settings: Allows special processing of scanned images. 
These transformations include stitching several partial image scans 
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into a single image, processing of scanned books and watermark 
stamping.

 

Click the Help button from the lower-left corner of the window and 
click on any option you want to know about. Then a pop up window 
appears with information about that option's feature which is provided 
from the Scan Assistant. 

Changing the scan feature settings
Your machine provides you with the following setting options to allow you to 
customize your scan jobs. The settings you change will be maintained for a 
certain time, but after that period, the options will be reset to default values.
• Scan Size: Sets the image size.
• Original Type: Sets the original documents’s type.
• Resolution: Sets the image resolution.
• Scan Color: Sets the color mode.
• Scan Format: Sets the file format in which the image is to be saved. If 

you select TIFF or PDF, you can select to scan multiple pages. 
Depending on the selected scan type, this option may not appear.

To customize the settings before starting a scan job:

1. Press  (Scan/Email) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Scan Feature and press OK.
4. Press the up/down until the scan type you want is highlighted and press 

OK.
5. Press the up/down until the scan setting option you want is highlighted 

and press OK.
6. Press the up/down arrow until the desired status highlights and press 

OK.
7. Repeat steps 5 and 6 to set other setting options.
8. When you have finished, press Stop/Clear to return to ready mode.

Changing the default scan settings
To avoid having to change the scan settings for each job, you can set up 
default scan settings for each scan type.

1. Press  (Scan/Email) on the control panel. 

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Scan Setup and press OK.
4. Press OK when Change Default highlights .
5. Press the up/down until the scan type you want is highlighted and press 

OK.
6. Press the up/down until the scan setting option you want is highlighted 

and press OK.
7. Press the up/down arrow until the desired status highlights and press 

OK.
8. Repeat steps 6 and 7 to set other setting options.
9. When you have finished, press Stop/Clear to return to ready mode.

Scan on both sides of paper

 

This is available only when you load originals into the document 
feeder.

By using the Duplex button on your machine, you can set the machine to 
scan on both sides of paper.

1. Press  (Scan/Email) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Duplex on the control panel.
4. Press the up/down arrow until the binding option you want is highlighted.

•Off: Scans in normal mode.
•2 Side: Scans on both sides of the original.
•2->1Side ROT2: Scans on both sides of the original and prints each 

one on a separate sheet, but the information on the back side of the 
printout is rotated 180°.

5. Press OK to save your selection.

Scanning with TWAIN-enabled software
If you want to scan documents using other software, you will need to use 
TWAIN-compliant software, such as Adobe Photoshop. 
Follow the steps below to scan with TWAIN-compliant software:
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. Open an application, such as Adobe Photoshop.
4. Open the TWAIN window and set the scan options.
5. Scan and save your scanned image.

Scanning using the WIA driver
Your machine also supports the Windows Image Acquisition (WIA) driver for 
scanning images. WIA is one of the standard components provided by 
Microsoft Windows XP and works with digital cameras and scanners. Unlike 
the TWAIN driver, the WIA driver allows you to scan and easily adjust 
images without using additional software.

 

The WIA driver works only on Windows XP/Vista/7 with a USB port.

Windows XP
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. From the Start menu, select Control Panel, > Scanners and Cameras.
4. Double click your scanner driver icon. The Scanner and Camera  

Wizard appears.
5. Click Next.
6. Set the option in Choose scanning preferences window and click 

Preview to see how your options affect the picture.
7. Click Next.
8. Enter a picture name, and select a file format and destination to save the 

picture.
9. Your picture has been successfully copied to your computer. Choose 

one of the options on screen. 
10. Click Next.
11. Click Finish.



Windows Vista
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. From the Start menu select Control Panel > Hardware and Sound > 
Scanners and Cameras. 

4. Double click Scan a document or picture. Windows Fax and Scan 
application appears.

 

•You can click on View scanners and cameras to view scanners, 
•If there is no Scan a document or picture, open the MS paint 

program and from the File click From Scanner or Camera... .
5. Click New Scan. Scan driver appears.
6. Choose your scanning preferences and click Preview to see your 

preferences affect the picture.
7. Click Scan.

 

If you want to cancel the scan job, press the Cancel button on the 
Scanner and Camera Wizard.

Windows 7
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. From the Start menu select Control Panel > Hardware and Sound > 
Devices and Printers. 

4. Click right button of mouse on device driver icon in Printers and Faxes 
> Start Scan. New Scan application appears.

5. Choose your scanning preferences and click Preview to see your 
preferences affect the picture.

6. Click Scan.

Macintosh scanning
You can scan documents using Image Capture program. Macintosh OS 
offers Image Capture program. 

Scanning with USB
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. Start Applications and click Image Capture.

 

If No Image Capture device connected message appears, 
disconnect the USB cable and reconnect it. If the problem 
continues, refer to the Image Capture’s help.

4. Set the scan options on this program.
5. Scan and save your scanned image.

 

•For more information about using Image Capture, refer to the Image 
Capture’s help.

•Use TWAIN-compliant software to apply more scan options.
•You can also scan using TWAIN-compliant software, such as Adobe 

Photoshop.
•Scan process differ according to TWAIN-compliant software. Please 

refer to the user’s guide of the software.
•If scanning does not operate in Image Capture, update Mac OS to 

the latest version. Image Capture operates properly in Mac OS X 
10.3.9 or higher and Mac OS X 10.4.7 or higher.

Scanning with network
1. Make sure that the machine is connected to your computer and powered 

on.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass
(See "Loading originals" on page 1).

3. Start Applications and click Image Capture.
4. For Mac OS X 10.4 ~ 10.5

Click Devices and click Browse Devices.
For Mac OS X 10.6
Select your device below SHARED. Skip to step 7.

5. For Mac OS X 10.4:
Select your machine in Twain devices option. Make sure that Use 
TWAIN software checkbox is checked, and click Connect.
•If a warning message appears, click Change Port.. to select port. 
•If TWAIN UI appears, from the Preference tab, click Change Port.. to 

select port. 

 

Refer to Scan Manager for Change port.. use (See "Setting 
scan information in Scan Manager" on page 7).

For Mac OS X 10.5:
Make sure that Connected checkbox is checked beside your machine in 
Bonjour Devices.
If you want to scan using TWAIN, refer to the Mac OS X 10.4 steps 
above.

6. Set the scan options on this program.
7. Scan and save your scanned image.

 

•For more information about using Image Capture,refer to the Image 
Capture’s help.

•Use TWAIN-compliant software to apply more scan options. 
•You can also scan using TWAIN-compliant software, such as Adobe 

Photoshop.
•Scan process differ according to TWAIN-compliant software. Please 

refer to the user’s guide of the software.
•If scanning does not operate in Image Capture, update Mac OS to 

the latest version. Image Capture operates properly Mac OS X 
10.4.7 or higher.

Setting scan information in Scan Manager
To find out about Scan Manager program information, to check the 
installed scan driver's condition, to change scan settings. and to add or 
delete the folders where scanned documents to computer are saved in 
Scan Manager program, follow these instructions:
1.From the Smart Panel menu on Status bar, click Scan Manager. 
2.Select the appropriate machine from the Scan Manager.
3. Press Properties.
4.Use Set Scan Button to change the file destination or scan settings, 

to add or delete application programs, and to format files. You can 
change the scanning machine by using Change port. (Local or 
Network) 
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5.When done, press OK.

Linux scanning
You can scan a document using the Unified Driver Configurator window.

Scanning
1. Double-click the Unified Driver Configurator on your desktop.

2. Click the  button to switch to Scanners Configuration.
3. Select the scanner on the list.

If you use only one machine device and it is connected to the computer 
and turned on, your scanner appears on the list and is automatically 
selected.
If you have two or more scanners connected to your computer, you can 
select any scanner to work at any time. For example, while acquisition is 
in progress on the first scanner, you may select the second scanner, set 
the device options and start the image acquisition simultaneously.

4. Click Properties.
5. Load originals face up into the document feeder, or place a single 

original face down on the platen glass
(See "Loading originals" on page 1).

6. From the Scanner Properties window, click Preview.
The document is scanned and the image preview appears in the 

Preview Pane.

7. Drag the pointer to set the image area to be scanned in the Preview 
Pane. 

8. Change the scan options in the Image Quality and Scan Area sections.
•Image Quality: This option allows you to select the color composition 

and the scan resolution for the image.
•Scan Area: This option allows you to select the page size. The 

Advanced button enables you to set the page size manually.
If you want to use one of the preset scan option settings, select the 
option from the Job Type drop-down list (See "Adding Job Type 
Settings" on page 8).
Click Default to restore the default setting for the scan options.

9. When you have finished, click Scan to start scanning.
The status bar appears on the bottom left of the window to show you the 
progress of the scan. To cancel scanning, click Cancel.

10. The scanned image appears.
If you want to edit the scanned image, use the toolbar (See "Using the 
Image Manager" on page 9).

11. When you are finished, click Save on the toolbar.
12. Select the file directory where you want to save the image and enter the 

file name.
13. Click Save.

Adding Job Type Settings
You can save your scan option settings for later use.

To save a new Job Type setting:
1.Change the options from the Scanner Properties window.
2.Click Save As.
3.Enter the name for your setting.
4.Click OK. 

Your setting is added to the Saved Settings drop-down list.

To save a Job Type setting for the next scan job:
1.Select the setting you want to use from the Job Type drop-down list.
2.The next time you open the Scanner Properties window, the saved 

setting is automatically selected for the scan job.
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To delete a Job Type setting
1.Select the setting you want to delete from the Job Type drop-down 

list.
2.Click Delete.

The setting is deleted from the list.

Using the Image Manager
The Image Manager application provides you with menu commands and 
tools to edit your scanned image.

Use the following tools to edit the image:

Tools Name Function

Save Saves the image.

Undo Cancels your last action.

Redo Restores the action you canceled.

Scroll Allows you to scroll through the image.

Crop Crops the selected image area.

Zoom Out Zooms the image out.

Zoom In Zooms the image in.

Scale Allows you to scale the image size; you can 
enter the size manually, or set the rate to scale 
proportionally, vertically, or horizontally.

Rotate Allows you to rotate the image; you can select 
the number of degrees from the drop-down list.

Flip Allows you to flip the image vertically or 
horizontally. 

Brightness Allows you to adjust the brightness or contrast 
of the image, or to invert the image.

Properties Shows the properties of the image.

For further details about the Image Manager application, refer to the on 
screen help.
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1.faxing
This chapter gives you information about using the fax feature in your machine.
This chapter includes:
• Preparing to fax
• Using a fax in your computer
• Sending a fax
• Receiving a fax

• Adjusting the document settings
• Forwarding a fax to another destination
• Setting up address book
• Printing sent fax report automatically

  

 

•You cannot use this machine as a fax through the internet phone line. 
For more information ask your internet service provider.

•We recommend using traditional analog phone services (PSTN: 
public switched telephone network) when connecting telephone 
lines to use the Fax. If you use other Internet services (DSL, ISDN, 
VolP), you can improve the connection quality by using the 
Micro-filter. The Micro-filter eliminates unnecessary noise signals 
and improves connection quality or Internet quality. Since the DSL 
Micro-filter is not provided with the machine, contact your Internet 
Service provider for use on DSL Micro-filter.

1 Line port
2 Micro filter
3 DSL modem / Telephone line

Preparing to fax
Before you send a fax, you need to connect the supplied line cord to the wall 
jack. Refer to the Quick Install Guide how to make a connection. The 
method of making a telephone connection varies from one country to 
another.

Using a fax in your computer
You can send a fax from your computer without going to the machine.

Sending a fax
To send a fax from your computer, the Samsung Network PC Fax program 
must be installed. This program will be installed when you installed the 
printer driver. 
1. Open the document to be sent.
2. Select Print from the File menu. 

The Print window will be displayed. It may look slightly different 
depending on your application.

3. Select Samsung Network PC Fax from the Print window
4. Click Print or OK.

5. Enter the recipients’ numbers and select the option.

If you want to use a cover page, check Use cover page.
Check Notify me on delivery, when the fax delivered to the recipients 
successfully. 

6. Click Send.

 

For more information about Samsung Network PC Fax, click Help. 

Checking a sent fax list
You can check a sent fax list on your computer.
From the Start menu, click Programs or All Programs > Samsung 
Printers > Network PC Fax > Fax Journal. Then, the Fax Journal 
appears with the fax list you have sent.

Receiving a fax
If you have installed the printer driver, the Samsung Scan & Fax Manager 
program is also installed. Start Samsung Scan & Fax Manager program to 
find out about this program information and the installed driver's condition. 
Through this program, you can change fax settings and add or delete the 
folders where faxed documents are saved in your computer. 

 

The Samsung Scan & Fax Manager program can only be used with 
the Windows and Macintosh systems. Check if the forwarding a fax to 
PC is set to On:

a)Press  (Fax) on the control panel.

b)Press Menu on the control panel.
c)Press the up/down arrow to highlight Fax Feature appears and 

press OK.
d)Press the up/down arrow to highlight Forward appears and press 

OK.
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e)Press the the up/down arrow to highlight PC: appears and press 
OK.

1. Open the Samsung Scan & Fax Manager.
•For Windows, from the Start menu, click All programs > Samsung 

Printers > Samsung Scan & Fax Manager > Samsung Scan & 
Fax Manager. 
Or you can open this program by right clicking the Smart Panel icon 
in the Windows task bar and selecting the Samsung Scan & Fax 
Manager.

•For Macintosh, from the Smart Panel menu on status bar, click 
Samsung Scan & Fax Manager. 

2. Select the appropriate machine from the Samsung Scan & Fax 
Manager.

3. Click Properties.
4. Use Set Fax Receiving to change the fax settings.
5. When setting is done, press OK.

Set Fax Receiving tab
•Enable Fax Receiving: You can select whether to use or not.
•File Format: You can convert the received faxes to PDF or TIFF.
•Save Location: Selects location to save the converted faxes.
•Prefix: Selects file or folder scheme as prefix. 
•Notify me when fax received: Shows popup window to notify 

receiving a fax.
•Print received fax: After receiving the fax, set prints information for 

the received fax.

Change Port tab
•Local Scanner: Select when your machine is connected via USB or 

LPT port. 
•Network Scanner: Select when your machine is connected via 

network port.
-Auto detection on the network: Automatically detects your 

machine.
-IP or Host name: Enter in your machine’s IP address or host name 

to detect your machine. 

Sending a fax
This part explains how to send a fax and the special methods of 
transmission.

 

When you place the originals, in the document feeder and/or on the 
platen glass one at a time (See "Loading originals" on page 1). If the 
originals are placed on both the document feeder and the scanner 
glass, the machine will read the originals on the document feeder first, 
which has higher priority in scanning.

Setting the fax header
In some countries, you are required by law to indicate your fax number on 
any fax you send. 

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight System Setup and press OK.
4. Press the up/down arrow to highlight Machine Setup and press OK.
5. Press the up/down arrow to highlight Machine ID and press OK.

6. Enter your name or the company name using the number keypad. You 
can enter alphanumeric characters using the number keypad, and 
include special symbols by pressing the 1 button. For details on how to 
enter alphanumeric characters, see "Entering characters using the 
number keypad" on page 2.

7. Press OK to save the ID.
8. Press the up/down arrow to highlight Machine Fax No. and press OK.
9. Enter your fax number using the number keypad and press OK.
10. Press Stop/Clear to return to ready mode.

Sending a fax 
1. Press  (Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See 
"Adjusting the document settings" on page 6).

4. Enter the receiving fax machine’s number.
You can use speed dial numbers, or group dial numbers. For details 
about storing and searching for a number, see "Setting up address 
book" on page 7.

5. Press Start on the control panel. The machine starts to scan and send a 
fax to destinations.

 

•If you want to send fax directly from your computer, use SmarThru 
Office (See "Using SmarThru Office" on page 3).

•When you want to cancel a fax job, press Stop/Clear before the 
machine start transmission.

•If you used the scanner glass, the machine shows the message 
asking to place another page.

•While the machine is sending a fax, you can not send an email at the 
same time.

Sending a fax manually
This method is sending a fax using On Hook Dial on the control panel.

1. Press  (Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See 
"Adjusting the document settings" on page 6).

4. Press On Hook Dial on the control panel.
5. Enter a fax number using the number keypad on the control panel.
6. Press Start when you hear a high-pitched fax signal from the remote fax 

machine.
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When you want to cancel a fax job, press Stop/Clear at any time while 
sending.

Confirming a transmission
When the last page of your original has been sent successfully, the machine 
beeps and returns to ready mode.
When something goes wrong while sending your fax, an error message 
appears on the display. For a list of error messages and their meanings, see 
"Understanding display messages" on page 8. If you receive an error 
message, press Stop/Clear to clear the message and try to send the fax 
again.
You can set your machine to print a confirmation report automatically each 
time sending a fax is completed. For further details, see "Printing sent fax 
report automatically" on page 9.

Automatic redialing
When the number you have dialed is busy or there is no answer when you 
send a fax, the machine automatically redials the number. The redial time 
depends on the country's factory default setting. To change the time interval 
between redials and the number of redial attempts (See "Changing the fax 
setup options" on page 1).
When the display shows Retry Redial?, press OK to redial the number 
without waiting. To cancel the automatic redialing, press Stop/Clear.

Redialing the last number
To redial the number you called last:
1. Press Redial/Pause on the control panel.
2. When an original is loaded in the document feeder, the machine 

automatically begins to send.
If an original is placed on the scanner glass, select Yes to add another 
page. Load another original and press OK. When you have finished, 
select No when Another Page? appears.

Sending a fax to multiple destinations
You can use the Multiple Send feature, which allows you to send a fax to 
multiple locations. Originals are automatically stored in memory and sent to 
a remote station. After transmission, the originals are automatically erased 
from memory. You cannot send a color fax using this feature.

1. Press  (Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See 
"Adjusting the document settings" on page 6).

4. Press Menu on the control panel.
5. Press the up/down arrow to highlight Fax Feature and press OK.
6. Press the up/down arrow to highlight Multi Send and press OK.
7. Enter the number of the first receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up address book" on 
page 7.

8. Enter the second fax number and press OK.
The display asks you to enter another fax number to send the document.

9. To enter more fax numbers, press OK when Yes highlights and repeat 
steps 7 and 8. You can add up to 10 destinations.

10. Press OK to start storing the scanned original data into memory.

 

Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

11. When you have finished entering fax numbers, press the left/right arrow 
to select No when Another Page? appears.

12. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No when Another Page? appears.
The machine begins sending the fax to the numbers you entered in the 
order in which you entered them.

Delaying a fax transmission
You can set your machine to send a fax at a later time when you will not be 
present. You cannot send a color fax using this feature.

1. Press  (Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See 
"Adjusting the document settings" on page 6).

4. Press Menu on the control panel.
5. Press the up/down arrow to highlight Fax Feature and press OK.
6. Press the up/down arrow to highlight Delay Send and press OK.
7. Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up address book" on 
page 7.

8. The display asks you to enter another fax number to send the document.
9. To enter more fax numbers, press OK when Yes highlights and repeat 

steps 7. You can add up to 10 destinations.

 

Once you entered a group dial number, you cannot enter another 
group dial numbers anymore.

10. When you have finished entering fax numbers, press the left/right arrow 
to select No when Another Page? appears and press OK.

11. Enter the job name you want and press OK.
For details on how to enter alphanumeric characters, see "Entering 
characters using the number keypad" on page 2.
If you do not want to assign a name, skip this step.

12. Enter the time using the number keypad and press OK.

 

If you set a time earier than the current time, the fax will be sent at 
that time on the following day.

The original is scanned into memory before transmission.
13. If an original is placed on the scanner glass, select Yes to add another 

pages. Load another original and press OK.
When you have finished, select No when Another Page? appears.
The machine returns to ready mode. The display reminds you that you 
are in ready mode and that a delayed fax is set.

Adding documents to a reserved delay fax job
You can add additional documents to the delayed fax job which is saved 
in memory.
1.Load the originals to be added and adjust document settings.
2.Press Menu on the control panel.
3.Press the up/down arrow to highlight Fax Feature and press OK.
4.Press the up/down arrow to highlight Add Pages and press OK.
5.Press the up/down arrow until the fax job you want appears and press 

OK.
When you have finished, select No when Another Page? appears. 
The machine scans the original into memory.
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6.Press Stop/Clear to return to ready mode.

Canceling a reserved delay fax job
You can cancel the delayed fax job which is saved in memory.
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight Fax Feature and press OK.
3.Press the up/down arrow to highlight Cancel Job and press OK.
4.Press the up/down arrow until the fax job you want appears and press 

OK.
5.Press OK when Yes highlights.

The selected fax is deleted from memory.
6.Press Stop/Clear to return to ready mode.

Sending a priority fax
This function is used when a high priority fax need to be sent ahead of 
reserved operations. The original is scanned into memory and immediately 
transmitted when the current operation is finished. In addition, priority 
transmission will interrupt a sending to multiple destinations between 
stations (example, when the transmission to station A ends, before 
transmission to station B begins) or between redial attempts.

1. Press  (Fax) on the control panel.

2. Load originals face up into the document feeder, or place a single 
original face down on the scanner glass.

3. Adjust the resolution and the darkness to suit your fax needs (See 
"Adjusting the document settings" on page 6).

4. Press Menu on the control panel.
5. Press the up/down arrow to highlight Fax Feature and press OK.
6. Press the up/down arrow to highlight Priority Send and press OK.
7. Enter the number of the receiving fax machine and press OK.

You can press speed dial numbers or select group dial number using 
Address book button. For details, see "Setting up address book" on 
page 7.

8. Enter the job name you want and press OK.
The original is scanned into memory before transmission.

9. If an original is placed on the scanner glass, select Yes to add another 
pages. Load another original and press OK.
When you have finished, select No when Another Page? appears.
The machine starts to scan and send a fax to destinations.

Sending faxes on both sides of paper

 

This is available only when you load originals into the document 
feeder.

You can set the machine to send faxes on both sides of paper.

1. Press  (Fax) on the control panel. 

2. Place originals, face up, in the document feeder. Or you can use the 
scanner glass with a single original document face down and closed the 
scanner lid.

3. Press Duplex on the control panel.
4. Press the up/down arrow until the binding option you want highlights.

•Off: Send faxes in normal mode.
•2 Side: Send faxes on both sides of the original.
•2->1Side ROT2: Send faxes on both sides of the original and prints 

each one on a separate sheet, but the information on the back side 
of the printout is rotated 180°.

5. Press OK to save your selection.

Receiving a fax
This part explains how to receive a fax, and the special receiving methods 
available.

Changing the receive modes
Your machine is preset to Copy mode at the factory; however you can 
change the default so fax is priority (See "Changing the default mode" on 
page 2). When you receive a fax, the machine answers the call on a 
specified number of rings and automatically receives the fax. But if you want 
to change the Fax mode to another mode, follow the steps below:

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Setup and press OK.
4. Press the up/down arrow to highlight Receiving and press OK.
5. Press the up/down arrow to highlight Receive Mode and press OK.
6. Press the up/down arrow until the fax reception mode you want 

highlights.
•Fax: Answers an incoming fax call and immediately goes into the fax 

reception mode.
•Tel: Receives a fax by pressing On Hook Dial and then Start.
•Ans/Fax: Is for when an answering machine attached to your machine. 

Your machine answers an incoming call, and the caller can leave a 
message on the answering machine. If the fax machine senses a fax 
tone on the line, the machine automatically switches to Fax mode to 
receive the fax.

•DRPD: you can receive a call using the Distinctive Ring Pattern 
Detection (DRPD) feature. Distinctive Ring is a telephone company 
service which enables an user to use a single telephone line to 
answer several different telephone numbers. For further details, see 
"Receiving faxes using DRPD mode" on page 5.

 

This setting may not be available depending on your country. 

7. Press OK to save your selection.
8. Press Stop/Clear to return to ready mode.

 

•To use the Ans/Fax mode, attach an answering machine to the 
EXT socket on the back of your machine. 

•If you do not want other people to view your received documents, 
you can use secure receiving mode. In this mode, all of the 
received faxes are stored in memory. For further details, see 
"Receiving in secure receiving mode" on page 5.

Receiving manually in Tel mode
You can receive a fax call by pressing On Hook Dial and then pressing 
Start when you hear a fax tone ; however you can change the default so fax 
is priority (See "Changing the default mode" on page 2). The machine 
begins receiving the fax.
To change the number of rings, see "Changing the fax setup options" on 
page 1.

Receiving automatically in Answering Machine/Fax 
mode
To use this mode, you must attach an answering machine to the EXT socket 
on the back of your machine (See "Rear view" on page 2).
If the caller leaves a message, the answering machine stores the message 
as it would normally. If your machine detects a fax tone on the line, it 
automatically starts to receive the fax.
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•If you have set your machine to this mode and your answering 
machine is switched off, or no answering machine is connected to 
EXT socket, your machine automatically goes into Fax mode after 
a predefined number of rings.

•If your answering machine has a user-selectable ring counter, set the 
machine to answer incoming calls within 1 ring.

•If you are in Tel mode when the answering machine is connected to 
your machine, you must switch off the answering machine. 
Otherwise, the outgoing message from the answering machine will 
interrupt your phone conversation.

Receiving faxes manually using an extension 
telephone
This feature works best when you are using an extension telephone 
connected to the EXT socket on the back of your machine. You can receive 
a fax from someone you are talking to on the extension telephone, without 
going to the fax machine.
When you receive a call on the extension phone and hear fax tones, press 
the keys *9* on the extension phone. The machine receives the fax.
Press the buttons slowly in sequence. If you still hear the fax tone from the 
remote machine, try pressing *9* once again.
*9* is the remote receive code preset at the factory. The first and the last 
asterisks are fixed, but you can change the middle number to whatever you 
wish. For details about changing the code, see "Changing the fax setup 
options" on page 1

Receiving faxes using DRPD mode
Distinctive Ring is a telephone company service which enables an user to 
use a single telephone line to answer several different telephone numbers. 
The particular number someone uses to call you is identified by different 
ringing patterns, which consist of various combinations of long and short 
ringing sounds. This feature is often used by answering services who 
answer telephones for many different clients and need to know which 
number someone is calling in on to properly answer the phone.
Using the Distinctive Ring Pattern Detection (DRPD) feature, your fax 
machine can learn the ring pattern you designate to be answered. Unless 
you change it, this ringing pattern will continue to be recognized and 
answered as a fax call, and all other ringing patterns will be forwarded to the 
extension telephone or answering machine plugged into the EXT socket. 
You can easily suspend or change DRPD at any time.
Before using the DRPD option, Distinctive Ring service must be installed on 
your telephone line by the telephone company. To set up DRPD, you will 
need another telephone line at your location, or someone available to dial 
your fax number from outside.
To set up the DRPD mode:

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Setup and press OK.
4. Press the up/down arrow to highlight Receiving and press OK.
5. Press the up/down arrow to highlight DRPD Mode and press OK.

Waiting Ring appears on the display.
6. Call your fax number from another telephone. It is not necessary to 

place the call from a fax machine.
7. When your machine begins to ring, do not answer the call. The machine 

requires several rings to learn the pattern.
When the machine completes learning, the display shows Completed 
DRPD Setup. If the DRPD setup fails, Error DRPD Ring appears.
Press OK when DRPD appears and start over from step 6.

 

•DRPD must be set up again if you re-assign your fax number, or 
connect the machine to another telephone line. 

•After DRPD has been set up, call your fax number again to verify 
that the machine answers with a fax tone. Then have a call 
placed to a different number assigned to that same line to be 
sure the call is forwarded to the extension telephone or 
answering machine plugged into the EXT socket.

Receiving in secure receiving mode
You may need to prevent your received faxes from being accessed by 
unauthorized people. You can turn on secure receiving mode to restrict 
printing of received faxes when the machine is unattended. In secure 
receiving mode, all incoming faxes go into memory. When the mode is 
deactivated, any stored faxes are printed.

Activating secure receiving mode
1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Secure Receive and press OK.
5. Press the up/down arrow to highlight On and press OK.
6. Enter a four-digit password you want to use and press OK.

 

You can activate secure receiving mode without setting a 
password, but cannot protect your faxes.

7. Re-enter the password to confirm it and press OK.
8. Press Stop/Clear to return to ready mode.
When a fax is received in secure receiving mode, your machine stores it in 
memory and shows Secure Receive to let you know that there is a fax 
received.

Printing received faxes
1.Access the Secure Receive menu by following steps 1 through 4 in 

“Activating secure receiving mode.”
2.Press the up/down arrow to highlight Print and press OK.
3.Enter the four-digit password and press OK.

The machine prints all of the faxes stored in memory.

Deactivating secure receiving mode
1.Access the Secure Receive menu by following steps 1 through 4 in 

“Activating secure receiving mode.”
2.Press the up/down arrow to highlight Off and press OK.
3.Enter the four-digit password and press OK.

The mode is deactivated and the machine prints all faxes stored in 
memory.

4.Press Stop/Clear to return to ready mode.

Printing received faxes on both sides of the paper
Set this duplex feature to save paper. When the machine prints the received 
fax data, it prints them on both sides of the paper.

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Setup and press OK.
4. Press the up/down arrow to highlight Receiving and press OK.
5. Press the up/down arrow to highlight Duplex Print and press OK.
6. Press the up/down arrow until the binding option you want highlights.
Faxing_ 5



•Off: Prints in Normal mode.
•Long Edge: Prints pages to be read like a book.

•Short Edge: Prints pages to be read by flipping like a note pad.

2

5
3

7. Press OK to save your selection.
8. Press Stop/Clear to return to ready mode.

Receiving faxes in memory
Since your machine is a multi-tasking device, it can receive faxes while you 
are making copies or printing. If you receive a fax while you are copying or 
printing, your machine stores incoming faxes in its memory. Then, as soon 
as you finish copying or printing, the machine automatically prints the fax. 

Adjusting the document settings
Before starting a fax, change the following settings according to your 
original’s status to get the best quality.

Resolution
The default document settings procedure good results when using typical 
text-based originals. However, if you send originals that are of poor quality, 
or contain photographs, you can adjust the resolution to produce a higher 
quality fax. 

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Resolution and press OK.
5. Press the up/down arrow until the option you want is highlighted and 

press OK.
6. Press Stop/Clear to return to ready mode.
Recommended resolution settings for different original document types are 
described in the table below:

mode recommended for:

Standard Originals with normal sized characters.

Fine Originals containing small characters or thin lines or 
originals printed using a dot-matrix printer.

Super Fine Originals containing extremely fine detail. Super Fine 
mode is enabled only if the machine with which you are 
communicating also supports the Super Fine resolution.

 

•For memory transmission, Super Fine mode is 
not available. The resolution setting is 
automatically changed to Fine

•When your machine is set to Super Fine 
resolution and the fax machine with which you 
are communicating does not support Super 
Fine resolution, the machine transmits using 
the highest resolution mode supported by the 
other fax machine.

Photo Fax Originals containing shades of gray or photographs.

 

The resolution setting is applied to the current fax job. To change the 
default setting, see "Change default" on page 2.

Darkness
You can select the degree of darkness of the original document. 

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Darkness and press OK.
5. Press the up/down arrow until the option you want highlights and press 

OK.
6. Press Stop/Clear to return to ready mode.

 

The darkness setting is applied to the current fax job. To change the 
default setting, see "Change default" on page 2.

Scan size
You can choose the size to be scanned.

 

The scan size options may vary between document feeder or scanner 
glass. 

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Scan Size and press OK.
5. Press the up/down arrow until the scan size you want highlights and 

press OK.
6. Press Stop/Clear to return to ready mode.

Forwarding a fax to another destination
You can set the machine to forward the received or sent fax to other 
destination by a fax, an email or a server. If you are out of office but have to 
receive the fax, this feature may be useful.

 

When you forward a fax by an email, you must first set the mail server 
and IP address in SyncThru™ Web Service (See "Using SyncThru™ 
Web Service" on page 1).

Forwarding a sent fax to another destination
You can set the machine to forward every fax you sent to another 
destination.

mode recommended for:
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1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Forward and press OK.
5. Press the up/down arrow to highlight Fax and press OK.
6. Press the up/down arrow to highlight Send Forward and press OK.
7. Press the up/down arrow to highlight On and press OK.
8. Enter the number of the fax machine to which faxes are to be sent and 

press OK.
9. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified fax machine.

Forwarding a received fax to another destination
With this feature, you can forward every fax you received to another 
destination by faxing. When the machine receives a fax, a fax is stored in 
the memory then, the machine sends it to the destination you have set.

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Forward and press OK.
5. Press the up/down arrow to highlight Fax and press OK.
6. Press the up/down arrow to highlight Receive Forward and press OK.
7. Press the up/down arrow to highlight Forward and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print. 

8. Enter the number of the fax machine to which faxes are to be sent and 
press OK.

9. Enter the starting time using up/down, left/right arrow or numeric keypad 
and press OK.

10. Enter the ending time using up/down, left/right arrow or numeric keypad 
and press OK.

11. Press Stop/Clear to return to ready mode.
Subsequent received faxes will be forwarded to the specified fax 
machine.

Forwarding a sent fax to other destination by an 
email
1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Forward and press OK.
5. Press the up/down arrow to highlight Email and press OK.
6. Press the up/down arrow to highlight Send Forward and press OK.
7. Press the up/down arrow to highlight On and press OK.
8. Enter your email address and press OK.
9. Enter the email address to which faxes are to be sent and press OK.
10. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified email address.

Forwarding a received fax to other destination by an 
email
1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.

3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Forward and press OK.
5. Press the up/down arrow to highlight Email and press OK.
6. Press the up/down arrow to highlight Receive Forward and press OK.
7. Press the up/down arrow to highlight Forward and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print. 

8. Enter your email address and press OK.
9. Enter the email address to which faxes are to be sent and press OK.
10. Press Stop/Clear to return to ready mode.

Subsequent received faxes will be forwarded to the specified email 
addresses.

Forwarding a sent fax to other destination by a 
server

 

When you forward a fax to FTP or SMB server, you must first set the 
server in SyncThru™ Web Service (See "Setting up an FTP server" 
on page 4 or "Setting up an SMB server" on page 4). You can forward 
a fax to a total of five destinations via the SMB or FTP.

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Forward and press OK.
5. Press the up/down arrow to highlight Server and press OK.
6. Press the up/down arrow to highlight Send Forward and press OK.
7. Press the up/down arrow to highlight On and press OK.
8. Press Stop/Clear to return to ready mode.

Subsequent sent faxes will be forwarded to the specified server.

Forwarding a received fax to other destination by 
server

 

When you forward a fax to FTP or SMB server, you must first set the 
server in SyncThru™ Web Service (See "Setting up an FTP server" 
on page 4 or "Setting up an SMB server" on page 4). You can forward 
a fax to a total of five destinations via the SMB or FTP.

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Feature and press OK.
4. Press the up/down arrow to highlight Forward and press OK.
5. Press the up/down arrow to highlight Server and press OK.
6. Press the up/down arrow to highlight Receive Forward and press OK.
7. Press the up/down arrow to highlight Forward and press OK.

To set the machine to print out a fax when fax forwarding has been 
completed, select Forward & Print. 

8. Press Stop/Clear to return to ready mode.
Subsequent received faxes will be forwarded to the specified server.

Setting up address book
You can set up Address Book with the fax numbers you use most 
frequently. Your machine provides you with the following features for setting 
up Address Book:

 

Before beginning to store fax numbers, make sure that your machine 
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is in Fax mode.

Speed dial numbers
You can store up to 240 frequently-used fax numbers in speed dial 
numbers.

Registering a speed dial number
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight New & Edit and press OK.
4.Press the up/down arrow to highlight Speed Dial and press OK.
5.Enter a speed dial number between 1 and 240 and press OK.

If an entry is already stored in the number you choose, the display 
shows the message to allow you to change it. To start over with 
another speed dial number, press Back.

6.Enter the name you want and press OK.
For details on how to enter alphanumeric characters, see ""Entering 
characters using the number keypad" on page 2.

7.Enter the fax number you want and press OK.
8.Press Stop/Clear to return to ready mode.

Editing speed dial numbers
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight New & Edit and press OK.
4.Press the up/down arrow to highlight Speed Dial and press OK.
5.Enter the speed dial number you want to edit and press OK.
6.Change the name and press OK.
7.Change the fax number and press OK.
8.Change the name and press OK.
9.Press Stop/Clear to return to ready mode.

Using speed dial numbers
When you are prompted to enter a destination number while sending a 
fax, enter the speed dial number at which you stored the number you 
want.
•For a one-digit (0-9) speed dial number, press and hold the 

corresponding digit button on the number keypad.
•For a two- or three-digit speed dial number, press the first digit button(s) 

and then hold down the last digit button.
You can also search through memory for an entry by pressing Address 
Book (See "Searching address book for an entry" on page 8).

Group dial numbers
If you frequently send the same document to several destinations, you can 
group these destinations and set them under a group dial number. You can 
then use a group dial number to send a document to all of the destinations 
within the group. You can set up to 200 (0 through 199) group dial numbers 
using the destination’s existing speed dial numbers.

Registering a group dial number
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight New & Edit and press OK.
4.Press the up/down arrow to highlight Group Dial and press OK.
5.Enter a group dial number between 0 and 199 and press OK.

If an entry is already stored in the number you choose, the display 
shows the message to allow you to change it.

6.Enter the name you want and press OK.
For details on how to enter alphanumeric characters, see ""Entering 
characters using the number keypad" on page 2.

7.Enter the first few letters of the speed dial’s name you want.
8.Press the up/down arrow until the name and number you want 

highlights and press OK.
9.Press OK when Yes highlights when Another Page? appears.

Repeat step 7 to include other speed dial numbers into the group.
10.When you have finished, press the left/right arrow to select No when 

Another Page? appears and press OK.
11.Press Stop/Clear to return to ready mode.

Editing a group dial number
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight New & Edit and press OK.
4.Press the up/down arrow to highlight Group Dial and press OK.
5.Enter the group dial number you want to edit and press OK.
6.Enter the name you want to edit and press OK.
7.Enter the first few letters of the speed dial’s name you want to add or 

delete.
8.Press the up/down arrow until the name and number you want 

highlights and press OK.
If you entered a new speed dial number, Add? appears.
If you enter a speed dial number stored in the group, Delete? 
appears.

9.Press OK to add or delete the number.
10.Press OK when Yes highlights to add or delete more numbers and 

repeat steps 7 and 8.
11.When you have finished, press the left/right arrow to select No at the 

Another Number? and press OK.
12.Press Stop/Clear to return to ready mode.

Using group dial numbers
To use a group dial entry, you need to search for and select it from 
memory.
When you are prompted to enter a fax number while sending a fax, 
press Address Book. See below.

Searching address book for an entry
There are two ways to search for a number in memory. You can either scan 
from A to Z sequentially, or you can search by entering the first letters of the 
name associated with the number.

Searching sequentially through the memory
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight Search & Dial and press OK.
4.Press the up/down arrow to highlight Group Dial and press OK.
5.Press the up/down arrow to highlight All and press OK.
6.Press the up/down arrow until the name and number you want 

highlights. You can search upwards or downwards through the entire 
memory in alphabetical order.
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Searching sequentially through the memory
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight Search & Dial and press OK.
4.Press the up/down arrow to highlight Group Dial and press OK.
5.Press the up/down arrow to highlight Search ID and press OK.
6.Enter the first few letters of the name you want.
7.Press the up/down arrow until the group dial’s name and number you 

want highlights.

Deleting a Address Book for entry
1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight Delete and press OK.
4.Press the up/down arrow until the deleting option you want is 

highlighted and press OK.
5.Press the up/down arrow until the searching method you want 

highlights and press OK.
Select Search All to search for an entry by scanning through all 
entries in Address Book.
Select Search ID to search for an entry by the first few letters of the 
name.

6.Press the up/down arrow until the name you want is highlighted and 
press OK.
Or, enter the first letters. Press the up/down arrow until the name you 
want highlights and press OK.

7.Press OK when Yes highlights to confirm the deletion.
8.Press Stop/Clear to return to ready mode.

Printing Address Book
You can check your Address Book settings by printing a list.

1.Press  (Fax) on the control panel.

2.Press Address Book on the control panel.
3.Press the up/down arrow to highlight Print and press OK.

The machine begins printing.

Printing sent fax report automatically
You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Setup and press OK.
4. Press the up/down arrow to highlight Auto Report and press OK.
5. Press the up/down arrow to highlight On and press OK.
6. Press Stop/Clear to return to ready mode.
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1.using usb memory device
This chapter explains how to use a USB memory device with your machine.
This chapter includes:
• About USB memory device
• Scanning to an USB memory device
• Printing from a USB memory device

• Backing up data
• Managing USB memory

  

About USB memory device
USB memory devices are available with a variety of memory capacities to 
give you more room for storing documents, presentations, music and 
videos, high resolution photographs, or whatever other files you want to 
store or move.
You can do the following on your machine using an USB memory device:
• Scan documents and save them on an USB memory device.
• Print data stored on an USB memory device.
• Format the USB memory device.
Your machine supports USB memory devices with FAT16/FAT32 and 
sector size of 512 bytes. 
Check your USB memory device’s file system from your dealer.
You must use only an authorized USB memory device with an A plug type 
connector.

Use only an USB memory device with metal-shielded connector.

Insert a USB memory device into the USB memory port on your machine.

 

•Do not remove the USB memory device while it is in use. The 
machine warranty does not cover damage caused by user’s 
misuse. 

•If your USB memory device has certain features (example, security 
key, security partition, booting disk, password settings and so 
forth), do not use the USB memory device with your machine. The 

files stored in the USB memory device may be corrupted, or the 
machine may not automatically detect it. For details about these 
features, see device’s User’s Guide.

Scanning to an USB memory device
You can scan a document and save the scanned image onto an USB 
memory device. There are two ways of doing this: you can scan to the 
device using the default settings, or you can customize your own scan 
settings. When you scan a document, the machine uses the default settings 
such as the resolution. You can also customize your own scan setting.
If your USB memory device has certain features (example, security key, 
security partition, booting disk, password settings and so forth), do not use 
the USB memory device with your machine. The files stored in the USB 
memory device may be corrupted, or the machine may not automatically 
detect it. For details about these features, see device’s User’s Guide.

Scanning
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Load originals face up into the document feeder, or place a single 

original face down on the scanner glass. 

3. Press  (Scan/Email) and press OK.

4. Press the up/down arrow to highlight Scan To USB and press OK.
Your machine begins scanning the original, and then asks if you want to 
scan another page.

5. To scan another page, press the left/right arrow to highlight Yes and 
press OK. Load an original and press Start.
Otherwise, press the left/right arrow to highlight No and press OK. 

6. After scanning is complete, you can remove the USB memory device 
from the machine.

Customizing scan to USB
You can specify image size, file format, or color mode for each scanning to 
USB job.

1. Press  (Scan/Email) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Scan Feature and press OK.
4. Press the up/down arrow to highlight USB Feature and press OK.
5. Press the up/down arrow to highlight the setting you want and press OK.

You can set the following options:
•Scan Size: Sets the image size.
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The scan size options may vary between document feeder or 
scanner glass. 

•Original Type: Sets the original document’s type.
•Resolution: Sets the image resolution.
•Scan Color: Sets the color mode. If you select Mono in this option, 

you cannot select JPEG in Scan Format.
•Scan Format: Sets the file format in which the image is to be saved. 

When you select TIFF or PDF, you can select to scan multiple 
pages. If you select JPEG in this option, you cannot select Mono in 
Scan Color. 

6. Press the up/down arrow until the desired status is highlighted and press 
OK.

7. Repeat steps 5 and 6 to set other setting options.
8. When you have finished, press Stop/Clear to return to ready mode.
You can change the default scan settings. For details, see "Changing the 
default scan settings" on page 6.

Printing from a USB memory device
You can directly print files stored on a USB memory device. You can print 
TIFF, BMP, JPEG and PRN files.
If your USB memory device has certain features (example, security key, 
security partition, booting disk, password settings and so forth), do not use 
the USB memory device with your machine. The files stored in the USB 
memory device may be corrupted, or the machine may not automatically 
detect it. For details about these features, see device’s User’s Guide.
Direct Print option supported file types: 
• PRN: Only files created by provided driver with your machine are 

compatible. PRN files can be created by selecting the Print to file check 
box when you print a document. The document will be saved as a PRN 
file, rather than printed on paper. Only PRN files created in this fashion 
can be printed directly from USB memory device (See "Printing to a file 
(PRN)" on page 8).

 

If you print PRN files created from other machine, the printout 
would be different .

• BMP: BMP Uncompressed
• TIFF: TIFF 6.0 Baseline
• JPEG: JPEG Baseline
• PDF: PDF 1.4 and below
To print a document from a USB memory device:
1. Insert a USB memory device into the USB memory port on your 

machine. If one has already been inserted, press Direct USB.
2. Press the up/down arrow to highlight USB Print and press OK.

Your machine automatically detects the device and reads data stored on 
it.

3. Press the up/down arrow until the folder or file you want is highlighted 
and press OK.
If you see + in the front of a folder name, there are one or more files or 
folders in the selected folder. 

4. If you selected a file, skip to the next step. 
If you selected a folder, press the up/down arrow until the file you want is 
highlighted and press OK. 

5. Press the up/down arrow to select the number of copies to be printed or 
enter the number. 

6. Press OK or Start to start printing the selected file.
After printing the file, the display asks if you want to print another job.

7. To print another document, press the left/right arrow to highlight Yes and 
press OK. Repeat from step 3.
Otherwise, press the left/right arrow to highlight No and press OK. 

8. Press Stop/Clear to return to ready mode.

Backing up data
Data in the machine’s memory can be accidentally erased due to power 
failure or storage failure. Backup helps you protect your Address Book 
entries and the system settings by storing them as backup files on a USB 
memory device.

Backing up data
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight System Setup and press OK.
4. Press the up/down arrow to highlight Machine Setup and press OK.
5. Press the up/down arrow to highlight Export Setting and press OK.
6. Press the up/down arrow until the option you want is highlighted.

•Address Book: Backs up all Address Book entries.
•Setup Data: Backs up all system settings.

7. Press OK to begin backing up the data.
The data is backed up to the USB memory.

8. Press Stop/Clear to return to ready mode.

Restoring data
1. Insert a USB memory device on which the backup data is stored in to the 

USB memory port.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight System Setup and press OK.
4. Press the up/down arrow to highlight Machine Setup and press OK.
5. Press the up/down arrow to highlight Import Setting and press OK.
6. Press the up/down arrow until the data type you want is highlighted and 

press OK.
7. Press the up/down arrow until the file containing the data you want to 

restore highlights and press OK.
8. To restore the backup file to the machine, press the left/right arrow to 

highlight Yes and press OK.
9. Press Stop/Clear to return to ready mode.

Managing USB memory
You can delete image files stored on a USB memory device one by one or 
all at once by reformatting the device.

 

After deleting files or reformatting a USB memory device, files cannot 
be restored. Therefore, confirm that you no longer need the data 
before deleting it.

Deleting an image file
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Direct USB on the control panel.
3. Press the up/down arrow to highlight File Manage and press OK.
4. Press the up/down arrow to highlight Delete and press OK.
5. Press the up/down arrow until the folder or file you want is highlighted 

and press OK.



 

If you see + in the front of a folder name, there are one or more 
files or folders in the selected folder.

If you selected a file, the display shows the size of the file for about 2 
seconds. Go to the next step.
If you selected a folder, press the up/down arrow until the file you want 
to delete highlights and press OK.

6. To delete file, press the up/down arrow to highlight Yes and press OK.
7. Press Stop/Clear to return to ready mode.

Formatting a USB memory device
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Direct USB on the control panel.
3. Press the up/down arrow to highlight File Manage and press OK.
4. Press the up/down arrow to highlight Format and press OK.
5. To format USB memory device, Press the up/down arrow to highlight 

Yes and press OK.
6. Press Stop/Clear to return to ready mode.

Viewing the USB memory status
1. Insert a USB memory device into the USB memory port on your 

machine.
2. Press Direct USB on the control panel.
3. Press the up/down arrow to highlight Check Space and press OK.

The available memory space appears on the display.
4. Press Stop/Clear to return to ready mode.
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1.machine status and advanced feature
This chapter explains how to browse the current status of your machine, and the method of setting for the advanced 
machine setup. Read this chapter carefully in order to use your machine's diverse features.
This chapter includes:
• Fax setup
• Copy setup
• Scan setup
• Printing a report
• Clearing memory

• Network
• Document management
• Job management
• Menu overview

  

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

Fax setup
Changing the fax setup options
Your machine provides you with various user-selectable options for setting 
up the fax system. You can change the default settings for your preferences 
and needs.
To change the fax setup options:

1. Press  (Fax) on the control panel.

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Fax Setup and press OK.
4. Press the up/down arrow until the fax setup item you want is highlighted 

and press OK.
5. Press the up/down arrow until the option you want is highlighted and 

press OK.
6. Press the up/down arrow until the desired status appears or enter the 

value for the option you have selected, and press OK.
7. If necessary, repeat steps 4 through 6.
8. Press Stop/Clear to return to ready mode.

Sending

Option Description

Redial Times You can specify the number of redial attempts. If 
you enter 0, the machine will not redial.

Redial Term Your machine can automatically redial a remote 
fax machine if it was busy. You can set an 
interval between attempts.

Prefix Dial You can set a prefix of up to five digits. This 
number dials before any automatic dial number 
is started. It is useful for accessing a PABX 
exchange.

ECM Mode This mode helps with poor line quality and 
makes sure any faxes you send are sent 
smoothly to any other ECM-equipped fax 
machine. Sending a fax using ECM may take 
more time.

Send Report You can set your machine to print a confirmation 
report showing whether a transmission was 
successful, how many pages were sent, and 
more. The available options are On, Off, and 
On-Error, which prints only when a transmission 
is not successful.

Image TCR This function allows users to know what fax 
messages have been sent by showing sent 
messages in the transmission report. 
The first page of the message is turned into an 
image file than is printed on the transmission 
report so the users can see what messages 
have been sent.
However, you can not use this function when 
sending fax without saving the data in the 
memory.

Dial Mode This setting may not be available depending on 
your country. If you cannot reach this option, 
your machine does not support this feature.
You can set the dial mode for your machine to 
either tone dialing or pulse dialing. If you have a 
public telephone system or a private branch 
exchnage (PBX) system, you may need to select 
Pulse. Contact your local telephone company if 
you are not sure which dial mode to use.
If you select Pulse, some phone system 
features might not be available. It can also take 
longer to dial a fax or phone number.

Receiving

Option Description

Receive Mode You can select the default fax receiving mode. 
For details on receiving faxes in each mode, see 
"Changing the receive modes" on page 4.

Ring To Answer You can specify the number of times the 
machine rings before answering an incoming 
call.

Option Description
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Change default

Option Description

Resolution Changing the resolution setting affects the 
appearance of the received document.
• Standard: Originals with normal sized 

characters.
• Fine: Originals containing small characters 

or thin lines or originals printed using a 
dot-matrix printer.

• Super Fine: Originals containing extremely 
fine detail. Super Fine mode is enabled only 
if the machine with which you are 
communicating also supports the Super 
Fine resolution.

 

•For memory transmission, Super Fine 
mode is not available. The 
resolution setting is automatically 
changed to Fine.

•When your machine is set to Super 
Fine resolution and the fax 
machine with which you are 
communicating does not support 
Super Fine resolution, the machine 
transmits using the highest 
resolution mode supported by the 
other fax machine.

• Photo Fax: Originals containing shades of 
gray or photographs.

Darkness You can select the default contrast mode to fax 
your originals lighter or darker.

Scan Size Sets the image size.

 

The scan size options may vary between 
document feeder or scanner glass. 

Auto Report
You can set the machine to print a report with detailed information about the 
previous 50 communication operations, including time and dates.
For further details, see "Printing sent fax report automatically" on page 9.

Copy setup
Changing the copy setup options
For copy output, you can set up several options in advance.
1. Press (Copy) on the control panel. 

2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Copy Setup and press OK.

Stamp RCV Name This option allows the machine to automatically 
print the page number, and the date and time of 
reception at the bottom of each page of a 
received fax.

Rcv Start Code This code allows you to initiate fax reception 
from an extension phone plugged into the EXT 
socket on the back of the machine. If you pick up 
the extension phone and hear fax tones, enter 
the code. It is preset to *9* at the factory.

Auto Reduction When receiving a fax containing pages as long 
as or longer than the paper loaded in the paper 
tray, the machine can reduce the size of the 
original to fit the size of the paper loaded in the 
machine. 
Turn on this feature if you want to automatically 
reduce an incoming page.
With this feature set to Off, the machine cannot 
reduce the original to fit onto one page. The 
original will be divided and printed in actual size 
on two or more pages.

Discard Size When receiving a fax containing pages as long 
as or longer than the paper in your machine, you 
can set the machine to discard a specific length 
from the end of the received fax. The machine 
will print the received fax on one or more sheets 
of paper, minus the data that would have been 
on the specified discard segment. 
When the received fax contains pages larger 
than the paper in your machine, and Auto 
Reduction has been turned on, the machine will 
reduce the fax to fit on the existing paper, and 
nothing will be discarded.

Junk Fax Setup This setting may not be available depending on 
your country. Using this feature, the system will 
not accept faxes sent from remote stations 
whose numbers are stored in the memory as 
junk fax numbers. This feature is useful for 
blocking any unwanted faxes.
When you turn on this feature, you can access 
the following options to set junk fax numbers.
• Add: Allows you to set up to 10 fax 

numbers.
• Delete: Allows you to delete the desired 

junk fax number. If you select Delete All, 
Allows you to delete all junk fax numbers.

DRPD Mode This setting may not be available depending on 
your country. This mode enables a user to use a 
single telephone line to answer several different 
telephone numbers. In this menu, you can set 
the machine to recognize which ring patterns to 
answer. For details about this feature, see 
"Receiving faxes using DRPD mode" on page 5.

Duplex Print Set this duplex feature to save paper. When the 
machine prints the received fax data, it prints 
them on both sides of the paper. For details 
about this feature, see "Printing received faxes 
on both sides of the paper" on page 5.

Option Description

Doc Box Saving This menu only appears when an optional hard 
disk drive (HDD) has been installed. With this 
feature set to On, allows you to store received 
faxes in the common box. 

Option Description
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4. Press the up/down arrow until the copy setup item you want is 
highlighted and press OK.

5. Press the up/down arrow until the setup option you want is highlighted 
and press OK.

6. Press the up/down arrow until the setting you want is highlighted and 
press OK.

7. Repeat steps 4 through 6, as needed.
8. Press Stop/Clear to return to ready mode.

Change default

Option Description

Scan Size Sets the image size.

 

The scan size options may vary between 
document feeder or scanner glass. 

# of Copies You can enter the number of copies using the 
number keypad.

Collation Collation is a process of printing a multiple-copy 
job in sets.

Reduce/Enlarge Reduces or enlarges the size of a copied image.

Darkness Adjusts the brightness level to make a copy that 
is easier to read, when the original contains faint 
markings and dark images.

Original Type Improves the copy quality by selecting the 
document type for the current copy job.

Scan setup
Changing the scan setup options
To avoid having to customize the scan settings for each job, you can set up 
default scan settings for each scan type.

1. Press  (Scan/Email) on the control panel.
2. Press Menu on the control panel.
3. Press the up/down arrow to highlight Scan Setup and press OK.
4. Press OK when Change Default highlights .
5. Press the up/down until the scan type you want is highlighted and press 

OK.
6. Press the up/down until the scan setting option you want is highlighted 

and press OK.

 

Setting option is the same for each scan type.

7. Press the up/down arrow until the desired status is highlighted and press 
OK.

8. Repeat steps 6 and 7 to set other setting options.
9. When you have finished, press Stop/Clear to return to ready mode.

Option Description

Scan Size Sets the image size.

 

The scan size options may vary between 
document feeder or scanner glass. 

Original Type Sets the original document’s type.

Resolution Sets the image resolution.

Scan Color Sets the color mode.

Scan Format Sets the file format in which the image is to be 
saved. If you select BMP, JPEG, TIFF, or PDF, 
you can select to scan multiple pages. 

 

Depending on the selected scan type, this 
option may not appear.

Printing a report
You can print a report on the machine's configuration or font list, etc.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Report and press OK.
4. Press the up/down arrow until the report or list you want to print 

highlights and press OK.
To print all reports and lists, select All Reports.

5. Press OK when Yes appears to confirm printing.
The selected information prints out.

Option Description

Configuration This list shows the status of the user-selectable 
options. You may print this list to confirm your 
changes after changing settings.

Supplies Info. This item allows you to check how many pages 
are printed and how much toner are left in the 
cartridge.

Address Book This list shows all of the email addresses 
currently stored in the machine’s memory.

Send Report This report shows the fax number, the number of 
pages, the elapsed time of the job, the 
communication mode, and the communication 
results for a particular fax job.
You can set up your machine to automatically 
print a transmission confirmation report after 
each fax job (See "Sending" on page 1).

Sent Report This report shows information on the faxes and 
emails you have recently sent.
You can set the machine to automatically print 
this report every 50 communications (See 
"Sending" on page 1).

Fax Rcv Report This report shows information on the faxes you 
have recently received. 

Scheduled Jobs This list shows the documents currently stored 
for delayed faxes along with the starting time 
and type of each operation. 

JunkFax Report This list shows the fax numbers specified as junk 
fax numbers. To add or delete numbers to or 
from this list, access the Junk Fax Setup menu 
(See "Receiving" on page 1).

Network Info. This list shows information on your machine’s 
network connection and configuration.

Option Description
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You can also print the machine's status information and browse status 
with SyncThru™ Web Service. Open the Web browser on your 
networked computer and type the IP address of your machine. When 
SyncThru™ Web Service opens, click Information > Print 
information.

Clearing memory
You can selectively clear information stored in your machine’s memory.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Clear Setting and press OK.
4. Press the up/down arrow until the item you want to clear highlights and 

press OK.
5. Press OK when Yes highlights to confirm clearing.
6. Repeat steps 4 through 5 to clear another item.
7. Press Stop/Clear to return to ready mode.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine.

Option Description

All Settings Clears all of the data stored in memory and 
resets all of your settings to the factory default.

Fax Setup Restores all of the fax options to the factory 
default.

Copy Setup Restores all of the copy options to the factory 
default.

Scan Setup Restores all of the scan options to the factory 
default.

System Setup Restores all of the system options to the factory 
default.

Network Setup Restores all of the network options to the factory 
default.

Address Book Clears all of the email address entries stored in 
memory.

Sent Report Clears all records of sent faxes and emails. 

Fax Rcv Report Clears all records of received faxes.

Network
You may set up the network with the machine's display screen. Before doing 
that, you must have the relevant information concerning the type of network 
protocols and computer system you use. If you are not sure which setting to 
use, contact your network administrator to configure this machine to the 
network.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Network and press OK.
3. Press the up/down arrow until the setup option you want is highlighted 

and press OK.
4. Press the up/down arrow until the setting you want is highlighted and 

press OK.
5. Repeat steps 3 through 4, as needed.
6. Press Stop/Clear to return to ready mode.

Option Description

TCP/IP (IPv4) Select appropriate protocol and configure 
parameters to use the network environment.TCP/IP (IPv6)

Ethernet Speed Configure the network transmission speed.

Wirelessa

a.This menu only appears when an optional wireless network interface 
has been installed.

Configure the wireless network environments.

Clear Setting Reverts the network settings to the default 
values.

Network Info. This list shows information on your machine’s 
network connection and configuration.

Document management
This menu only appears when an optional hard disk drive (HDD) has been 
installed.
This menu allows you to store the scanned documents in a box, set various 
options for stored documents and change the default settings for stored 
documents. 

 

•To use this menu, you need to create a box first. Creating and editing 
the box can only be done through SyncThru™ Web Service (See 
"Box tab" on page 1).

User Auth List This list shows authorized users who are 
allowed to use the email function.

PCL Font List You can print the PCL font list.

PS3 Font List You can print the PS3 font list.

Accounting Report This is used only when network authentication in 
enabled with SyncThru™ Web Service. Prints 
the report of printing out count for each login 
user. 

Stored Joba This list shows the current status of stored job 
on hard disk drive (HDD).

Completed Joba The Completed Job page shows the list of 
completed print jobs. The list contains up to 50 
files from the latest print jobs.

Net Auth Log This is shows users and their IDs who logged in 
the domain.

Counter info. You can view the amount of each category that 
your machine has printed so far.

Fax Options You can set to print the information of a fax 
reports.

a.This menu only appears when an optional hard disk drive (HDD) has 
been installed.

Option Description Option Description
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•Common Box is provided by default.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight Document Box and press OK.
3. Press the up/down arrow until the setup option you want is highlighted 

and press OK.

Option Description

Doc Box Feature • Add From Scan: You can store scanned 
documents in a box. The stored file will be 
named automatically as 
"yearmonthdayhourminutesecond". 

• Task From Box: You can print a document 
from a box. 

Doc Box Setup • Add From Scan: You can set the default 
options for storing the document to a box. 

• Task From Box: You can set the default 
options for printing the document from a box. 

Doc Box Report You can print a report about documents stored 
in a box. 

 

For the document stored in the Secure Box, you can set the 
password for accessing the document.

Job management
This menu item is avaidlable when the optional hard disk or memory is 
installed
(See "Printing with the optional hard disk" on page 8 or "Printing with the 
optional memory (CLX-6250 Series only)" on page 5).

Menu overview
The control panel provides access to various menus to set up the machine 
or use the machine’s functions. These menus can be accessed by pressing 
Menu.

 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine. 

Items Option

Fax Feature Darkness
Resolution
Scan Size
Multi Send
Delay Send
Priority Send
Forward
Secure Receive
Add Page
Cancel Job

Fax Setup Sending
Redial Times
Redial Term
Prefix Dial
ECM Mode
Send Report
Image TCR
Dial Modea

Receiving
Receive Mode
Ring To Answer
Stamp RCV Name
Rcv Start Code
Auto Reduction
Discard Size
Junk Fax Setup
DRPD Modea

Duplex Print
Doc Box Savingb

Change Default
Resolution
Darkness
Scan Size

Auto Report

Copy Feature Scan Size
Reduce/Enlarge
Darkness
Original Type
Layout
Adjust Bkgd
Margin Shift
Edge Erase
Gray Enhance
WaterMark
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Copy Setup Change Default
Scan Size
# of Copies
Collation
Reduce/Enlarge
Darkness
Original Type

Scan Feature USB Feature
Scan Size
Original Type
Resolution
Scan Color
Scan Format

Email Feature
Scan Size
Original Type
Resolution
Scan Color

FTP Feature
Scan Size
Original Type
Resolution
Scan Color

SMB Feature
Scan Size
Original Type
Resolution
Scan Color

Scan Setup Change Default
USB Feature

Scan Size
Original Type
Resolution
Scan Color
Scan Format

Email Feature
Scan Size
Original Type
Resolution
Scan Color
Scan Format

FTP Feature
Scan Size
Original Type
Resolution
Scan Color
Scan Format

SMB Feature
Scan Size
Original Type
Resolution
Scan Color
Scan Format

Send Report

Items Option

System Setup Machine Setup
Machine ID
Machine Fax No.
Date & Time
Clock Mode
Form Menub

Select Formb

Language
Default Mode
Power Save
Timeout
Job Timeout
Altitude Adjust
Auto Continue
Paper Substitution
Net Accounting
Import Setting
Export Setting
Color Report

Paper Setup
Paper Size
Paper Type
Paper Source
Wide A4

Sound/Volume
Key Sound
Alarm Sound
Speaker
Ringer

Report
All Reports
Configuration
Supplies Info.
Address Book
Send Report
Sent Report
Fax Rcv Report
Scheduled Jobs
JunkFax Report
Network Info.
User Auth List
PCL Font List
PS Font List
Accounting Report
Stored Jobb

Completed Jobb

Net Auth Log
Counter info.
Fax Options

Maintenance
CLR Empty Msgc

Supplies Life
Color
Serial Number
Toner Low Alert

Items Option
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System Setup Clear Setting
All Settings
Fax Setup
Copy Setup
Scan Setup
System Setup
Network Setup
Address Book
Sent Report
Fax Rcv Report

Job Managementb

Active Job
Stored Job
File Policy

Image Overwriteb

Immediate
On Demand

Network TCP/IP (IPv4)
DHCP
BOOTP
Static

IP Address
Primary DNS
Secondary DNS

TCP/IP (IPv6)
IPv6 Activate
DHCPv6 Config

Ethernet Speed
Auto
10M Half
10M Full
100M Half
100M Full

Wirelessd

WLAN Settings
Wizard
Custom

WLAN Default
WLAN Signal

Clear Setting
Network Info.

Document Boxb Doc Box Feature
Task From Box
Add From Scan

Doc Box Setup
Task From Box
Add From Scan

Doc Box Report

a.This setting may not be available depending on your country.
b.This menu only appears when an optional hard disk drive (HDD) has 

been installed.
c. This menu only appears when the toner cartridge has almost reached 

its estimated cartridge life.

Items Option d.This menu only appears when an optional wireless network interface 
has been installed.
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1.management tools
This chapter introduces management tools provided to help you make full use of your machine. 
This chapter includes:
• Introducing useful management tools
• Using SyncThru™ Web Service
• Using the Smart Panel program

• Smarthru Office
• Using the Unified Linux Driver Configurator

  

Introducing useful management tools
The programs below help you to use your machine conveniently.
• "Using SyncThru™ Web Service" on page 1.
• "Using the Smart Panel program" on page 2.
• "Smarthru Office" on page 3.
• "Using the Unified Linux Driver Configurator" on page 4.

Using SyncThru™ Web Service

 

Internet Explorer 6.0 or higher is the minimum requirement for 
SyncThru™ Web Service.

If you have connected your machine to a network and set up TCP/IP 
network parameters correctly, you can manage the machine via SyncThru™ 
Web Service, an embedded web server. Use SyncThru™ Web Service to:
• View the machine’s device information and check its current status.
• Change TCP/IP parameters and set up other network parameters.
• Change printer preference.
• Set the email notifications advising of the machine’s status.
• Get support for using the machine.

To access SyncThru™ Web Service:
1. Access a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.

Logging into SyncThru™ Web Service
Before configuring options in SyncThru™ Web Service, you need to 
log-in as an administrator. You can still use SyncThru™ Web Service 
without logging in but you won’t have access to Settings tab and 
Security tab. 
1.Click Login on the upper right of the SyncThru™ Web Service 

website.
A log-in page appears. 

2.Type in the ID and Password then click Login .
If it’s your first time logging into SyncThru™ Web Service, type in the 
below default ID and password.
•ID: admin 
•Password: sec00000 

SyncThru™ Web Service overview

 

Some tabs may not appear depending on your model.

Information tab
This tab gives you general information about your machine. You can 
check things, such as the machine’s IP address, remaining amount of 
toner, ethernet information, firmware version and more. You can also 
print reports such as an error report and so on. 
•Active Alerts: This item allows you to check the alerts occurred in the 

machine and their severity.
•Supplies: This item allows you to check how many pages are printed 

and amount of toner left in the cartridge.
•Usage Counters: This item allows you to check the usage count by 

print types:simplex, duplex.

•Current Settings: This item allows you to check the machine and 
network information. 

•Print information: This item allows you to print reports such as 
system related reports, e mail address and font reports.

Box tab
This tab only appears when an optional hard disk drive (HDD) is 
installed.
You can save PC-printed, faxed, scanned or copied documents in the 
User Box or System Box and print the saved documents. 

 

When saving the document using the Add from Scan menu in the 
control panel, you can choose the box to save the scanned 
document from the below.
•Common Box: This box is provided by default. Received faxes 

are stored in this box. Allows you to store received faxes if Doc 
Box Saving menu in the control panel is On. You cannot 
delete this box. 

•Public Box: This box can be created by a user. 
•Secure Box: This box is created by a user. You can set the 

password for accessing this box. 
•User Box: Only received fax and scanned documents will be saved in 

this box. Types of boxes provided may differ depending on the 
model you are using. 

•System Box: You can save the documents from the system. 
-Secured Received Fax: Allows you to store received faxes if 

Secure Receive menu in the control panel is On.

-Stored Print: Allows you to print documents which you have saved 
as Store, Proof or Print Schedule in the printer driver’s Job 
Setting option. 

-Secured Print: Allows you to print documents which you have 
saved as Confidential in the printer driver’s Job Setting option. 



Address Book tab
You can store contact information such as name, speed no, e-mail 
address and so on. For grouping individual addresses, Fax Group entry 
and E-mail Group entry are ready.
•Individual: You can create an individual address book. Click the Add 

button. 
•Fax Groups: You can create fax group address books. You can add 

users by clicking the Add button or by dragging the user from 
Individual group to Fax Groups. 

•E-mail Groups: You can create e-mail group address books. You can 
add users by clicking the Add button or by dragging the user from 
Individual group to E-mail Groups. 

Setting tab
This tab allows you to set configurations provided by your machine and 
network. You need to log-in as an administrator to view this tab. 
•Machine Settings tab: This tab allows you to set options provided by 

your machine. 
-System: You can set settings related to your machine.
-Printer: You can set settings related to printing jobs. 
-Copy: You can set settings related to copying jobs. 
-Fax: You can set settings related to faxing jobs. 
-Scan: You can set settings related to scanning jobs. 
-E-mail Notification: You can set e-mail notification feature and 

e-mail address of recipients who will receive the notification.
•Network Settings tab: This tab allows you to view and change the 

network environment. You can set things, such as TCP/IP, network 
protocols and so on. 
-SNMP: You can exchange of management information between 

network devices using SNMP.

-Outgoing Mail Server(SMTP): You can set the outgoing E-mail 
server.

-Restore Default: You can restore default network settings.

Security tab
This tab allows you to set system and network security information. You 
need to log-in as an administrator to view this tab.
•System Security: You can set the system administrator’s information 

and also enable or disable machine features.

•Network Security: You can set settings for HTTPs, IPSec, IPv4/IPv6 
filtering, 802.1x, Authentication servers.

•User Access Control: You can set configurations for user 
accessibility.

Maintenance tab
This tab allows you to maintain your machine by upgrading firmwares 
and setting contact information for sending emails. You can also connect 
to Samsung website or download drivers by selecting the Link menu.
•Firmware Update: You can upgrade your machine’s firmware.
•Contact Information: You can view the contact information.
•Link: You can view the links to useful sites where you can download 

orcheck information. 

E-mail notification setup
You can receive emails about your machine’s status by setting this option. 
By setting information such as IP address, host name, e-mail address and 
SMTP server information, the machine status (toner cartridge shortage or 
machine error) will be sent to a certain person's e-mail automatically. This 
option may be used more frequently by a machine administrator. 
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Settings tab, select Machine Settings > E-mail Notification. 

 

If you haven’t configured outgoing server environment, go to 
Settings > Network Settings > Outgoing Mail Server(SMTP) to 
configure network environment before setting e-mail notification. 

4. Click Add button to add e-mail notification user. 
Set the recipient name and e-mail address(es) with notification items 
you want to receive an alert for.

5. Click Apply. 

 

If the firewall is activated, the e-mail may not be sent successfully. In 
that case, contact the a network administrator.

Setting the system administrator information
Set the the system administrator information. This setting is necessary for 
using the e-mail notification option.
1. Start a web browser, such as Internet Explorer, from Windows.

Enter the machine IP address (http://xxx.xxx.xxx.xxx) in the address 
field and press the Enter key or click Go.

2. Your machine’s embedded website opens.
3. From the Security tab, select System Security > System 

Administrator
4. Enter the name of the administrator, phone number, location and E-mail 

address. 
5. Click Apply. 

Using the Smart Panel program
Smart Panel is a program that monitors and informs you of the machine 
status, and allows you to customize the machine’s settings. For Windows 
and Macintosh, Smart Panel is installed automatically when you install the 
machine software. For Linux, you can download Smart Panel from 
Samsung website and install (See "Installing the SmartPanel" on page 5).

 

To use this program, you need the following system requirements:
•Windows. Check for windows operating system(s) compatible with 

your machine (See "System requirements" on page 2).
•Mac OS X 10.3 or higher.
•Linux. Check for Linux systems that are compatible with your 

machine (See "System requirements" on page 2).
•Internet Explorer version 5.0 or higher for flash animation in HTML 

Help.

Understanding Smart Panel
If an error occurs while printing, you can check the error from the Smart 
Panel.
You can also launch Smart Panel manually. Double-click the Smart Panel 
icon on the Windows task bar (in Windows), or Notification Area (in Linux). 
You can also click it on the status bar (in Mac OS X).
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Windows Double-click this icon in Windows.

Macintosh Click this icon in Mac OS X.

Linux Click this icon in Linux.

Or, if you are a Windows user, you can launch it from the Start menu, select 
Programs or All Programs > Samsung Printers > your machine name > 
Smart Panel.

 

•If you have already installed more than one Samsung machine, first 
select the correct machine model you want in order to access the 
corresponding Smart Panel.
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart 
Panel icon and select your machine.

•The Smart Panel window and its contents shown in this user’s guide 
may differ depending on the machine or operating system in use.

The Smart Panel program displays the current status of the machine, the 
estimated level of toner remaining in the toner cartridge(s), and various 
other types of information. You can also change settings.

 

1

Toner Level View the level of toner remaining in the toner 
cartridge(s). The machine and the number of toner 
cartridge(s) shown in the above window may differ 
depending on the machine in use. Some machines 
do not have this feature.

 

2 Buy Now Order replacement toner cartridge(s) online.

 

3

User’s Guide View User’s Guide.

 

This button changes to Troubleshooting 
Guide when error occurs. You can directly 
open troubleshooting section in the user’s 
guide. 

 

4

Printer 
Setting

Configure various machine settings in the Printer 
Settings Utility window. Some machines do not 
have this feature.

 

If you connect your machine to a network, 
the SyncThru™ Web Service window 
appears instead of the Printer Settings Utility 
window.

 

5

Driver Setting Set all of the machine options you need in the 
Printing Preferences window. This feature is 
available only for Windows (See "Opening printing 
preferences" on page 2).

Changing the Smart Panel Program Settings
Right-click (in Windows or Linux) or click (in Mac OS X) the Smart Panel 
icon and select Options. Select the settings you want from the Options 
window. 

Smarthru Office
The supplied software CD provides you with SmarThru Office. SmarThru 
Office offers you convenient features to use with your machine. 

Starting SmarThru Office
Follow the steps below to start SmarThru Office:
1. Make sure that your machine and computer are turned on and properly 

connected to each other.
2. Once you have installed SmarThru Office, you will see the SmarThru 

Office icon on your desktop.
3. Double-click the SmarThru Office icon.

 

This menu displays direct buttons for some features. The direct 
buttons include: Categories, Binder, Life Cycle, Scan and OCR, 
Fix and Enhance and Samsung Website. You can disable this 
menu by checking “Do not show this diaglog again”.

4. The SmarThru Office appears.
For more information about SmarThru Office, click Help > SmarThru 
Office help. The SmarThru Office Help window appears; you can view 
on screen help supplied on the SmarThru program.

 
Click the SmarThru icon  in the tray area of the Windows taskbar 
to activate the SmarThru Office launcher.

 

Follow the steps below to uninstall SmarThru Office.  
Before you begin the uninstall, ensure that all applications are closed 
on your computer. 
a)From the Start menu, select Programs or All Programs.
b)Select SmarThru Office, and then select Uninstall SmarThru 

Office.
c)When your computer asks you to confirm your selection, read the 

statement and click OK. 
d)Click Finish.

Using SmarThru Office
Scanning
1.Click the SmarThru icon  in the tray area of the windows taskbar to 

activate the SmarThru Office launcher.

2.Click the scanning icon  to open the scanning window.
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3.Scan Setting window opens.

 

1
Select 
Scanner

Allows you to select between the Local or Network 
scanner. 

 

2
Select 
Profile

Allows you to save settings frequently used for 
future use. Click New Profile to save the setting. 

 

3
Scan 
Settings

Allows you to customize settings for Scan Size 
and Paper Source.

 

4
Scan To Allows you to customize settings for File Name 

and location to send scanned data.

 

Click Advanced button to set more scan options.

4.Set scan settings and click Scan. 

Printing
1.Click the SmarThru icon  in the tray area of the Windows taskbar to 

active the SmarThru Office launcher.

2.Click the printing icon  to open the printing window.
3.Select the file you want to print.
4.Select the machine you want to use for printing.
5.Click Print to start the job.

Sending a file via fax
You can fax while working on SmarThru Office.

1.Click the SmarThru icon  in the tray area of the Windows taskbar to 
active the SmarThru Office launcher.

2.Click the faxing icon  to open the faxing window.
3.Set fax settings and click Send Fax.

•Select Fax Machine: Choose whether the machine is connected 
locally or via network. If the machine is in network, click Browse 
to insert the IP address and other information.

•Pages Ready: Select file you want to fax. Click Add.
•Recipients: Click Add to enter the fax number.
•Cover page: If you need a cover page, enter the values for the 

options. If not, click Skip Cover Page.
•Fax Settings: If the original document is faded or not vivid, click 

Fine. In this case, the fax speed could be low.

Sending a file to FTP
You can upload files to an FTP server while working on SmarThru 
Office. 
1.Double-click the SmarThru Office icon on your desktop.
2.Select the file to send to FTP.
3.Select File > Send to > Send By FTP.
4.Send By FTP window opens. 
5.Add your file and click Upload.

Email
You can send email while working on SmarThru Office. 

 

You need an email client program, such as Outlook Express, to 
send email in SmarThru Office. Procedure for sending email may 
differ depending on email client program you are using.

1.Double-click the SmarThru Office icon on your desktop.
2.Select the file to send to Email.
3.Select File > Send to> Send By E-mail.
4.An email client opens. 
5.Type in necessary information and send your email.

Using the Unified Linux Driver Configurator
Unified Driver Configurator is a tool primarily intended for configuring 
machine devices. You need to install Unified Linux Driver to use Unified 
Driver Configurator (See "Installing the Linux Unified Driver" on page 5).
After the driver is installed on your Linux system, the Unified Driver 
Configurator icon will automatically be created on your desktop.

Opening the Unified Driver Configurator
1. Double-click the Unified Driver Configurator on the desktop.

You can also click the Startup Menu icon and select Samsung Unified 
Driver > Unified Driver Configurator.

2. Click each button on the left to switch to the corresponding configuration 
window.

1 Printers 
Configuration 

2 Scanners 
Configuration 

3 Ports 
Configuration 

 

 To use the on screen help, click Help.

3. After changing the configurations, click Exit to close the Unified Driver 
Configurator.
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Printers configuration
Printers configuration has the two tabs: Printers and Classes.

Printers tab
View the current system’s printer configuration by clicking on the 
machine icon button on the left side of the Unified Driver Configurator 
window.

 

1 Switches to Printers configuration.
 

2 Shows all of the installed machine.
 

3 Shows the status, model name and URI of your machine.

The printer control buttons are, as follows:
•Refresh: Renews the available machines list.
•Add Printer: Allows you to add a new machines.
•Remove Printer: Removes the selected machine.
•Set as Default: Sets the current selected machine as a default 

machine.
•Stop/Start: Stops/starts the machine.
•Test: Allows you to print a test page to ensure the machine is working 

properly.
•Properties: Allows you to view and change the printer properties. 

Classes tab
The Classes tab shows a list of available machine classes.

 

1 Shows all of the machine classes.
 

2
Shows the status of the class and the number of machines in the 
class.

•Refresh: Renews the classes list.
•Add Class: Allows you to add a new machine class.
•Remove Class: Removes the selected machine class.

Scanners configuration
In this window, you can monitor the activity of scanner devices, view a list of 
installed Samsung machine devices, change device properties and scan 
images.

 

1 Switches to Scanners configuration.
 

2 Shows all of the installed scanners.
 

3 Shows the vendor, model name and type of your scanner. 
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• Properties: Allows you to change the scan properties and scan a 
document. 

Ports configuration
In this window, you can view the list of available ports, check the status of 
each port and release a port that is stalled in a busy state when its owner 
has terminated the job for any reason.

 

1 Switches to Ports configuration.
 

2 Shows all of the available ports.
 

3 Shows the port type, device connected to the port, and status.

• Refresh: Renews the available ports list.
• Release port: Releases the selected port.

Sharing Ports Between Printers and Scanners
Your machine may be connected to a host computer via a parallel port 
or USB port. Since the machine device contains more than one device 
(printer and scanner), it is necessary to organize proper access of 
“consumer” applications to these devices via the single I/O port.
The Unified Linux Driver package provides an appropriate port sharing 
mechanism that is used by Samsung printer and scanner drivers. The 
drivers talk to their devices via so-called machine ports. The current 
status of any machine port can be viewed via the Ports configuration. 
The port sharing prevents you from accessing one functional block of 
the machine device, while another block is in use.
When you install a new machine device onto your system, it is strongly 
recommended you do this with the assistance of an Unified Driver 
Configurator. In this case you will be asked to choose I/O port for the 
new device. This choice will provide the most suitable configuration for 
machine’s functionality. For machine scanners, I/O ports are being 
chosen by scanner drivers automatically, so proper settings are applied 
by default.
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1.maintenance
This chapter provides information for maintaining your machine and the toner cartridge.
This chapter includes:
• Printing a machine report
• Monitoring the supplies life
• Adjusting the color contrast
• Finding the serial number

• Using Toner Low Alert
• Cleaning a machine
• Storing the toner cartridge
• Tips for moving & storing your machine

  

Printing a machine report
You can print the machine's information and job report.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Report and press OK.
4. Press the up/down arrow until the report or list you want to print appears 

and press OK.
To print all reports and lists, select All Reports.

5. Press the left/right arrow to highlight Yes at the Printing? prompt and 
press OK.

 

You can use SyncThru™ Web Service to print the machine's 
configuration or browse the status. Open the web browser in the 
networked computer and type the machine's IP address. When 
SyncThru™ Web Service opens, click Information > Print 
Information Sheet.

Monitoring the supplies life
To view the supply life indicators, follow the steps below:
1. Press Menu on the control panel.
2. Press up/down arrow to highlight System Setup and press OK.
3. Press up/down arrow to highlight Maintenance and press OK.
4. Press up/down arrow to highlight Supplies Life and press OK.
5. The display shows options as you press up/down arrow.
6. When you select the option, press OK to browse the life.

Adjusting the color contrast
Color menu allows you to adjust the color setting.
1. Press Menu on the control panel.
2. Press up/down arrow to highlight System Setup and press OK.
3. Press up/down arrow to highlight Maintenance and press OK.
4. Press up/down arrow to highlight Color and press OK.
5. The display shows options as you press up/down arrow.

Option Description

Custom Color This menu allows you to adjust contrast, color by 
color.
• Default: Optimizes colors automatically. 
• Manual Adjust: Allows you to manually 

adjust the color contrast for each cartridge.
It is recommended to use the Default setting for 
best color quality.

Auto Color Reg. You can adjust the position of color texts or 
graphics to match the position of the printed 
colors to those on your screen.

 

If you have moved the machine, it is 
strongly recommended to operate this 
menu manually.

Density Controla

a.CLX-6250 Series only.

The machine automatically calibrates the toner 
density of machine for the best possible color 
print quality. 
If you select Off, the machine is calibrated by 
the factory default toner density.

Density Adjustmenta This item allows you to quickly adjust color 
density. You can easily adjust the color density 
and see the result right away but it’s not a 
permenant adjustment. Use this item to get a 
quick result.

Density Sensinga Automatically calculates the reduced or worn out 
supplies like toner or machine parts and uses 
this information to adjust the color density. For 
example, if the yellow toner is running out, the 
machine calculates the amount of remaining 
yellow toner and adjusts color density so the 
printouts are fine.

Density Calibrationa You can manually calibrate the toner density of 
machine for the best possible color print quality.

Finding the serial number
When you call for service or register as a user on the Samsung website, the 
machine’s serial number by taking the following steps:
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1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Maintenance and press OK.
4. Press the up/down arrow to highlight Serial Number and press OK.
5. Check your machine’s serial number.
6. Press Stop/Clear to return to ready mode.

Using Toner Low Alert
If toner in the cartridge has run out, a message informing user to change the 
toner cartridge appears. You can set the option for this message to appear 
or not. 
1. Press Menu on the control panel.
2. Press up/down arrow to highlight System Setup and press OK.
3. Press up/down arrow to highlight Maintenance and press OK.
4. Press up/down arrow to highlight Toner Low Alert and press OK.

Cleaning a machine
If printing quality problems occur or if you use your machine in a dusty 
environment, you need to clean your machine regularly to keep the best 
printing condition and use your machine longer.

 

•Cleaning the cabinet of the machine with cleaning materials 
containing large amounts of alcohol, solvent, or other strong 
substances can discolor or distort the cabinet. 

•If your machine or the surrounding area is contaminated with toner, 
we recommend you use cloth or tissue dampened with water to 
clean it. If you use a vacuum cleaner, toner blows in the air and 
might be harmful to you.

Cleaning the outside
Clean the machine cabinet with a soft, lint-free cloth. Dampen the cloth 
slightly with water, but be careful not to let any water drip onto or into the 
machine.

Cleaning the inside
During the printing process, paper, toner and dust particles can accumulate 
inside the machine. This buildup can cause print quality problems, such as 
toner specks or smearing. Cleaning the inside of the machine clears and 
reduces these problems.
1. Turn the machine off and unplug the power cord. Wait for the machine to 

cool down.
2. Using the handle, completely open the front door.

3. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine do 
not touch surface of belt.

 

When you open the front door and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

4. Grasp the handles on the toner cartridge and pull the cartridge out.

 

If you open the front door, be careful not to touch the underneath 
the control panel (the lower part of the fuser unit). The temperature 
of the fuser unit might be extremely hot and could damage your 
skin. 
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5. With a dry, lint-free cloth, wipe away any dust and spilled toner from the 
toner cartridge area.

 

While cleaning the inside of the machine, be careful not to damage 
the transfer roller or any other inside parts. Do not use solvents 
such as benzene or thinner to clean. Printing quality problems can 
occur and cause damage to the machine.

6. Locate the long strip of glass (LSU) inside the machine and using a 
cotton swab, gently clean the 4 pieces of LSU glass.

7. Slide the toner cartridge back into the machine. 

8. Holding the handle on the paper transfer belt, align it with the slots on 
the inside of the front door.

9. Lower the paper transfer belt until it is parallel with the front door and 
firmly seated.

10. Close the front door. Ensure that the cover is securely closed. 

 

If the front door is not completely closed, the machine will not 
operate. 

11. Plug in the power cord and turn the machine on.

Cleaning the scan unit
Keeping the scan unit clean helps ensure the best possible copies. We 
suggest that you clean the scan unit at the start of each day and during the 
day, as needed.
1. Slightly dampen a soft, lint-free cloth or paper towel with water.
2. Open the scanner lid.
3. Wipe the surface of the scanner glass and the document feeder glass 

until it is clean and dry.
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1 Scanner lid
2 Scanner glass
3 Document feeder 

glass
4 White bar

4. Wipe the underside of the scanner lid and white sheet until it is clean 
and dry.

5. Close the scanner lid.

Storing the toner cartridge
Toner cartridges contain components that are sensitive to light, temperature 
and humidity. Samsung suggests users follow the recommendations below 
to ensure the optimum performance, highest quality and longest life from 
your new Samsung toner cartridges.
Store this cartridge in the same environment as the printer it will be used in; 
this should be in controlled office temperature and humidity conditions. The 
toner cartridge should remain in its original, unopened package until 
installation – If original packaging is not available, cover the top opening of 
the cartridge with paper and store in a dark cabinet.
Opening the cartridge package prior to use dramatically shortens its useful 
shelf and operating life. Do not store on the floor. If the toner cartridge is 
removed from the printer, always store the cartridge:
• Inside the protective bag from the original package. 
• Store lying flat (not standing on end) with the same side facing up as if 

they were installed in the machine.
• Do not store consumables in;

-Temperature greater than 40°C (104°F).
-Humidity range less than 20% nor not greater than 80%.
-An environment with extreme changes in humidity or temperature.
-Direct sunlight or room light.
-Dusty places.
-A car for a long period of time.
-An environment where corrosive gases are present.
-An environment with salty air.

Handling instructions
• Do not touch the surface of the photosensitive drum in the cartridge.
• Do not expose the cartridge to unnecessary vibrations or shock.
• Never manually rotate the drum, especially in the reverse direction; this 

can cause internal damage and toner spillage.

Use of non-Samsung and refilled toner cartridge
Samsung Electronics does not recommend or approve the use of 
non-Samsung brand toner cartridges in your printer including generic, store 
brand, refilled, or remanufactured toner cartridges.

 

Samsung’s printer warranty does not cover damage to the machine 
caused by the use of a refilled, remanufactured, or non-Samsung 
brand toner cartridge.

Estimated cartridge life
Estimated cartridge life (the life of the toner cartridge yield) depends on the 
amount of toner that print jobs require. The actual print-out number may 
vary depending on the print density of the pages you print on, operating 
environment, printing interval, media type, and/or media size. For example, 
if you print a lot of graphics, the consumption of the toner is high and you 
may need to change the cartridge more often.

Tips for moving & storing your machine
• When moving the machine, do not tilt or turn it upside down. Otherwise, 

the inside of the machine may be contaminated by toner, which can 
cause damage to the machine or bad print quality.

• When moving the machine, make sure at least two people are holding 
the machine securely. 

• When moving the machine or when machine is not in use for a long time, 
lock the scanner lock.
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1.troubleshooting
This chapter gives helpful information for what to do if you encounter an error.
This chapter includes:
• Redistributing toner
• Clearing original document jams
• Tips for avoiding paper jams

• Clearing paper jams
• Understanding display messages
• Solving other problems

  

Redistributing toner
When the toner cartridge is near the end of its life:
• White streaks or light printing occurs. 
• The toner-related message saying that the toner is low may appear on 

the display.
• The Status LED blinks red. 
If this happens, you can temporarily improve print quality by redistributing 
the remaining toner in the cartridge. In some cases, white streaks or light 
printing will still occur even after you have redistributed the toner.
1. Using the handle, completely open the front door.

2. Grasp the handles on the toner cartridge and pull the cartridge out.

 

If you open the front door, be careful not to touch the underneath 
the control panel (the lower part of the fuser unit). The temperature 
of the fuser unit might be extremely hot and could damage your 
skin. 

 

When you open the front door and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

3. Holding both handles on the toner cartridge, thoroughly rock it from side 
to side to redistribute the toner.

 

If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

4. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. 
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 
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place completely.

5. Close the front door. Ensure that the cover is securely closed. 

 

If the front door is not completely closed, the machine will not 
operate. 

Clearing original document jams
When an original jams while passing through the document feeder, a 
warning message appears on the display screen.

 

To avoid tearing the document, remove the jammed document slowly 
and gently.

 

To prevent document jams, use the scanner glass for thick, thin, or 
mixed paper-type originals.

Input misfeed
1. Remove any remaining pages from the document feeder.
2. Open the document feeder cover.

3. Gently remove the original jammed from the document feeder.

4. Close the document feeder cover. Reload the pages you removed, if 
any, in the document feeder.

Exit misfeed
1. Remove any remaining pages from the document feeder.
2. Remove the misfeed original, and remove the sheets from the document 

output tray by carefully pulling it to the right using both hands.

3. Load the removed pages back into the document feeder.

Roller misfeed
1. Open the scanner lid.
2. Remove the misfeed original, and remove the sheets from the feed area 

by carefully pulling it to the right using both hands.
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1 scanner lid

3. Close the scanner lid. Load the removed pages back into the document 
feeder.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, refer to the next guidelines. 
• Ensure that the adjustable guides are positioned correctly (See "Loading 

paper in the tray" on page 3).
Do not overload the tray. Ensure that the paper level is below the paper 
capacity mark on the inside of the tray.

• Do not remove paper from the tray while your machine is printing.
• Flex, fan and straighten paper before loading. 
• Do not use creased, damp, or highly curled paper.
• Do not mix paper types in a tray.
• Use only recommended print media (See "Setting the paper size and 

type" on page 7).
• Ensure that the recommended side of the print media is facing up in the 

tray, or facing down in the multi-purpose tray.

Clearing paper jams
When a paper jam occurs, a warning message appears on the display 
screen. 

 

To avoid tearing the paper, pull the jammed paper out slowly and 
gently. Follow the instructions in the following sections to clear the 
jam. 

In tray 1

 

Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically 
ejected from the machine.
If the paper does not exit, go to the next step.

2. Pull out tray 1 .

3. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

If the paper does not move when you pull, or if you do not see the paper 
in this area, check the fuser area around the toner cartridge (See "Inside 
the machine" on page 4).

4. Insert tray 1 back into the machine until it snaps into place. Printing 
automatically resumes.

In optional tray 2

 

Click this link to open an animation about clearing a jam.
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1. Pull out optional tray 2.
2. Remove the jammed paper by pulling in the direction shown. To avoid 

tearing the paper, pull it out gently and slowly.

If the paper does not move when you pull or if you do not see the paper 
in this area, stop and go to the next step.

3. Pull tray 1 half-way out.
4. If you see the jammed paper, remove the paper from the machine by 

gently pulling it straight out.
5. Insert the trays back into the machine. Printing automatically resumes.

In the multi-purpose tray

 

Click this link to open an animation about clearing a jam.

1. If the paper is not feeding properly, pull the paper out of the machine.

If you cannot find the jammed paper, or if there is any resistance 
removing the paper, stop pulling and go to step 2.

2. Close the multi-purpose tray.
3. Pull the tray out.

4. Open the inner cover while you are pushing the lever with two hands.

5. Pull the paper out gently.

6. Replace the tray.
7. Open and close the front door to resume printing.

 

If the front door is not completely closed, the machine will not 
operate.

Inside the machine

 

Click this link to open an animation about clearing a jam.

 

The fuser area is hot. Take care when removing paper from the 
machine.

1. Using the handle, completely open the front door.

 

Be careful not to scratch the surface of the paper transfer belt. 
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2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

3. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.

4. Holding the handle on the paper transfer belt, align it with the slots on 
the inside of the front door.

5. Lower the paper transfer belt until it is parallel with the front door and 
firmly seated.

6. Close the front door to resume printing.

 

If the front door is not completely closed, the machine will not 
operate. 

In exit area

 

Click this link to open an animation about clearing a jam.

1. Open and close the front door. The jammed paper is automatically 
ejected from the machine.
If you do not see the jammed paper, go to next step.

2. Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

../common/swf/jam_exitarea.htm


3. Open the scan unit.

 

When the scanner lid is open, the scan unit cannot be opened. Do 
not force the scan unit open, it can cause damage to the machine. 
Close the scanner lid before opening the scan unit.

4. Open the fuser cover.
5. Open the inner cover.

 

Do not touch the fuser inside the inner cover. It is hot and could 
cause burns! 

6. Pull up the paper jam lever in the direction of the arrow to separate the 
fuser rollers and carefully remove the jammed paper from the unit.

7. Press down the paper jam lever to reapply pressure to the rollers.
8. Close the inner cover.

 

Before closing the inner cover, the jam lever must be fastened first 
(step7). Otherwise, paper jam can occur. 

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

9. Open the inner cover of reverse unit and carefully remove the jammed 
paper out of the machine.

If there is any resistance removing the paper or difficulty picking up 
jammed paper, stop pulling and turn the release knob to the direction as 
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shown to remove the misfed paper.

10. Close the inner cover of the reverse unit.
11. Lowering down the scan unit gently and slowly until it is completely 

closed. Make sure that it is securely latched.
Be careful not to pinch your fingers!

 

If the scan unit is not completely closed, the machine will not 
operate.

If you do not see the jammed paper or if there is any resistance when 
you pull, stop and go to the next step.

12. Open the rear cover and carefully take the jammed paper out of the 
machine.

13. Close the rear cover.

In the duplex unit area 

 

Click this link to open an animation about clearing a jam.

1. Open the front door.

 

Be careful not to scratch the surface of the paper transfer belt. 

2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

3. Remove the jammed paper by pulling in the direction shown. To avoid 
tearing the paper, pull it out gently and slowly.
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4. Holding the handle on the paper transfer belt, align it with the slots on 
the inside of the front door.

5. Lower the paper transfer belt until it is parallel with the front door and 
firmly seated.

6. Close the front door to resume printing.

 

If the front door is not completely closed, the machine will not 
operate. 

Understanding display messages
Messages appear on the control panel display to indicate the machine’s 
status or errors. Some error messages are shown with graphics to aid you in 
troubleshooting.

Checking display messages
1. When errors occur, Check Error appears on the display and press OK. 
2. Check the display message to see what kind of error has occurred. 

If several messages appear, press the up/down arrow to highlight the 
message you want solve.

3. Press OK on the control panel.
Refer to the tables below to understand the messages’ and their 
meaning, and solve the problem, using the suggested solutions.

 

•If Check Error still appears, repeat above steps.
•If a message is not in the table, reboot the power and try the printing 

job again. If the problem persists, call for service.
•When you call for service, provide the service representative with the 

contents of display message and the serial number.
•Some messages may not appear in the display depending on options 

or models.
•[aaa] indicates the error code. When you contact the service center, 

this error code help to handle the problem.
•[ccc] indicates the part of the each toner cartridge.
•[xxx] indicates the media type.
•[zzz] indicates the paper size.
•[yyy] indicates the tray.

Message Meaning Suggested solutions
[ccc] toner cart. 
error
Error: [aaa]
Open/Close Door

The toner cartridge is 
wrong installed.

Open and close the 
front door; and check 
that the toner cartridge’s 
are installed correctly. If 
the problem persists, 
call for service.

Prepare new [ccc] 
toner
Prepare new [ccc] 
toner cartridge

Small amount of toner is 
left in the cartridge. The 
estimated cartridge life of 
toner is close.

Prepare a new cartridge 
for replacement. You 
may temporarily 
increase the printing 
quality by redistributing 
the toner (See 
"Redistributing toner" on 
page 1).
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Replace new [ccc] 
toner
Replace with new 
[ccc] toner cartridge

The indicated toner 
cartridge has almost 
reached its estimated 
cartridge life. The 
machine might stop 
printing. 

 

Estimated cartridge 
life means the 
expected or 
estimated toner 
cartridge life, which 
indicates the 
average capacity of 
print-outs and is 
designed pursuant 
to ISO/IEC 19798. 
The number of 
pages may be 
affected by the 
percentage of 
image area, 
operating 
environment, 
printing interval, 
media type and 
media size. Some 
amount of toner 
may remain in the 
cartridge even 
when red LED is 
turns on and the 
printer stops 
printing.

• You can choose Stop 
or Continue as 
shown on the control 
panel. If you select 
Stop, the printer 
stops printing and 
you cannot print any 
more without 
changing the 
cartridge. If you 
select Continue, the 
printer keeps printing 
but the printing 
quality cannot be 
guaranteed.
Replace the toner 
cartridge for the best 
print quality when this 
message appears. 
Using a cartridge 
beyond this stage 
can result in printing 
quality issues. (See 
"Replacing the toner 
cartridge" on page 2)

 

Samsung does 
not recommend 
using 
non-genuine 
Samsung toner 
cartridge such 
as refilled or 
remanufactured
. Samsung 
cannot 
guarantee 
non-genuine 
Samsung toner 
cartridge's 
quality. Service 
or repair 
required as a 
result of using 
non-genuine 
Samsung toner 
cartridges will 
not be covered 
under the 
machine 
warranty.

• If the machine stops 
printing, replace the 
toner cartridge (See 
"Replacing the toner 
cartridge" on page 2).

[ccc] toner Not 
Compatible
[ccc] toner cartridge 
is not compatible.
Check guide

The toner cartridge you 
have installed is not for 
your machine.

Install a 
Samsung-genuine toner 
cartridge, designed for 
your machine.

Message Meaning Suggested solutions
[ccc] toner Not 
Installed
[ccc] toner cartridge 
is not installed.
Install it

The toner cartridge is not 
installed or the CRUM 
(Consumer Replaceable 
Unit Monitor) in the 
cartridge is not properly 
connected.

Reinstall the toner 
cartridge two or three 
times. If the problem 
persists, the toner 
cartridge is not being 
detected. Call for 
service.

[ccc] Toner Not 
Installed
[ccc] Toner is not 
installed.
Remove seal tape & 
reinstall

The machine cannot 
detect a toner cartridge.

Remove the sealing 
tape from the toner 
cartridge.
Refer to Quick Install 
Guide.

Group
Not Available

You have tried to select a 
group location number 
where only a single 
location number can be 
used, such as when 
adding locations for a 
multiple send operation.

Use a speed dial 
number or dial number 
manually using the 
number keypad.

Data Read Fail
Check USB Memory

Time expired while 
reading date.

Try again.

Data Write Fail
Check USB Memory

Storing to the USB 
memory failed.

Check the available 
USB memory space.

Door is open.
Close it

The door is not securely 
latched.

Close the door until it 
locks into place.

Door is open or
Check Transfer belt

The front door is not 
securely latched.

Close the front door 
until it locks into place.

IP Conflict
This IP address 
conflicts with that 
of other system

The IP address is used 
elsewhere. 

Check the IP address or 
obtain a new IP 
address.

Connection Error Connection with the 
SMTP server failed.

Check the server 
settings and the 
network cable.

Enter Again You entered an 
unavailable item.

Enter the correct item 
again.

Fax memory is 
almost full

The fax memory is full. Delete unnecessary fax 
jobs and retransmit after 
more memory becomes 
available. Alternatively, 
split the transmission 
into more than one 
operation.

Fan error
Error: [aaa]
Turn off then on

There is a problem in the 
machine.

Turn the machine off 
and turn it on again. If 
the problem persists, 
call for service.

Fuser error
Error: [aaa]
Turn off then on

There is a problem in the 
machine.

Turn the machine off 
and turn it on again. If 
the problem persists, 
call for service.

Fuser unit Not 
Installed
Fuser unit is not 
installed.
Install it

The fuser unit is not 
installed.

Call for service.

Message Meaning Suggested solutions
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Paper Empty in 
[yyy]
Paper is empty 
in [yyy].
Load paper

There is no paper in the 
tray.

Load paper in the tray 
(See "Loading paper in 
the tray" on page 3).

Jam bottom of 
duplex

Paper has jammed 
during duplex printing.

Clear the jam (See "In 
the duplex unit area" on 
page 7).

Jam in exit area Paper has jammed in exit 
area.

Clear the jam (See "In 
exit area" on page 5).

Jam inside machine Paper has jammed 
inside the machine.

Clear the jam (See 
"Inside the machine" on 
page 4).

Jam inside of 
duplex

Paper has jammed 
during duplex printing.

Clear the jam (See "In 
the duplex unit area" on 
page 7).

Jam top of duplex Paper has jammed 
during duplex printing.

Clear the jam (See "In 
the duplex unit area" on 
page 7).

Junk Fax Error
Junk Fax Job 
Cancelled

The machine has 
received a fax from 
which is registered as a 
junk fax.

The received fax data 
will be deleted. 
Reconfirm junk fax 
setup (See "Receiving" 
on page 1).

Line Busy
The line is already 
engaged.
Try Again Later

The receiving fax 
machine did not answer 
or the line is already 
engaged.

Try again after a few 
minutes.

Line Error
The Fax Line has a 
problem.
Try Again Later

Your machine cannot 
connect with the 
receiving fax machine or 
has lost contact because 
of a problem with the 
phone line.

Try again. If the problem 
persists, wait an hour or 
so for the line to clear 
again. Or, turn the ECM 
mode on (See 
"Sending" on page 1.)

LSU error
Error: [aaa]
Turn off then on

There is a problem in the 
machine.

Turn the machine off 
and turn it on again. If 
the problem persists, 
call for service.

Memory Full
Cancel | Start

The memory is full. Press the left/right 
arrow to highlight 
Cancel or Start, then 
press OK. If you select 
Cancel , the machine 
stops the fax job. If you 
select Start, the 
machine only sends 
scanned documents of 
the fax job. 

Memory Full
Divide the job

The memory is full. Split the transmission 
into more than one 
operation.

Memory Full
Fax memory is full. 
Print or remove 
received fax job

The memory is full. Print or remove the 
received fax data in the 
memory.

Motor Error
Error: [aaa]
Turn off then on

There is a problem in the 
machine.

Turn the machine off 
and turn it on again. If 
the problem persists, 
call for service.

Message Meaning Suggested solutions
Network Error
There is a problem 
with the network.

There is a problem with 
the network.

Check the network. If 
the problem persists, 
ask the system 
administrator or the 
person who has set up 
your local network.

No Answer
The remote fax 
machine has not 
answered

The remote fax machine 
has not answered after 
several redial attempts.

Try again. Verify the 
number to ensure that a 
fax can be received.

Not proper room 
temperature. 
Change room 
temperature

The machine is in a room 
with improper room 
temperature.

Move the machine to a 
room with proper room 
temperature (See 
"Environmental 
specifications" on 
page 1).

No Such Job You are performing an 
Add Pages or Cancel 
Job operation, but there 
are no jobs waiting.

Check the display to 
see if there are any 
scheduled jobs. The 
display should indicate 
if any scheduled jobs 
are in Standby mode, 
for example, Delay Fax.

Network problem
Network cable is 
not connected.
Check it.

The machine is not 
connected with a 
network cable.

Connect the machine to 
the network with a 
network cable.

Network problem
Network card is 
not installed.
Check it.

There is a problem on 
the network interface.

Turn the power switch 
off and on. If the 
problem persists, call 
for service.

Original paper Jam
Original paper Jam 
inside of scanner.
Remove Jam

The load original has 
jammed in the document 
feeder.

Clear the jam (See 
"Clearing original 
document jams" on 
page 2).

Original paper Jam
Original paper is too 
long for scanner. 
Check size

The original is too long 
for scanner.

Check the originals
(See "Preparing 
originals" on page 1).

Output Bin Full
Output Bin Full
Remove printed 
paper

The document output 
tray is full.

The document output 
tray can hold up to 160 
sheets of plain paper. 
Once the paper is 
removed from the
document output tray, 
the printer resumes 
printing.

Paper Jam in MP Paper has jammed in the 
multi-purpose tray area.

Clear the jam (See "In 
the multi-purpose tray" 
on page 4).

Paper Jam in tray1 Paper has jammed in the 
tray1 area.

Clear the jam (See "In 
tray 1" on page 3).

Paper Jam in tray2 Paper has jammed in the 
tray2 area.

Clear the jam (See "In 
optional tray 2" on 
page 3).

Message Meaning Suggested solutions
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Paper Empty in 
[yyy]
Paper is empty in 
[yyy]
Load paper

There is no paper in
the tray.

Load paper in the tray 
(See "Loading paper in 
the tray" on page 3).

Paper Mismatch 
[yyy]
Load [zzz][xxx] 
Continue  Cancel 

The paper size
specified in the printer
properties does not
match the paper you
are loading.

You can select the 
option between 
Continue or Cancel. If 
you select Cancel , the 
printing job will stop. 
Load the correct paper 
in the tray. If you select 
Continue, printing job 
will continue.

BOOTP problem
BOOTP has a
problem. Switching 
to Auto IP

There is a problem with 
the network.

Check your network 
environment, or contact 
your network 
administrator.

DHCP problem
DHCP has a
problem. 
Reconfigure 
BOOTP/static IP

There is a problem with 
the network.

Check your network 
environment, or contact 
your network 
administrator.

DHCP problem
DHCP has a
problem. Switching 
to Auto IP

There is a problem with 
the network.

Check your network 
environment, or contact 
your network 
administrator.

BOOTP problem
BOOTP has a
problem. 
Reconfigure 
DHCP/static IP

There is a problem with 
the network.

Check your network 
environment, or contact 
your network 
administrator.

Replace [ccc] toner
Replace with new 
[ccc] Toner

The toner cartridge has 
reached the end of its 
lifespan.

Replace the toner 
cartridge with a 
Samsung-genuine toner 
cartridge (See 
"Replacing the toner 
cartridge" on page 2).

Replace Fuser unit
Replace with new 
fuser unit

The fuser unit has 
reached the end of its 
lifespan.

This message appears 
when the fuser unit is 
worn. Replace the fuser 
unit with a new one. Call 
for service.

Retry Redial? The machine is
waiting for a specified
time interval to redial
a previously busy
station.

You can press OK to
immediately redial, 
Stop/Clear to cancel 
the redial operation.

Scanner door Open
Door of scanner is 
open.
Close it

The scanner door is not 
securely latched.

Close the scanner door 
until it locks into place.

Scanner locked 
Scanner locking 
switch is locked. 
Release it

The scanner module is 
locked.

Unlock the CCD (See 
"Front view" on page 1). 
Or turn off the machine 
and on again. If the 
problem persists, call 
for service.

Message Meaning Suggested solutions
Self Diagnostics
Please Wait...

The engine in your 
printer is performing self 
diagnostics.

Please wait a few 
minutes.

Send Error
There is a problem 
in DNS

There is a problem in 
DNS.

Configure the DNS 
setting.

Send Error
There is a problem 
in POP3

There is a problem in 
POP3.

Configure the POP3 
setting.

Send Error
There is a problem 
in SMTP

There is a problem in 
SMTP.

Change to the available 
server.

Send Error
There is a problem 
in SMTP 
authentication

There is a problem in 
SMTP authentication.

Configure the 
authentication setting.

Send Error
There is a problem 
on the NIC Card

There is a problem on 
network interface card.

Turn the power switch 
off and on. If the 
problem persists, call 
for service.

Sensor Failure
[aaa]
Turn off then on

There is a problem in the 
sensor signal.

Turn the machine off 
and turn it on again. If 
the problem persists, 
call for service.

Mail Size Error
Mail exceeds than 
server support

The mail size is larger 
than the supported size 
by SMTP server.

Divide your mail or 
reduce the resolution.

System error
Error: [aaa]
Turn off then on

There is a problem in the 
machine.

Turn the machine off 
and turn it on again. If 
the problem persists, 
call for service.

Mail Size Error
One Page is
Too Large

Single page data 
exceeds the configured 
mail size.

Reduce the resolution 
and try again.

Too many Faxes
Too may faxes are 
received. Print or 
remove job

Too many faxes are 
received.

Print or remove 
received fax.

Too many Faxes
Too may faxes are 
queued. Wait or 
remove job

Too many faxes are 
queued to be sent.

Cancel reserved fax in 
priority fax feature.

TR belt Not installed
Transfer belt unit is 
not installed.
Install it

The transfer belt is not 
installed.

Install a 
Samsung-genuine 
transfer belt.

TR. belt Not 
compatible
Transfer belt unit is 
not compatible.
Check guide

The transfer belt of the 
machine is not for your 
machine.

Install the a 
Samsung-genuine part 
designed for your 
machine.

Transfer belt is low
Transfer belt unit 
will be worn.
Order new one

The life of the transfer 
belt will expired soon.

Order a transfer belt 
(See "Available 
accessories" on 
page 2).

Message Meaning Suggested solutions
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Solving other problems
The following chart lists some conditions that may occur and the 
recommended solutions. Follow the suggested solutions until the problem is 
corrected. If the problem persists, call for service.

Power problems

 

Click this link to open an animation about power problems.

Replace TR. Belt
Replace with new 
Transfer belt unit

The life of the transfer 
belt has expired.

Replace the transfer 
belt with a new one.
Install a 
Samsung-genuine 
transfer belt.

Tray[yyy] cassette 
Out
Tray[yyy] cassette 
is pulled out.
Insert it properly

The tray is not properly 
closed.

To close the tray, lower 
the rear edge, align it 
with the slot, and slide it 
into the printer.

Tray[yyy] has a 
problem
Communication 
problem occurred 
with tray[yyy]

The machine cannot 
communicate with the 
optional tray .

Reinstall the optional 
tray. If the problem 
persists, call for service. 

Tray[yyy] Not 
Installed
Tray[yyy] is not 
installed. Install it

The optional tray is not 
installed.

Reinstall the optional 
tray. If the problem 
persists, call for service. 

Tray2 has a problem
Communication 
problem occurred 
with Tray2

The machine cannot 
communicate with the 
optional tray 2.

Check the cable 
connecting the machine 
and the optional tray 2. 
If the problem persists, 
call for service.

Tray2 Not installed
Tray2 is not 
installed. Install it

The optional tray2 is not 
installed.

Install the optional tray 
2. If the optional tray 2 is 
installed, check the 
cable connecting the 
machine and the 
optional tray 2. If the 
problem persists, call 
for service. 

Updating Data
Please Wait...

• The machine is 
updating data.

• This message can 
also appear when 
printing on paper 
smaller than A4, such 
as envelope or B5. In 
this case, the machine 
is adjusting the 
settings for best print 
results. 

Wait a few minutes.

Message Meaning Suggested solutions
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Condition Suggested solutions

The machine is 
not receiving 
power; 
or the printer 
cable connection 
between the 
computer and the 
machine is not 
connected 
properly.

• Plug in the power cord and then press the power 
switch to turn the machine on. 

Or press  (power) on the control panel.

• Disconnect the machine printer cable and 
reconnect it.
-For Local USB

-For Network Printing 

Paper feeding problems
Condition Suggested solutions

Paper jams during 
printing.

Clear the paper jam (See "Clearing paper jams" 
on page 3).

Paper sticks 
together.

• Check the maximum paper capacity of the 
tray (See "Print media specifications" on 
page 3).

• Make sure that you are using the correct type 
of paper (See "Print media specifications" on 
page 3).

• Remove paper from the tray and flex or fan 
the paper.

• Humid conditions may cause some paper to 
stick together, install paper from a fresh ream.

Multiple sheets of 
paper do not feed.

Different types of paper may be stacked in the 
tray. Load paper of only one type, size, and 
weight.

Paper does not feed 
into the machine.

• Remove any obstructions from inside the 
machine.

• Paper has not been loaded correctly. Remove 
paper from the tray and reload it correctly.

• There is too much paper in the tray. Remove 
excess paper from the tray.

• The paper is too thick. Use only paper that 
meets the specifications required by the 
machine (See "Print media specifications" on 
page 3).

• If an original does not feed into the machine, 
the document feeder rubber pad may require 
to be replaced. Contact a service 
representative.

The paper keeps 
jamming.

• There is too much paper in the tray. Remove 
excess paper from the tray. If you are printing 
on special materials, use the multi-purpose 
tray.

• An incorrect type of paper is being used. Use 
only paper that meets the specifications 
required by the machine (See "Print media 
specifications" on page 3).

• There may be debris inside the machine. 
Open the front door and remove any debris.

• If an original does not feed into the machine, 
the document feeder rubber pad may need to 
be replaced. Contact a service representative.

Envelopes skew or 
fail to feed correctly.

Ensure that the paper guides are against both 
sides of the envelopes.
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Printing problems
Condition Possible cause Suggested solutions

The machine 
does not print.

The machine is not 
receiving power.

Check the power cord 
connections. Check both 
power switches and the 
power source.

The machine is not 
selected from the 
available printers 
list.

Select this printers “Name” 
from the available printers 
drop-down list in the 
application you are printing 
from

Check the machine for the following:
• The front door is not closed. Close the front 

door.
• Paper is jammed. Clear the paper jam (See 

"Clearing paper jams" on page 3).
• No paper is loaded. Load paper (See "Loading 

paper in the tray" on page 3).
• The toner cartridge is not installed. Install the 

toner cartridge.
If a system error occurs, contact your service 
representative.

The connection 
printer cable 
between the 
computer and the 
machine is not 
connected properly.

Disconnect the machine 
printer cable and reconnect 
it.

The connection 
printer cable 
between the 
computer and the 
machine is 
defective.

If possible, attach the printer 
cable to another computer 
that is working properly and 
print a job. You can also try 
using a different machine 
printer cable.

The port setting is 
incorrect.

Check the Windows printer 
settings to make sure that 
the print job is sent to the 
correct port. If the computer 
has more than one port, 
make sure that the machine 
is attached to the correct 
one.

The machine may 
be configured 
incorrectly. 

Check the Printing 
Preferences to ensure that 
all of the print settings are 
correct (See "Opening 
printing preferences" on 
page 2).

The printer driver 
may be incorrectly 
installed.

Repair the machine software 
(See "Installing USB 
connected machine’s driver" 
on page 3).

The machine is 
malfunctioning.

Check the display message 
on the control panel to see if 
the machine is indicating a 
system error. Contact a 
service representative.
Troubleshooting_ 14



The document size 
is so big that the 
hard disk space of 
the computer is 
insufficient to 
access the print job.

Make available more hard 
disk space and print the 
document again.

The machine 
selects print 
materials from 
the wrong paper 
source.

The paper option 
that was selected in 
the Printing 
Preferences may 
be incorrect.

For many software 
applications, the paper 
source selection is found 
under the Paper tab within 
the Printing Preferences. 
Select the correct paper 
source. See the printer 
driver help screen (See 
"Opening printing 
preferences" on page 2).

A print job is 
extremely slow.

The job may be 
very complex.

Reduce the complexity of 
the page or try adjusting the 
print quality settings.

Half the page is 
blank.

The page 
orientation setting 
may be incorrect.

Change the page orientation 
in your application. See the 
printer driver help screen.

The paper size and 
the paper size 
settings do not 
match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the 
tray.
Or, ensure that the paper 
size in the printer driver 
settings matches the paper 
selection in the software 
application settings you use.

Condition Possible cause Suggested solutions

The machine 
prints, but the 
text is wrong, 
garbled, or 
incomplete.

The machine cable 
is loose or 
defective.

Disconnect the machine 
printer cable and reconnect. 
Try a print job that you have 
already printed successfully. 
If possible, attach the printer 
cable and the machine to 
another computer that you 
know works ensure print 
driver is installed and try a 
print job. Finally, try a new 
machine printer cable.

The wrong printer 
driver was selected.

Check the application’s 
printer selection menu to 
ensure that your machine is 
selected.

The software 
application is 
malfunctioning.

Try printing a job from 
another application.

The operating 
system is 
malfunctioning.

Exit Windows and reboot the 
computer. Turn the machine 
off and back on again.

If you are in a DOS 
environment, the 
font setting for your 
machine may be 
set incorrectly.

Change the language 
setting (See "Changing the 
display language" on 
page 1).

Printer driver 
corrupted.

Reinstall printer drvier.

Pages print, but 
they are blank.

The toner cartridge 
is defective or out of 
toner.

Redistribute the toner, if 
necessary. 
If necessary, replace the 
toner cartridge.

The file may have 
blank pages.

Check the file to ensure that 
it does not contain blank 
pages.

Some parts, such 
as the controller or 
the board, may be 
defective.

Contact a service 
representative.

The machine 
does not print 
PDF files 
correctly. Some 
parts of graphics, 
text, or 
illustrations are 
missing.

Incompatibility 
between the PDF 
file and the Acrobat 
products.

Printing the PDF file as an 
image may enable the file to 
print. Turn on Print As 
Image from the Acrobat 
printing options. 

 

It will take longer to 
print when you print a 
PDF file as an image.

Condition Possible cause Suggested solutions
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Printing quality problems
If the inside of the machine is dirty or paper has been loaded improperly, 
there might be a reduction in print quality. See the table below to clear the 
problem. 

The print quality 
of photos is not 
good. Images are 
not clear.

The resolution of 
the photo is very 
low. 

Reduce the photo size. If 
you increase the photo size 
in the software application, 
the resolution will be 
reduced. 

Before printing, 
the machine 
emits vapor near 
the output tray.

Using damp paper 
can cause vapor 
during printing.

This is not a problem. Just 
keep printing.

The machine 
does not print 
special- sized 
paper, such as 
billing paper.

Paper size and 
paper size setting 
do not match.

Set the correct paper size in 
the Paper tab in the 
Printing Preferences (See 
"Opening printing 
preferences" on page 2).

Condition Suggested Solutions

Light or faded print • If a vertical white streak or faded area 
appears on the page, the toner supply is low. 
You may be able to temporarily extend the 
toner cartridge life (See"Redistributing toner" 
on page 1). If this does not improve the print 
quality, install a new toner cartridge.

• The paper may not meet paper specifications; 
for example, the paper may be too moist or 
rough (See "Print media specifications" on 
page 3).

• If the entire page is light, the print resolution 
setting is too low or the toner save mode is 
on. Adjust the print resolution and turn the 
toner save mode off. See the help screen of 
the printer driver.

• A combination of faded or smeared defects 
may indicate that the toner cartridge needs 
cleaning (See "Cleaning the inside" on 
page 2).

• The surface of the LSU part inside the 
machine may be dirty (See "Cleaning the 
inside" on page 2).

Toner specks • The paper may not meet specifications; for 
example, the paper may be too moist or rough 
(See "Print media specifications" on page 3).

• The transfer roller may be dirty. Clean the 
inside of your machine. Contact a service 
representative.

• The paper path may need cleaning. Contact a 
service representative.

Condition Possible cause Suggested solutions

Dropouts If faded areas, generally rounded, occur 
randomly on the page:
• A single sheet of paper may be defective. 

Try reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper (See "Print 
media specifications" on page 3).

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• Change the printer option and try again. Go 
to Printing Preferences, click Paper tab, 
and set type to Thick (See "Opening printing 
preferences" on page 2).

• If these steps do not correct the problem, 
contact a service representative.

White Spots If white spots appear on the page:
• The paper is too rough and a lot of dirt from a 

paper falls to the inner devices within the 
machine, so the transfer roller may be dirty. 
Clean the inside of your machine (See 
"Cleaning the inside" on page 2).

• The paper path may need cleaning (See 
"Cleaning the inside" on page 2).

Vertical lines If black vertical streaks appear on the page:
• The surface (drum part) of the toner 

cartridge inside the machine has probably 
been scratched. Remove the toner cartridge 
and install a new one (See "Replacing the 
toner cartridge" on page 2).

If white vertical streaks appear on the page:
• The surface of the LSU part inside the 

machine may be dirty (See "Cleaning the 
inside" on page 2).

If vertical streaks appear on the page:
• The surface of the scanner glass and its 

white sheet may be dirty. Clean these unit 
(See "Cleaning the scan unit" on page 3).

Color or Black 
background

If the amount of background shading becomes 
unacceptable:
• Change to a lighter weight paper (See "Print 

media specifications" on page 3).
• Check the environmental conditions: very 

dry conditions or a high level of humidity 
(higher than 80% RH) can increase the 
amount of background shading.

• Remove the old toner cartridge and, install a 
new one (See "Replacing the toner 
cartridge" on page 2). If this problem 
persists, contact a service representative.

Condition Suggested Solutions
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Toner smear If toner smears on the page: 
• Clean the inside of the machine (See 

"Cleaning the inside" on page 2).
• Check the paper type and quality (See "Print 

media specifications" on page 3).
• Remove the toner cartridge and then, install 

a new one (See "Replacing the toner 
cartridge" on page 2).

Vertical repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The toner cartridge may be damaged. If you 

still have the same problem, remove the 
toner cartridge and, install a new one (See 
"Replacing the toner cartridge" on page 2).

• Parts of the machine may have toner on 
them. If the defects occur on the back of the 
page, the problem will likely correct itself 
after a few more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Background 
scatter

A
Background scatter results from bits of toner 
randomly distributed on the printed page. 
• The paper may be too damp. Try printing 

with a fresh ream of paper. Do not open 
reams of paper until necessary so that the 
paper does not absorb too much moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can 
cause problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the 
print resolution through your software 
application or in Printing Preferences (See 
"Opening printing preferences" on page 2).

Misformed 
characters

• If characters are improperly formed and 
producing hollow images, the paper stock 
may be too slick. Try different paper (See 
"Print media specifications" on page 3).

• If characters are improperly formed and 
producing a wavy effect, the scanner unit may 
need service (See "Cleaning the scan unit" on 
page 3).

Condition Suggested Solutions

Page skew

A a B b CA a B b CA a B b CA a B b C cA a B b C c

• Ensure that the paper is loaded properly.
• Check the paper type and quality (See "Print 

media specifications" on page 3).
• Ensure that the guides are not too tight or too 

loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl (See "Print media specifications" on 
page 3).

• Turn the stack of paper over in the tray. Also 
try rotating the paper 180° in the tray.

Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality (See "Print 

media specifications" on page 3).
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray.

Back of printouts 
are dirty

Check for leaking toner. Clean the inside of the 
machine (See "Cleaning the inside" on page 2).

Solid Color or 
Black pages

A
• The toner cartridge may not be installed 

properly. Remove the cartridge and reinsert it.
• The toner cartridge may be defective. 

Remove the toner cartridge and install a new 
one (See "Replacing the toner cartridge" on 
page 2).

• The machine may require repair. Contact a 
service representative.

Condition Suggested Solutions
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Copying problems
Condition Suggested solution

Copies are too light 
or too dark

Use Darkness in Copy feature to lighten or 
darken the backgrounds of copies (See 
"Changing the darkness" on page 1).

Smears, lines, 
marks, or spots 
appear on copies.

• If the defects are on the original, use 
Darkness in Copy feature to lighten the 
background of your copies (See "Changing 
the darkness" on page 1).

• If there are no defects on the original, clean 
the scan unit (See "Cleaning the scan unit" on 
page 3).

Copy image is 
skewed.

• Ensure that the original is face down on the 
scanner glass or face up in the document 
feeder.

• Check that the copy paper is loaded correctly.

Blank copies print 
out.

Ensure that the original is face down on the 
scanner glass or face up in the document 
feeder.

Image rubs off the 
copy easily.

• Replace the paper in the tray with paper from 
a new package.

• In high humidity areas, do not leave paper in 
the machine for extended periods of time.

Frequent copy paper 
jams occur.

• Fan the paper, then turn it over in the tray. 
Replace the paper in the tray with a fresh 
supply. Check/adjust the paper guides, if 
necessary.

• Ensure that the paper is the proper type and 
weight.

• Check for copy paper or pieces of copy paper 
remaining in the machine after a paper jam 
has been cleared.

Toner cartridge 
produces fewer 
copies than 
expected before 
running out of toner.

• Your originals may contain pictures, solids, or 
heavy lines. For example, your originals may 
be forms, newsletters, books, or other 
documents that use more toner.

• The scanner lid may be left open while copies 
are being made.

• Turn the machine off and back on. 

Loose toner • Clean the inside of the machine (See 
"Cleaning the inside" on page 2).

• Check the paper type and quality (See "Print 
media specifications" on page 3).

• Remove the toner cartridge and then, install a 
new one (See "Replacing the toner cartridge" 
on page 2).

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Character Voids

A
Character voids are white areas within parts of 
characters that should be solid black:
• You may be printing on the wrong surface of 

the paper. Remove the paper and turn it 
around. 

• The paper may not meet paper 
specifications (See "Print media 
specifications" on page 3).

Horizontal stripes

A a B b C
A a B b C
A a B b C
A a B b C
A a B b C

If horizontally aligned black streaks, white 
streaks or smears appear:
• The toner cartridge may be installed 

improperly. Remove the cartridge and 
reinsert it.

• The toner cartridge may be defective. 
Remove the toner cartridge and install a new 
one (See "Replacing the toner cartridge" on 
page 2).

• The machine might had a minor shock 
during printing or copying. There is no 
problem with the machine. Try printing again. 

• If the problem persists, the machine may 
require repair. Contact a service 
representative.

Curl If the printed paper is curled or paper does not 
feed into the machine:
• Turn the stack of paper over in the tray. Also 

try rotating the paper 180° in the tray. 
• Change the printer option and try again. Go 

to Printing Preferences, click Paper tab, 
and set type to Thin (See "Opening printing 
preferences" on page 2).

An unknown image 
repetitively 
appears on a few 
sheets or loose 
toner, light print, or 
contamination 
occurs.

Your machine is probably being used at an 
altitude of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality, 
such as loose toner or light imaging. Change the 
correct altitude setting to your machine (See 
"Altitude adjustment" on page 1).

Condition Suggested Solutions
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Scanning problems
Condition Suggested solutions

The scanner does not 
work. 

• Make sure that you place the original to be 
scanned face down on the scanner glass, or 
face up in the document feeder.

• There may not be enough available memory 
to hold the document you want to scan. Try 
the Prescan function to see if that works. 
Try lowering the scan resolution rate.

• Check that the machine printer cable is 
connected properly.

• Make sure that the machine printer cable is 
not defective. Switch the printer cable with a 
known good cable. If necessary, replace the 
printer cable.

• Check that the scanner is configured 
correctly. Check scan setting in the 
SmarThru Office or the application you want 
to use to make certain that the scanner job 
is being sent to the correct port (for example, 
USB001).

The unit scans very 
slowly. 

• Check if the machine is printing received 
data. If so, scan the document after the 
received data has been printed.

• Graphics are scanned more slowly than text.
• Communication speed slows in scan mode 

because of the large amount of memory 
required to analyze and reproduce the 
scanned image. Set your computer to the 
ECP printer mode through BIOS setting. It 
will help to increase the speed. For details 
about how to set BIOS, refer to your 
computer user’s guide.

Message appears on 
your computer 
screen:
• Device can’t be 

set to the H/W 
mode you want.

• Port is being used 
by another 
program. 

• Port is Disabled.
• Scanner is busy 

receiving or 
printing data. 
When the current 
job is completed., 
try again.

• Invalid handle.
• Scanning has 

failed.

• There may be a copying or printing job in 
progress. Try your job again when that job is 
finished.

• The selected port is currently being used. 
Restart your computer and try again.

• The machine printer cable may be 
improperly connected or the power may be 
off.

• The scanner driver is not installed or the 
operating environment is not set up properly.

• Ensure that the machine is properly 
connected and the power is on, then restart 
your computer.

• The USB cable may be improperly 
connected or the power may be off.

Fax problems
condition suggested solutions

The machine is not 
working, there is no 
display, or the 
buttons are not 
working.

• Unplug the power cord and plug it in again.
• Ensure that there is power being supplied to the 

electrical outlet.
• Ensure that the power switch is turned on, and 

the soft power switch on the control panel is 
pressed.

No dial tone. • Check that the phone line is properly 
connected.

• Check that the phone socket on the wall is 
working by plugging in another phone.

The numbers stored 
in memory do not 
dial correctly.

Make sure that the numbers are stored in memory 
correctly. Print a Addess Book list (See "Setting 
up address book" on page 7).

The original does 
not feed into the 
machine.

• Make sure that the paper is not wrinkled and 
you are inserting it in correctly. Check that the 
original is the right size, not too thick or thin.

• Make sure that the document feeder is firmly 
closed.

• The document feeder rubber pad may need to 
be replaced. Contact a service representative.

Faxes are not 
received 
automatically.

• The receiving mode should be set to fax.
• Make sure that there is paper in the tray.
• Check to see if the display shows any error 

message. If it does, clear the problem

The machine does 
not send.

• Make sure that the original is loaded in the 
document feeder or on the scanner glass. 

• Check the fax machine you are sending to, to 
see if it can receive your fax.

The incoming fax 
has blank spaces or 
is of poor-quality.

• The fax machine sending you the fax may be 
faulty. 

• A noisy phone line can cause line errors.
• Check your machine by making a copy.
• A toner cartridge has almost reached its 

estimated cartridge life. Replace the toner 
cartridge (See "Replacing the toner cartridge" 
on page 2).

Some of the words 
on an incoming fax 
are stretched.

The fax machine sending the fax had a temporary 
document jam. 

There are lines on 
the originals you 
sent.

Check your scan unit for marks and clean it (See 
"Cleaning the scan unit" on page 3).
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Samsung Scan and Fax Manager Problem
Condition suggested solution

Samsung Scan and 
Fax Manager does 
not work. 

• Check your system requirements. Samsung 
Scan and Fax Manager works in Window and 
Macintosh (See "System requirements" on 
page 2).

• Check that the Samsung Scan and Fax 
Manager is installed by looking under “All 
programs” in windows. If not installed and/or 
working correctly, reinstalled using the CD 
supplied with the product, or download the 
latest version from the Samsung website. 
(www.samsung.com/printer)

Common PostScript problems
The following situations are PS language specific and may occur when 
several printer languages are used.

Problem Possible cause Solution

PostScript file 
cannot be printed.

The PostScript 
driver may not be 
installed correctly.

• Install the PostScript 
driver (See "Installing 
USB connected 
machine’s driver" on 
page 3).

• Print a configuration 
page and verify that 
the PS version is 
available for printing.

• Reinstall the PS 
driver. If the problem 
persists, contact a 
service representative.

“Limit Check Error” 
report prints.

The print job was 
too complex.

You might need to 
reduce the complexity of 
the page or install more 
memory (See "Installing 
a memory module" on 
page 5).

A PostScript error 
page prints.

The print job may 
not be PostScript.

Make sure that the print 
job is a PostScript job. 
Check to see whether 
the software application 
expected a setup or 
PostScript header file to 
be sent to the machine.

The optional tray is 
not selected in the 
driver.

The printer driver 
has not been 
configured to 
recognize the 
optional tray.

Open the PostScript 
driver properties, select 
the Device Options tab, 
and set the tray option.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

The resolution 
setting in the printer 
driver may not be 
matched with the 
one in Acrobat 
Reader.

Make sure that the 
resolution setting in your 
printer driver matches 
the one in Acrobat 
Reader.

Common Windows problems
Condition Suggested solutions

“File in Use” 
message appears 
during installation.

Exit all software applications. Remove all 
software from the printer’s startup group, then 
restart Windows. Reinstall the printer driver.

“General Protection 
Fault”, “Exception 
OE”, “Spool 32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred” messages 
appear.

These messages may appear during printing. 
Just keep waiting until the machine finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

The machine dials a 
number, but the 
connection with the 
other fax machine 
fails.

The other fax machine may be turned off, out of 
paper, or cannot answer incoming calls. Speak 
with the other machine operator and ask them to 
solve the problem on their side.

Faxes do not store in 
memory.

There may not be enough memory space to store 
the fax. If the display indicating the memory status 
shows, delete any faxes you no longer need from 
the memory, and then try to store the fax again. 
Call for service.

Blank areas appear 
at the bottom of 
each page or on 
other pages, with a 
small strip of text at 
the top

You may have chosen the wrong paper settings in 
the user option setting. For details about paper 
settings (See "Setting the paper size and type" on 
page 7).

condition suggested solutions
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Refer to Microsoft Windows User’s Guide that came with your 
computer for further information on Windows error messages.

Common Linux problems
condition Suggested solutions

The machine does 
not print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator and 
switch to the Printers tab in Printers 
configuration window to look at the list of 
available machines. Make sure that your 
machine is displayed on the list. If not, open 
Add new printer wizard to set up your 
device.

• Check if the machine is started. Open 
Printers configuration and select your 
machine on the printers list. Look at the 
description in the Selected printer pane. If its 
status contains Stopped string, press the 
Start button. After that normal operation of 
the machine should be restored. The 
“stopped” status might be activated when 
some problems in printing occurred. For 
instance, this could be an attempt to print a 
document when the port is claimed by a 
scanning application.

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
user applications to the same port is possible. 
To avoid possible conflicts, only one of them 
at a time is allowed to gain control over the 
device. The other user will encounter “device 
busy” response. You should open ports 
configuration and select the port assigned to 
your machine. In the Selected port pane you 
can see if the port is occupied by some other 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present application is not functioning 
properly.

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is specified 
in the command line parameter, then remove 
it to print properly. For Gimp front-end, select 
“print” -> “Setup printer” and edit command 
line parameter in the command item.

• The CUPS (Common UNIXPrinting System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp (Internet 
Printing Protocol) printing.Use the socket 
printing instead of ipp or install a later version 
of CUPS (cups-1.1.22 or higher).

Some color images 
come out all black.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.05) when the base color 
space of the document is indexed color space 
and it is converted through CIE color space. 
Because Postscript uses CIE color space for 
Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 7.06 or later. You can find 
recent Ghostscript versions at 
www.ghostscript.com.

Some color images 
come out in 
unexpected color.

This is a known bug in Ghostscript (until GNU 
Ghostscript version 7.xx) when the base color 
space of the document is indexed RGB color 
space and it is converted through CIE color 
space. Because Postscript uses CIE color space 
for Color Matching System, you should upgrade 
Ghostscript on your system to at least GNU 
Ghostscript version 8.xx or later. You can find 
recent Ghostscript versions at 
www.ghostscript.com.

The machine does 
not print whole 
pages and its output 
is half page printed.

It is a known problem that occurs when a color 
printer is used on version 8.51 or earlier of 
Ghostscript, 64-bit Linux OS, and reported to 
bugs.ghostscript.com as Ghostscript Bug 
688252.
The problem is solved in AFPL Ghostscript v. 
8.52 or above. Download the latest version of 
AFPL Ghostscript from 
http://sourceforge.net/projects/gho

I cannot scan via 
Gimp Front-end.

Check if Gimp Front-end has Xsane:Device 
dialog. on the Acquire menu. If not, you should 
install Xsane plug-in for Gimp on the your 
computer. You can find Xsane plug-in package 
for Gimp on Linux distribution CD or Gimp home 
page. For the detailed information, refer to the 
Help for Linux distribution CD or Gimp Front-end 
application. 
If you wish to use another kind of scan 
application, refer to application’s Help.

I encounter error 
“Cannot open port 
device file” when 
printing a document.

Avoid changing print job parameters (via LPR 
GUI, for example) while a print job is in progress. 
Known versions of CUPS (Common UNIX 
Printing System) server break the print job 
whenever print options are changed and then try 
to restart the job from the beginning. Since 
Unified Linux Driver locks the port while printing, 
the abrupt termination of the driver keeps the 
port locked and unavailable for subsequent print 
jobs. If this situation occurs, try to release the 
port by selecting Release port in Port 
configuration window.

condition Suggested solutions
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Refer to Linux User’s Guide that came with your computer for further 
information on Linux error messages.

Common Macintosh problems
condition Suggested solutions

The machine does 
not print PDF files 
correctly. Some 
parts of graphics, 
text, or illustrations 
are missing.

Printing the PDF file as an image may enable 
the file to print. Turn on Print As Image from the 
Acrobat printing options. 

 

It will take longer to print when you print a 
PDF file as an image.

The document has 
printed, but the print 
job has not 
disappeared from 
the spooler in Mac 
OS X 10.3.2.

Update your Mac OS to OS Mac OS X 10.3.3. or 
higher.

Some letters are not 
displayed normally 
during the cover 
page printing.

Mac OS cannot create the font during the cover 
page printing. The English alphabet and 
numbers are displayed normally on the cover 
page.

When printing a 
document in 
Macintosh with 
Acrobat Reader 6.0 
or higher, colors 
print incorrectly.

Make sure that the resolution setting in your 
machine driver matches the one in Acrobat 
Reader.

 

Refer to Macintosh User’s Guide that came with your computer for 
further information on Macintosh error messages.

The machine does 
not appear on the 
scanners list.

• Ensure your machine is attached to your 
computer, connected properly via the USB 
port, and is turned on.

• Ensure the scanner driver for your machine is 
installed in your system. Open Unified Linux 
Driver configurator, switch to Scanners 
configuration, then press Drivers. Make 
sure that driver with a name corresponding to 
your machine's name is listed in the window. 

• Ensure the port is not busy. Since functional 
components of machine (printer and scanner) 
share the same I/O interface (port), the 
situation of simultaneous access of different 
user applications to the same port is possible. 
To avoid possible conflicts, only one of them 
at a time is allowed to gain control over the 
device. The other user will encounter “device 
busy” response. This usually happens when 
starting a scan procedure. An appropriate 
message box appears.
To identify the source of the problem, open 
the Ports configuration and select the port 
assigned to your scanner, port's symbol 
/dev/mfp0 corresponds to LP:0 designation 
displayed in the scanners’ options, /dev/mfp1 
relates to LP:1, and so on. USB ports start at 
/dev/mfp4, so scanner on USB:0 relates to 
/dev/mfp4 respectively and so forth 
sequentially. In the Selected port pane, you 
can see if the port is occupied by another 
application. If this is the case, you should 
either wait for completion of the current job or 
press the Release port button, if you are sure 
that the present port applicaton is not 
functioning properly.

The machine does 
not scan.

• Ensure a document is loaded into the 
machine, ensure your machine is connected 
to the computer.

• If there is an I/O error while scanning.

condition Suggested solutions
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1.supplies and accessories
This chapter provides information on purchasing supplies, accessories and maintenance parts available for your machine.
This chapter includes:
• How to purchase
• Available supplies
• Available accessories
• Maintenance parts
• Replacing the toner cartridge
• Replacing the paper transfer belt

• Necessary precautions to take when installing accessories
• Activating the added accessories in printer properties
• Upgrading a memory module
• Installing a wireless network interface card
• Installing a hard disk
• Checking replaceable’s lifespan

  

 

Available accessories may differ from country to country. Contact your 
sales representatives to obtain the list of available accessories.

How to purchase
To order Genuine Samsung supplies, accessories and, maintenance parts, 
contact your local Samsung dealer or the authorized retailer where you 
purchased your machine. You can also visit www.samsung.com/supplies, 
select your country/region, and obtain information on calling for service.

Available supplies
When supplies reach their lifespan, you can order the following types of 
supplies for your machine:

Type Average yielda Part name

TONER 
CARTRIDGES
Standard yield

• Average continuous 
black cartridge yield: 
2,500 standard pages 
(Black)

• Average continuous 
colored cartridge yield: 
2,000 standard pages 
(Yellow/Magenta/Cyan)

K508(CLT-K508S): Black
C508(CLT-C508S): Cyan
M508(CLT-M508S): 
Magenta
Y508(CLT-Y508S): Yellow
Region Ab

b.Region A: Albania, Austria, Belgium, Bosnia, Bulgaria, Croatia, Cyprus, 
Czech Republic, Denmark, Finland, France, Germany, Greece, 
Hungary, Italy, Macedonia, Netherlands, Norway, Poland, Portugal, 
Romania, Serbia, Slovakia, Slovenia, Spain, Sweden, Switzerland, UK. 

: 
K5082(CLT-K5082S): 
Black
C5082(CLT-C5082S): 
Cyan
M5082(CLT-M5082S): 
Magenta
Y5082(CLT-Y5082S): 
Yellow

TONER 
CARTRIDGES
High yield

• Average continuous 
black cartridge yield: 
5,000 standard pages 
(Black)

• Average continuous 
colored cartridge yield: 
4,000 standard pages 
(Yellow/Magenta/Cyan)

K508L(CLT-K508L): Black
C508L(CLT-C508L): Cyan
M508L(CLT-M508L): 
Magenta
Y508L(CLT-Y508L): 
Yellow
Region Ab: 
K5082L(CLT-K5082L): 
Black
C5082L(CLT-C5082L): 
Cyan
M5082L(CLT-M5082L): 
Magenta
Y5082L(CLT-Y5082L): 
Yellow

Paper transfer 
belt

Approx. 50,000 pages
When the transfer belt has 
worn out with abrasion, 
you need to change it. By 
this time you may be 
notified with the transfer 
belt-related message on 
the display.

CLT-T508

To replace a toner cartridge see "Replacing the toner cartridge" on page 2.

 

Depending on the options and percentage of image area, job mode 
used, the toner cartridge’s lifespan may differ.

 

You must purchase supplies, including toner cartridges, in the same 
country where you purchased your machine. Otherwise, supplies will 
be incompatable with your machine since the system configurations 
vary from country to country.

a.Declared yield value in accordance with ISO/IEC 19798.

Type Average yielda Part name
Supplies and accessories_ 1

http://www.samsung.com/supplies
http://www.samsung.com/supplies


Available accessories
You can purchase and install accessories to enhance your machine’s 
performance and capacity.

Accessory function Part name
Memory module Extend your machine’s 

memory capacity.
• CLX-6220 Series

-CLP-MEM201: 128 MB
-CLP-MEM202: 256 MB

• CLX-6250 Series
-ML-MEM150: 128 MB
-ML-MEM160: 256 MB
-ML-MEM170: 512 MB

Optional tray 2 If you are experiencing 
frequent paper supply 
problems, you can 
attach an additional 500 
sheets tray. You can 
print documents in 
various sizes and types 
of print materials.

CLX-S6250A

Hard disk 
(CLX-6250 Series 
only)

Allows you to enhance 
the machine’s capability 
and print in various 
ways.

ML-HDK300

IEEE 802.11 b/g 
Wireless LAN 
(CLX-6250 Series 
only)a

a.Depending on your country, wireless LAN cards may not be available. 
Contact your local Samsung dealer or the retailer where you bought your 
printer.

Allows you to connect 
your printer to a 
wireless network.

ML-NWA40L

Maintenance parts
To purchase maintenance parts, contact the source where you bought the 
machine. 
Replacing maintenance parts can be performed only by an authorized 
service provider, dealer, or the retailer where you bought the machine. The 
warranty does not cover the replacement of any maintenance parts once it 
has reached its “Average Yield”.
Maintenance parts are replaced at specific intervals to avoid print quality 
and paper feed problems resulting from worn parts, see table below. The 
purpose of which is to maintain your machine in top working condition. The 
maintenance parts below should be replaced when the life span of each 
item has been met.

parts Average yielda

Fuser unit Approx. 100,000 pages

Document feeder friction pad Approx. 75,000 pages 

Document feeder pick-up roller Approx. 20,000 pages

Pick-up roller (Multi-purpose tray, Tray1, 
Optional tray 2)

Approx. 70,000 pages

Friction pad (Multi-purpose tray, Tray1, 
Optional tray 2)

Approx. 70,000 pages

Replacing the toner cartridge

 

Click this link to open an animation about replacing a toner cartridge.

When the toner cartridge reaches its estimated cartridge life.
• The status LED and the toner-related message on the display indicates 

which each individual toner cartridge should be replaced.
• The machine stops printing. Incoming faxes are saved in memory. 
At this stage, the toner cartridge needs to be replaced. Check the type of the 
toner cartridge for your machine (See "Available supplies" on page 1).
1. Using the handle, completely open the front door.

2. Grasp the handles on the toner cartridge and pull to remove the 
cartridge from the machine.

 

If you open the front door, be careful not to touch the underneath 
the control panel (the lower part of the fuser unit). The temperature 
of the fuser unit might be extremely hot and could damage your 

a. It will be affected by operating system used, computing performance, 
application software, connecting method, media type, media size and 
job complexity.
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skin. 

 

When you open the front door and work inside the machine, it is 
highly recommend that you remove the paper transfer belt first. 
Because the work you do could contaminate the paper transfer 
belt.

3. Remove the new toner cartridge from its bag. 

 

•Don't use sharp objects, such as a knife or scissors, to open the 
print cartridge package. You could damage the surface of the 
print cartridge. 

•To prevent damage, do not expose the print cartridge to light for 
more than a few minutes. Cover it with a piece of paper to 
protect it if necessary.

4. Slowly shake the cartridge five or six times to distribute the toner evenly 
inside the cartridge. It will assure maximum copies per cartridge. 

5. Place the print cartridge on a flat surface, as shown, and remove the 
paper covering the print cartridge by removing the tape.

 

•If toner gets on your clothing, wipe it off with a dry cloth and wash 
clothing in cold water. Hot water sets toner into fabric.

•Do not touch the surface, the OPC drum in the cartridge. If the 
surface is contaminated, it might affect the printout quality. Use 
the handle on the cartridge to avoid touching this area. 

6. Hold the toner cartridge by the handle and slowly insert the cartridge into 
the opening in the machine. Ensure the color cartridge is placed in the 
correct position, see label in picture below for the correct color position 
for each cartridge.
Tabs on the sides of the cartridge and corresponding grooves within the 
machine will guide the cartridge into the correct position until it locks into 

place completely.

7. Close the front door. Make sure that the cover is securely closed. 

 

If the front door is not completely closed, the machine will not 
operate. 

Replacing the paper transfer belt
After the life span of the paper transfer belt is complete, you have to replace 
it.
• The transfer belt-related message appears on the display, telling it's 

time for a replacement. 
• The Smart Panel program window appears on the computer telling you 

the paper transfer belt needs to be replaced. 

 

The life span of the paper transfer belt may be affected by operating 
environment, printing interval, media type, and media size.

1. Open the front door.

 

If you leave the front door open for more than a few minutes, the 
OPC drum in the toner cartridge can be exposed to light. This will 
cause damage to the OPC drum. Close the front door should the 
installation need to be halted for any reason.

2. Press the green release handle to release the paper transfer belt. 
Holding the handle on the paper transfer belt, lift it out of the machine.

3. Remove a new paper transfer belt from its bag. 
4. Remove the paper covering the paper transfer belt. 

 

•Do not use sharp objects, such as a knife or scissors, to open the 
paper transfer belt package. You could damage the surface of 
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the paper transfer belt. 
•Be careful not to scratch the surface of the paper transfer belt.

5. Holding the handle on the new paper transfer belt, align it with the slots 
on the inside of the front door.

6. Lower the paper transfer belt until it is parallel with the front door and 
firmly seated.

7. Close the front door to resume printing.

 

If the front door is not completely closed, the machine will not 
operate. 

Necessary precautions to take when installing 
accessories
• Disconnect the power cord.

To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

• Discharge static electricity.
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

• Activating the added accessories in the PS driver properties.
After installing an accessory such as an optional tray, PS driver users 
must do the additional setting. Go to the PS printer properties and set 
the added accessory activated. 

 

When installing accessories, the battery inside the machine is a 
service component and needs to be replaced by an authorized 
servicer. Do not change it by yourself.
There is a risk of an explosion if battery is replaced by an incorrect 
type.

Activating the added accessories in printer 
properties
After installing added accessories, you need to select it in the printer 
properties of the printer driver in order to use it.
1. Install the driver (See "Installing USB connected machine’s driver" on 

page 3 or "Installing network connected machine’s driver" on page 3).
2. Click the Windows Start menu.
3. For Windows 2000, select Settings > Printers.

•For Windows XP/2003, select Printers and Faxes. 
•For Windows 2008/Vista, select Control Panel > Hardware and 

Sound > Printers. 
•For Windows 7, select Control Panel > Hardware and Sound > 

Devices and Printers. 
•For Windows Server 2008 R2, select Control Panel > Hardware > 

Devices and Printers. 
4. Right-click your machine.
5. For Windows XP/2003/2008/Vista, press Properties.

•For PS driver, select PS driver and right-click to open Properties. 
For Windows 7 and Windows Server 2008 R2, from context menus, 
select the Printer properties.

 

If Printer properties item has ► mark, you can select other 
printer drivers connected with selected printer.

6. In printer driver properties, select Device Options. 
7. In printer driver properties, set the necessary options.
8. Click OK. 

Upgrading a memory module
Your machine supports DIMM (Dual Inline Memory Module). Use this 
memory module slot to install additional memory.
When you are expanding the memory capacity, you can add a memory 
module to the vacant memory slot (See "Available accessories" on page 2).
We recommend the use of only genuine Samsung DIMM's. You may void 
your warranty if it is determined that your machine problem is being caused 
by third party DIMM's.
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Installing a memory module
1. Turn the machine off and unplug all cables from the machine.
2. Remove the screws and remove the rear cover.

3. Remove the screws, then lift up the cover slightly and pull the cover to 
the right.

1 Control board 
cover

4. Remove the new memory module from its bag. 
5. Holding the memory module by the edges, align the memory module in 

the slot at about a 30-degree angle. Make sure that the notches of the 
module and the grooves on the slot fit each other.

 

The notches and grooves illustrated above may not match those 
on an actual memory module and its slot.

6. Press the memory module into the slot with care until you hear a 'click'. 

 

Do not press the memory module strongly or the module may be 
damaged. If the module does not seem to fit into the slot properly, 
carefully try the previous procedure again.

7. Install the control board with the screw removed in step 3. 
8. Install the rear cover with the screw removed in step 2.
9. Reconnect the power cord and printer cable, and turn the machine on.

 

If you use the PS driver, you must activate the added memory in the 
PS driver properties 
(See "Activating the added accessories in printer properties" on 
page 4).

Printing with the optional memory (CLX-6250 Series 
only)

 

•You can only use this feature if you have installed the 512 MB 
optional memory. (CLX-6250 Series only)

•After installing the optional memory, you can use advanced printing 
features, such as proofing a job and specifying of printing a private 
job in the printer properties window.

Job Settings 
This option allows you to choose how to print the printing file by using 
the 512 MB optional memory. 
1.Open the document you want to print.
2.Select Print from the File menu. The Print window appears. 
3.Select your printer driver from the Select Printer list.

The basic print settings including the number of copies and print 
range are selected within the Print window. 

4.Access Printing Preferences (See "Opening printing preferences" on 
page 2).

5.Click the Advanced tab then select Job Settings.
6.Select the Print Mode you want .

•Normal: This mode prints without storing your document in the 
optional memory. 

•Proof: This mode is useful when you print more than one copy. 
You can print one copy first to check, than print the rest of copies 
later. 

•Confidential: This mode is used for printing confidential 
documents. You need to enter a password to print. 

7.Select OK.

Controlling the active job queue
All of the print jobs waiting to be printed are listed in the active job queue 
in the order you sent them to the printer. You can delete a job from the 
queue before printing, or promote a job to print sooner.
1.Press Menu on the control panel.
2.Press left/right arrow until Job Management appears and press OK.
3.Press left/right arrow until Active Job appears and press OK.
4.Press left/right arrow until the user’s name and file name you want to 

use appears and press OK.

 

If the select file is a confidential print job, enter the specified 
4-digit password.
Use the left/right arrow to enter digits. When you press OK, the 
cursor will move to the next character. When you finish 
entering the password, press OK.
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If you enter the incorrect password, Invalid Password 
appears. Reenter the correct password.

5.Press the left/right arrow until the desired setting appears and press 
OK.
•Cancel: You can delete a file from the queue.
•Promote: You can select a job waiting in the active job queue and 

change its print order so that it can be printed sooner.
•Release: You can print a job scheduled to be printed at a specified 

time immediately. In this case, the job currently printing is 
stopped and the selected job will be printed. This function is 
available when the job is scheduled for later printing.

6.When Yes appears, press OK.

File Policy
You can choose the file policy for generating file name before you 
proceed with the job through optional memory. If the optional memory 
already has the same name when you entered a new file name, you can 
rename or overwrite it.
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Job Management and press 

OK.
4.Press the up/down arrow to highlight File Policy and press OK.
5.Press the up/down arrow to highlight the desired setting and press 

OK.
•Rename : If the optional memory already has the same name 

when you enter a new file name, the file will be saved as a 
different name that is automatically programmed.

•Overwrite : You can set the machine to delete previous job 
information on optional memory as you store new job 
information.

6.Press OK.

Installing a wireless network interface card

 

Depending on your country, wireless LAN cards may not be available. 
Contact your local Samsung dealer or the retailer where you bought 
your printer.

The machine is equipped with a network interface which allows you to use 
your machine on a network. You can also purchase a wireless network 
interface card to enable the use of the machine in wireless network 
environments (See "Available accessories" on page 2).

Installing a wireless network interface card
1. Turn the machine off and unplug all cables from the machine.
2. Remove the screws and remove the rear cover.

3. Remove the screws, then lift up the cover slightly and pull the cover to 
the right.

1 Control board 
cover

4. Detach the dummy panel on your machine using a screwdriver. Be 
careful when removing not to damage the plastic cover.

5. Take out a new wireless interface card from its bag.
6. Place the wireless network interface card into the card guide [below item 

3], ensure the connector side of the card is to the right.

1 wireless network interface 
card connector

2 wireless network interface 
card

3 wireless network interface 
card guide

7. Align the wireless network card connector on the right side of the card 
with the connector on the control board [1].
Press the wireless interface card [2] down firmly into the main connector 
[1] until it is completely and securely in place.
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1 Connector
2 Wireless 

interface card

8. Install the control board cover with the screws removed in step 3.

9. Install the rear cover with the screws removed in step 2.
10. Plug all the cables back into the machine, and turn the machine on.
11. Set the wireless network environment.

 

For information about configuring and using the printer on a 
wireless network environment, refer to the Wireless network install 
guide provided with the wireless network interface card. You can 
also configure the network parameters on the control panel; see 
the next column.

Configuring the machine’s wireless network
Before starting you will need to know the network name(SSID) of your 
wireless network and the network key if it is encrypted. This information was 
set when the wireless router(access point) was installed. If you do not know 
about your wireless environment, please ask the person who has set up 
your network.
To configure wireless parameters, you can use both control panel and 
SyncThru™ Web Service.

Using the control panel
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight Network and press OK.
3.Press the up/down arrow to highlight Wireless and press OK.
4.Press the up/down arrow to highlight WLAN Settings and press OK.
5.Press the up/down arrow to select the setup method you want is 

highlighted and press OK.
•Wizard: The wireless network interface card in your printer 

searches for wireless networks in the area and shows the results.
•Custom: You can configure the wireless settings according to your 

needs.

Wizard mode
1.The wireless network interface card on your machine searches for 

wireless network in the area and shows the results.
2.Press the up/down arrow to select a network you want to use in 

Search List and press OK. You can select a network using SSID.
3.When None appears in WLAN Security on the display, press OK to 

save your selection. go to step 6.
If you see another messages, go to the next step.

4.According to the network you select, WLAN security encryption type 
will be WEP or WPA.
•In case of WEP, Press the up/down to selcet Open System or 

SharedKey.
-Open System: Authentication is not used, and Encryption 

may or may not be used, depending on the need for data 
security. Enter the WEP Key using number keypad after 
selecting Open System.

-SharedKey: Authentication is used. A device that has a proper 
WEP Key can access the network. Enter the WEP Key using 
number keypad after selecting SharedKey.

•In case of WPA, Enter the WPA Key using number keypad. The 
Key length should be between 8 to 63 characters long.

5.Press OK.
6.Press Stop/Clear to return to ready mode.

 

•SSID: SSID (Service Set Identifier) is a name that identifies a 
wireless network. Access points and wireless devices 
attempting to connect to a specific wireless network must use 
the same SSID. The SSID is case-sensitive.

•WEP : WEP (Wired Equivalent Privacy) is a security protocol 
preventing unauthorized access to your wireless network. 
WEP encrypts the data portion of each packet exchanged on a 
wireless network using a 64-bit or 128-bit WEP encryption key.

•WPA : WPA authorizes and identifies users based on a secret 
key that changes automatically at regular intervals. WPA also 
uses TKIP (Temporal Key Integrity Protocol) and AES 
(Advanced Encryption Standard) for data encryption.

Custom mode
1.Enter the SSID when Edit SSID appears on the top line of the display, 

the name that identifies a wireless network. SSID is case-sensitive 
so you need to enter it carefully. Press OK.

2.Select the type of wireless connections. Press the up/down arrow to 
select the method of Operation Mode you want and press OK.
•Ad-hoc: Allows wireless devices to communicate directly with each 

other in a peer-to-peer environment. Go to step 3.
•Infrastructure: Allows wireless devices to communicate with each 

other through an access point. Go to step 4.
3.Press the up/down arrow to select the method of Channel you want 

and press OK. If you select Auto, the wireless network interface card 
on your machine will automatically adjust the channels.

4.Press the up/down arrow to select the method of WLAN Security you 
want and press OK.
•None: This is used when the validation of a wireless device’s 

identity and data encryption are not required for your network. 
Open system is used for IEEE 802.11 authentication.

•Static WEP: This uses the WEP (Wired Equivalent Privacy) 
algorithm suggested by IEEE 802.11 standard for security. Static 
WEP security mode requires a proper WEP key for data 
encryption, decryption, and IEEE 802.11 authentication. Press 
the left/right arrow to select the setup method you want in 
Authentication and press OK.
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-Open System: Authentication is not used, and encryption may 
or may not be used, depending on the need for data security. 
Enter the WEP Key using number keypad after selecting 
Open System and then press OK.

-SharedKey: Authentication is used. A device that has a proper 
WEP Key can access the network. Enter the WEP Key using 
number keypad after selecting SharedKey and then press 
OK.

•WPA-PSK or WPA2-PSK: You can select WPA-PSK or 
WPA2-PSK to authenticate the print server based on WPA 
Pre-Shared Key. This uses a shared secret key (generally called 
Pre Shared Key passphrase) which is manually configured on 
the access point and each of its clients.
a. Press OK when WPA-PSK or WPA2-PSK appears on the 
bottom line of the display.
b. Press the up/down arrow to select TKIP or AES in Encryption 
and press OK. If you select WPA2-PSK, press the up/down 
arrow to select AES or TKIP + AES in Encryption and press 
OK.
c. Enter the WPA Key using number keypad and press OK.

5.When you have finished, press Stop/Clear to return to the ready 
mode. If you do not know about your wireless environment, please 
ask the network administrator.

 

Disconnect the network cable (standard or crossover). Your 
machine should then start communicating wirelessly with the 
network. In case of Ad-hoc mode, you can use a wireless LAN and 
wired LAN simultaneously.

Now go to "Installing network connected machine’s driver" on page 3.

Using SyncThru™ Web Service
For information about configuring and using the machine on a wireless 
network environment, refer to the Wireless network install guide 
provided with the wireless network interface card. You can also 
configure the network parameters on the SyncThru™ Web Service.

Installing a hard disk
Installing the hard disk allows the data from your computer to be sent to the 
print queue of the printer hard disk. This decreases the workload of the 
computer. You can also use various print features, such as storing a job in 
the hard disk, proofing a job, and printing private documents.
The order information is provided for optional hard disk (See "Available 
accessories" on page 2).

Installing a hard disk
1. Turn the machine off and unplug all cables from the machine.
2. Remove the screws and remove the rear cover.

3. Remove the screws, then lift up the cover slightly and pull the cover to 
the right.

1 Control board 
cover

4. Take out a new hard disk from its plastic bag.
5. Align the connector on the hard disk with the connector on the control 

board. Push the hard disk in until it is latched into place.

6. Fasten down the hard disk with the screws supplied with your new hard 
disk; then reinstall the covers removed in steps 2 and 3.

7. Reconnect the power cord and machine cable. Turn on the machine.
8. You must activate the added hard disk in the driver properties

(See "Activating the added accessories in printer properties" on page 4).

Printing with the optional hard disk

 

After installing the optional hard disk, you can use advanced printing 
features, such as storing or spooling a print job to the hard disk, 
proofing a job, and specifying of printing a private job in the printer 
properties window.
Once you have stored files in the hard disk, you can easily print or 
delete the stored files using the control panel of your printer.

Storing a job
You can store jobs on the hard disk.
1.Open the document you want to print.
2.Select Print from the file menu. The Print window appears. 
3.Select your machine from Select Printer list. 
4.Click Properties or Preferences.
5.Click the Advanced tab and click Job Setting.
6.Select the print mode you want from the drop-down list

(See "Using help" on page 3).
7.Enter the user’s name and file name.
8.Click OK until the Print window is displayed.
9.Click OK or Print to start printing.

Printing or deleting a stored job
You can print or delete jobs stored on the hard disk.
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1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Job Management and press 

OK.
4.Press the up/down arrow to highlight Stored Job and press OK.
5.Press the up/down arrow to highlight the user’s name and file name 

you want use and press OK.

 

If the select file is a confidential print job, enter the specified 
4-digit password.
Use the up/down arrow to enter digits and use the left/right 
arrow to move between digits. When you finish entering the 
password, press OK.
If you enter the incorrect password, Invalid Password 
appears. Reenter the correct password.

6.Press the up/down arrow to highlight the desired setting and press 
OK.
•Print: You can print a stored job.
•Delete: You can delete a stored job.

7.When Yes appears, press OK.

Controlling the active job queue
All of the print jobs waiting to be printed are listed in the active job queue 
in the order you sent them to the printer. You can delete a job from the 
queue before printing, or promote a job to print sooner.
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Job Management and press 

OK.
4.Press the up/down arrow to highlight Active Job and press OK.
5.Press the up/down arrow to highlight the user’s name and file name 

you want use and press OK.

 

If the select file is a confidential print job, enter the specified 
4-digit password.
Use the up/down arrow to enter digits and use the left/right 
arrow to move between digits. When you finnish entering the 
password, press OK.
If you enter the incorrect password, Invalid Password 
appears. Reenter the correct password.

6.Press the up/down arrow to highlight the desired setting and press 
OK.
•Cancel: You can delete a file from the queue.
•Promote: You can select a job waiting in the active job queue and 

change its print order so that it can be printed sooner.
•Release: You can print a job scheduled to be printed at a specified 

time immediately. In this case, the job currently printing is 
stopped and the selected job will be printed. This function is 
available when the job is scheduled for later printing.

7.When Yes appears, press OK.

Form file
Form overlay are images stored in the printer hard disk drive (HDD) as a 
special file format that can be printed in layers on any document. 

Creating new form files
Use the steps below to create a new form overlay.
1.Create or open a document containing text or an image for use in a 

new form file.
2.To save the document as a form file, access Printing Preferences 

(See "Opening printing preferences" on page 2).
3.Click the Advanced tab, and select Advanced.
4.In the Advanced Output Options window, check Save as Form for 

Overlay. 
5.Click Search.
6.Type a file name of up to eight characters in the File name box. Select 

the destination path and click Save.
7.Click OK or Print until you exit the Print window.

8. A confirm message appears, click Yes to save.
The file is not printed. Instead, it is stored on your computer hard disk 
drive. 

 

If you click NO, the machine prints your form without saving.

9.A confirm message appears, click Yes to save.

 

The form file size must be the same as the document you print with 
the form file.

Using form files on your machine’s hard disk
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Machine Setup and press OK.
4.Press the up/down arrow to highlight Form Menu and press OK.
5.Press the up/down arrow until the item you want appears and press 

OK.
•Off: Prints in normal mode.
•Single Form: Prints all page using the first form.
•Double Form: Prints the front page using the first form and the 

back page using the second form.
6.Press Back.
7.Press the up/down arrow to highlight Select Form and press OK.
8.Press the up/down arrow until the item you want appears and press 

OK.
9.Press the up/down arrow until the form file for the second form 

appears and press OK.

File Policy
You can choose the file policy for generating file name before you 
proceed with the job through hard disk drive (HDD). If the hard disk drive 
(HDD) memory already has the same name when you entered a new file 
name, you can rename or overwrite it.
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Job Management and press 

OK.
4.Press the up/down arrow to highlight File Policy and press OK.
5.Press the up/down arrow to highlight the desired setting and press 

OK.
•Rename : If the hard disk drive (HDD) memory already has the 
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same name when you enter a new file name, the file will be 
saved as a different name that is automatically programmed.

•Overwrite : You can set the machine to delete previous job 
information on hard disk drive (HDD) as you store new job 
information.

6.Press OK.

Deleting residual image data
Image Overwrite is a security measure for customers who are 
concerned about unauthorized access and duplication of classified or 
private document.
1.Press Menu on the control panel.
2.Press the up/down arrow to highlight System Setup and press OK.
3.Press the up/down arrow to highlight Job Management and press 

OK.
4.Press the up/down arrow to highlight Image Overwrite and press OK.
5.Press the up/down arrow to highlight the desired setting and press 

OK.
•Immediate : All residual image data from the machine will be 

erased immediately after each job has been processed.
•On Demand : This option provides an on-demand facility for a 

system administrator to erase all the real image data remained in 
hard disk drive (HDD) after this option enabled. All existing jobs 
will be deleted regardless of their status and all job submissions 
will be prohibited for the duration of the overwrite.

6.Press the up/down arrow to move to On or Off for Immediate.
Press the up/down arrow to move to Enable or Disable for On 
Demand.

 

If you selected On Demand enabled, the machine confirms if 
the overwrite feature starts now. Press the up/down arrow to 
select Yes or No. If you select Yes, On Demand overwrite 
starts as soon as you select Yes. If you select No, this feature 
will be enabled.

7.Press OK.

Checking replaceable’s lifespan
If you experience frequent paper jams or printing problems, check the 
number of pages the machine has printed. Replace the corresponding 
parts, if necessary.
1. Press Menu on the control panel.
2. Press the up/down arrow to highlight System Setup and press OK.
3. Press the up/down arrow to highlight Maintenance and press OK.
4. Press the up/down arrow to highlight Supplies Life and press OK.
5. Press the up/down arrow until the item you want appears and press OK.
6. Press Stop/Clear to return to ready mode.
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1.specifications
This chapter guides you about this machine’s specifications.
This chapter includes:
• Hardware specifications
• Environmental specifications
• Electrical specifications
• Print media specifications
  

 

The specification values are listed below, specification are subject to change without notice. See www.samsung.com/printer for possible changes in 
information.

Hardware specifications

Item Description

Dimension Height 651 mm (25.63 inches)
Depth 498 mm (19.61 inches)
Width 468 mm (18.43 inches)

Weight Machine with consumables 37.40 Kg (82.45 lbs)
Package weight Paper 5.8 Kg (12.7 lbs)

Plastic 1.8 Kg (3.9 lbs)

Environmental specifications

Item Description

Noise Levela

a.Sound Pressure Level, ISO 7779. Configuration tested: machine basic installation, A4 paper, simplex printing.

Ready mode 35 dB(A )

Printing mode • CLX-6220 Series: 53 dB(A) 
• CLX-6250 Series: 54 dB(A) 

Temperature Operation 15 to 32 °C (59 to 89.6 °F)

Storage (Packed) -20 to 40 °C (-4 to 104°F)

Humidity Operation 20 to 80% RH

Storage (Packed) 10 to 90% RH

Electrical specifications

 

Power requirements are based on the country/region where the device is sold. Do not convert operating voltages. Doing so might damage the device and 
void the product warranty.

Item Description

Power ratinga 110 volt models AC 110 - 127 V
220 volt models AC 220 - 240 V
Specifications_ 1
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Power consumption Average operating mode • CLX-6220 Series: Less than 550 W
• CLX-6250 Series: Less than 580 W

Ready mode • CLX-6220 Series: Less than 33 W
• CLX-6250 Series: Less than 38 W

Power save mode • CLX-6220 Series: Less than 11 W
• CLX-6250 Series: Less than 13 W

Power off mode Less than 1 W

a.See the rating label on the machine for the correct voltage, frequency (hertz) and type of current for your machine.

Item Description
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Print media specifications

Type Size Dimensions
Print media weight ba

a.If media weight is over 105 g/m2 (28 lb bond), load a paper into the multi-purpose tray one by one.

/Capacity

Plain paper Letter 216 x 279 mm (8.5 x 11 inches) 70 to 90 g/m2 (19 to 24 lbs bond) 
• 250 sheets of 80 g/m2(20 lbs 

bond) for tray1
• 500 sheets of 80 g/m2(20 lbs 

bond) for optional tray.

70 to 90 g/m2 (19 to 24 lbs bond) 
• 100 sheets of 80 g/m2(20 lbs bond)Legal 216 x 356 mm (8.5 x 14 inches)

US Folio 216 x 330 mm (8.5 x 13 inches)
A4 210 x 297 mm (8.27 x 11.69 inches)
Oficio 216 x 343 mm (8.5 x 13.5 inches)
JIS B5 182 x 257 mm (7.17 x 10.12 inches) 70 to 90 g/m2 (19 to 24 lb bond) 

• 250 sheets of 80 g/m2(20 lbs 
bond)

ISO B5 176 x 250 mm (6.93 x 9.84 inches) 
Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.83 x 8.27 inches) 70 to 90 g/m2 (19 to 24 lb bond) 
• 250 sheets of 80 g/m2(20 lbs 

bond) for tray1
• Not available in optional tray.

Statement 140 x 216 mm (5.5 x 8.5 inches)
A6 105 x 148 mm (4.13 x 5.83 inches)

Envelope Envelope Monarch 98 x 191 mm (3.87 x 7.5 inches) Not available in tray1 / optional 
tray.

75 to 90 g/m2 (20 to 24 lbs bond)
• 10 sheetsEnvelope No. 10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)
Envelope C5 162 x 229 mm (6.38 x 9.02 inches)
Envelope C6 114 x 162 mm (4.49 x 6.38 inches)
Envelope No. 9 98 x 225 mm (3.87 x 8.87 inches)
Envelope 6 3/4 92 x 165 mm (3.62 x 6.5 inches)

Thick paper Refer to the Plain paper 
section 

Refer to the Plain paper section 90 to 105 g/m2 (24 to 28 lbs bond)
• 250 sheets of 80 g/m2(20 lbs 

bond) f or tray1. 
• 500 sheets of 80 g/m2(20 lbs 

bond) for optional tray.

90 to 105 g/m2 (24 to 28 lbs bond)
• 40 sheets

Thin paper Refer to the Plain paper 
section 

Refer to the Plain paper section 60 to 70 g/m2 (16 to 19 lbs bond)
• 250 sheets of 80 g/m2(20 lbs 

bond) f or tray1. 
• 500 sheets of 80 g/m2(20 lbs 

bond) for optional tray.

60 to 70 g/m2 (16 to 19 lbs bond)
• 100 sheets

Thicker paper Refer to the Plain paper 
section 

Refer to the Plain paper section Not available in tray1 / optional 
tray.

106 to 120 g/m2 (28 to 32 lbs bond)
• 10 sheets

Extra thick Refer to the Plain paper 
section 

Refer to the Plain paper section 120 to 170 g/m2 (32 to 46 lbs bond)
• 10 sheets

Labelsc Refer to the Plain paper 
section 

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lbs bond)
• 10 sheets

Card stock Refer to the Plain paper 
section 

Refer to the Plain paper section 171 to 220 g/m2 ( 46 to 59 lbs bond)
• 5 sheets

Glossy Photo, 
Matte Photo

Refer to the Plain paper 
section 

100 x 150 mm (4 x 6 inches) 111 to 220 g/m2 ( 30 to 59 lbs bond)
• 1 sheet

Minimum size (custom) 98 x 148 mm (3.9 x 5.8 inches)  
Maximum size (custom) 216 x 356 mm (8.5 x 14 inches)

tray1 / optional tray multi-purpose tray



b.Maximum capacity may differ depending on media weight, thickness, and environmental conditions. 
c. Smoothness: 100 to 250 (sheffield).
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1.administrator’s guide (windows only)
This chapter gives helpful information and troubleshooting tips for system administrators using Samsung Installer.

Overview
Samsung provides convenient installation methods useful for 
administrators. Administrators can remotely install the machine driver to 
multiple client computers or use command window to install the driver at 
once. Administrators can also make their own installation package for 
distribution. 
Check the system requirements before installing the machine’s driver (See 
"System requirements" on page 2).

Remote installation
Remote Installation is provided under Administrator Installation menu. It 
is provided for administrators to remotely install device drivers and 
application software to multiple client computers. To use remote installation, 
you must configure at least one group. Multiple client computers can be 
added to a group that has the same installation configuration. Installation 
configuration includes device drivers or application software to be installed, 
port used for printing, default printer, printer name, sharing information and 
etc.

 

For remote installation, all client computers must be joined to a 
domain or a workgroup and file sharing must be enabled to be 
accessed by remote installer software on both server and client sides. 
If you cannot access the client computers, you might need to disable 
the Firewall option on the client computers.

Domain remote installation

 

You need to be a member of domain administrator to use Domain 
Remote Installation.

1. Make sure that the machine is connected to the network or USB and 
powered on.

2. Insert the supplied software CD into your CD-ROM drive.
•The software CD should automatically run and an installation window 

appears.
•If the installation window does not appear, click Start and then Run. 

Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Administrator Installation > Remote Installation.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Client Group window appears. 
6. Click New Group. 

To use remote installation, you need at least a group. If you have 
already created a group, load the group you want and go to step 16. 
•Edit Group: You can edit groups.
•Load Group: You can load groups. 
•Delete Group: You can delete groups.

7. Log on window appears. Select Domain Remote Installation and type 
in the administrator’s Domain, ID and Password. 

 

If your company has no domain network environment, you can use 
Workgroup Remote Installation (See "Workgroup Remote 
Installation" on page 2).

8. Click Next.
9. Select Clients window appears. 
10.  Type in the group name in the Group Name field.
11. Add the client computers to be in the group to the right side panel. 

 

•You can click … button to search the client computers and add 
button to add a client computer by typing the IP address or the 
computer name of client.

•You can add up to 50 client computers in a group. If you want to 
add more than 50 client computers, you need to create more 
groups. 

•If the firewall is enabled on the client computer, access may be 
denied.

•The client computer’s operating system should be Windows 2000 
or higher.

•C drive must be shared as C$.
12. Select Software and Utilities to Install window appears.

Select the driver(s) and application software(s) you want to install and 
click Next. 

13. Select Printer connection window appears. 
Select the printer connection type and click Next. 
•If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

•The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

14. Confirm Group details window appears. 
Check the group information and click Next.

 

Location to save the group shows the path of default folder 
which stores the created group information. The group information 
file will be created as “<group_name>.RGI. You can change the 
path by clicking the Change button. 

15. Select Client Group window appears again.
Administrator’s Guide (Windows only)_ 1



16. Select the group(s) and click Next to start remote installation.
Remote installation begins, you can see the installation status from the 
window. 

17. When installation is completed, Results of remote installation window 
appears. 
Check the result. For failed client computers, you can reinstall again by 
clicking the Reinstall button.

 

For failed client computers, you can check the log file which is 
created in the client computers.

Workgroup Remote Installation
You can also use remote installation method with workgroups. 
If your company has no domain network environment, you should use 
Workgroup Remote Installation.

 

If the client computer uses Windows Vista or higher, ID should be 
Administrator.

1. Make sure that the machine is connected to the network or USB and 
powered on.

2. Insert the supplied software CD into your CD-ROM drive.
•The software CD should automatically run and an installation window 

appears.
•If the installation window does not appear, click Start and then Run. 

Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Administrator Installation > Remote Installation.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Client Group window appears. 
6. Click New Group. 

To use remote installation, you need at least a group. If you have 
already created a group, load the group you want and go to step 16. 
•Edit Group: You can edit groups.
•Load Group: You can load groups. 
•Delete Group: You can delete groups.

7. Log on window appears. Select Workgroup Remote Installation and 
type in the Workgroup, ID and Password. 

 

•For Windows XP/2000/2003, the ID should be of a member of 
Administrators group for operating computers and for Windows 
Vista/2008/7, the ID should be of the default administrator 
account named Administrator. 

•You can also use Domain Remote Installation (See "Domain 
remote installation" on page 1).

8. Click Next.
9. Select Clients window appears. 
10.  Type in the group name in the Group Name field.

11. Add the client computers to be in the group to the right side panel. 

 

•You can click … button to search the client computers and add 
button to add the client computer by typing the IP address or 
the computer name of client.

•You can add up to 50 client computers in a group. If you want to 
add more than 50 client computers, you need to create more 
groups. 

•If the firewall is enabled on the client computer, access may be 
denied.

•The client computer’s operating system should be Windows 2000 
or higher.

•If you have grouped the client computers in a workgroup and you 
try to connect to the client computer, a pop up window asking 
you to enter an Administrator's ID/password of the client 
computer you selected will appear if you can't access through 
the password you set in step 7. 

•C drive must be shared as C$.
12. Select Software and Utilities to Install window appears.

Select the driver(s) and application software(s) you want to install and 
click Next. 

13. Select Printer connection window appears. 
Select the printer connection type and click Next. 
•If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next.

•The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

14. Confirm Group details window appears. 
Check the group information and click Next.

 

Location to save the group shows the path of default folder 
which stores the created group information. The group information 
file will be created as “<group_name>.RGI. You can change the 
path by clicking the Change button. 

15. Select Client Group window appears again.
16. Select the group(s) and click Next to start remote installation.

Remote installation begins, you can see the installation status from the 
window. 

17. When installation is completed, Results of remote installation window 
appears. 
Check the result. For failed client computers, you can reinstall again by 
clicking the Reinstall button.

 

For failed client computers, you can check the log file which is 
created in the client computers.
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Error log messages
Message Meaning Suggested solutions

Connection 
Error

Unable to bind the socket. 
[Port number:..]

Restart the client 
computer.

Unable to listen the 
socket. [Port number:..]

Unable to connect to the 
client computer.

Client computer’s socket is 
closed.

Setup Error Unable to access the 
default shared folder(C$) 
in the client computer.

• Check if C drive 
folder is shared as 
C$.

• Check if you can 
remotely access the 
client computer’s C$ 
folder on a network 
browser.

Unable to copy service 
files.

Check if you can 
remotely access the 
client computer’s C$ 
folder on the network 
browser.

Unable to start the service 
on the client computer.

Check whether 
RMInstallService 
program is running from 
Services. (From the 
Windows Start menu, 
select Control Panel > 
Administrative Tools > 
Services).
If RMInstallService is 
stopped then restart it 
and try remote 
installation again.
If you can't restart 
RMInstallService, then 
reboot client computer 
and try remote 
installation again.

Unable to create thread for 
monitoring.

Restart the client 
computer.

Unable to share folder on 
client computer.

Check if the shared 
folder in the client 
computer can be shared 
with full control.Unable to copy Installation 

files.

Unable to execute the 
setup file normally.

• Check if the same 
model’s installer is 
running.

• Check if the installer 
is waiting for a user 
input.

Unable to get 
profile

N/A Check if the 
environment of client 
computer is supported 
for installation.OS not 

supported

Internet 
Explorer not 
supported

MSXML not 
supported

Insufficient free 
space

Not 
Administrator

Create Customized Installer
Create Customized Installer allows administrators to create their own 
installation package with the installation setting you want. You can choose 
the drivers or software to be installed, assigned printer, printer name, 
sharing options, default printer and so on.
The created installation package can be distributed as a single 
self-extraction EXE package to clients through file servers or special 
distribution servers. You can also create an install script file for silent 
installation. 

Creating a setup package
You can create a setup package from CD to a local folder. The created 
setup package will include only selected device drivers or application.
There are two types of setup package you can create. Normal(setup.exe) 
and Self-Extraction Package. Normal(setup.exe) will extract only 
selected driver or application files from CD. Self-Extraction Package will 
package like normal installation CD package as a single self-extractable 
setup.exe file.
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

•The software CD should automatically run and an installation window 
appears.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Administrator Installation > Create Customized Installer.
If necessary, select a language from the drop-down list.

Message Meaning Suggested solutions
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4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Package Type window appears. 
Select Normal(setup.exe) or Self-Extraction Package. 
If you place the mouse cursor over the package type, you can see the 
detailed information on the bottom right side of the window. 

6. Select Software and Utilities to Install window appears.
Check the device drivers or application software you want to included in 
the setup package and click Next.

7. Select Printer connection window appears. 
Select the printer connection type and click Next. 
•If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next. 

•The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

 

If you can’t search network printers on the network then check 
whether your firewall setting is disabled. If it is enabled, disable 
firewall temporarily and try searching again.

8. Set Printer Drivers window appears. Click Next. 
If necessary, configure printer name, sharing, shared name and default 
printer setting. If you changed settings then you should click Apply 
button to apply changes then click Next.

9. Summary window appears. Check the package information and click 
Next to start creating the setup package. 
You can modify the package configuration by clicking the Back button. 

 

Check the Install the package as silent mode, if you want to 
make the installation package as a silent installation package. 
Silent installation installs the driver automatically by the set option 
without user intervention. 

10.  When creating the setup package is finished, Packaging Completed 
window appears. 
Check Open package folder upon completion if you want the created 
package to open automatically after it’s created. 

11. Click Finish. 

Creating a setup script file
You can generate setup configuration script file based on the CD image. It 
can be used with Silent installation for distributing software to multiple client 
computers. For example, you can upload a full CD setup files into a file 
server then distribute batch file or log-on script file that executes silent 
installation with this customized script file(ex: \\<file_server>\CD\setup.exe 
/s /i”c:\temp\CONFIG.CI3).
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

•The software CD should automatically run and an installation window 
appears.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.

•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Administrator Installation > Create Customized Installer.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Package Type window appears. 
Select Generate a Setup script file.
If you place the mouse cursor over the package type, you can see the 
detailed information on the bottom right side of the window. 

6. Select Software and Utilities to Install window appears.
Check the device drivers or application software you want to included in 
the setup package and click Next.

7. Select Printer connection window appears. 
Select the printer connection type and click Next. 
•If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next. 

•The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

 

•If you can’t search network printers on the network then check 
whether your firewall setting is disabled. If it is enabled, disable 
firewall temporarily and try searching again.

•Setup configuration script filename is set as CONFIG.CI3 and it’s 
not changeable.

8. Set Printer Drivers window appears. Click Next. 
If necessary, configure printer name, sharing, shared name and default 
printer setting. If you changed settings then you should click Apply 
button to apply changes then click Next.

9. Summary window appears. Check the package information and click 
Next to start creating the setup package. 
You can modify the package configuration by clicking the Back button. 

 

Check the Install the package as silent mode, if you want to 
make the installation package as a silent installation package. 
Silent installation installs the driver automatically by the set option 
without user intervention. 

10.  When creating the setup package is finished, Packaging Completed 
window appears. 
Check Open package folder upon completion if you want the created 
package to open automatically after it’s created. 

11. Click Finish. 

Modifying a setup script file
1. Make sure that the machine is connected to the network or USB and 

powered on.
2. Insert the supplied software CD into your CD-ROM drive.

•The software CD should automatically run and an installation window 
appears.

•If the installation window does not appear, click Start and then Run. 
Type X:\Setup.exe, replacing “X” with the letter which represents 
your CD-ROM drive. Click OK.
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•If you use Windows Vista, Windows 7 and Windows 2008 Server R2 
click Start > All programs > Accessories > Run.
Type X:\Setup.exe replacing “X” with the letter which represents 
your CD-ROM drive and click OK.

•If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue in the 
User Account Control windows.

•If the AutoPlay window appears in Windows 7 and Windows 2008 
Server R2, click Run Setup.exe in Install or run program field, and 
click Yes in the User Account Control windows.

3. Select Administrator Installation > Create Customized Installer.
If necessary, select a language from the drop-down list.

4. Read License Agreement, and select I accept the terms of the 
License Agreement. Then, click Next.

5. Select Package Type window appears. 
Select Modify Script.
If you place the mouse cursor over the package type, you can see the 
detailed information on the bottom right side of the window. 

6. Open the script file you want to modify(ex:CONFIG.CI3). 

 

CONFIG.CI3 script file will exist in \Setup\Script subfolder of the 
created setup package.

7. Select Printer connection window appears. 
Select the printer connection type and click Next. 
•If you selected Network Connection, Search Network Printers 

window appears, type in the IP address or host name in the 
information field than click Search. when you are finished, click 
Next. 

•The discovered printer list will show network printers on the same 
subnet. If you want to specify a network printer that is located over 
subnet then specify IP address of network printer directly.

 

•If you can’t search network printers on the network then check 
whether your firewall setting is disabled. If it is enabled, disable 
firewall temporarily and try searching again.

•Setup configuration script filename is set as CONFIG.CI3 and it’s 
not changeable.

8. Set Printer Drivers window appears. Click Next. 
If necessary, configure printer name, sharing, shared name and default 
printer setting. If you changed settings then you should click Apply 
button to apply changes then click Next.

9. Summary window appears. Check the package information and click 
Next to start creating the setup package. 
You can modify the package configuration by clicking the Back button. 

10.  When creating the setup package is finished, Packaging Completed 
window appears.
Check Open package folder upon completion if you want the created 
package to open automatically after it’s created. 

11. Click Finish. 

Silent installation Mode
Silent installation mode is an installation method that does not require any 
user intervention. Once you start the installation, the machine driver and 
software are automatically installed on you computer. You can start the 
silent installation by typing /s or /S in the command window. Silent 
installation can also be performed by using the command script file 
(See"Create Customized Installer" on page 3).

Command-line Parameters
Following table shows commands that can be used in the command window 
or in making a script file (See "Creating a setup script file" on page 4).

 

Following command-line are effective and operated when command is 
used with /s or /S. But /h, /H or /? are exceptional commands that can 
be operated solely.

Command- 
line Definition Description

/s or
/S

Starts silent installation. Installs machine drivers 
without prompting any UIs 
or user intervention.

/p”<port 
name>” or
/P”<port 
name>”

Specifies printer port.

 

Network Port will be 
created by use of 
Standard TCP/IP Port 
monitor. For local port, 
this port must exist on 
system before being 
specified by 
command.

Printer port name can be 
specified as IP address, 
hostname, USB local port 
name or IEEE1284 port 
name.
For example
•  /p”xxx.xxx.xxx.xxx” in 

where, “xxx.xxx.xxx.xxx” 
means IP address for 
network printer. 
/p”USB001”, /P”LPT1:”, 
/p”hostname”

• When installing the 
driver silently in Korean, 
type in-Setup.exe /s 
/L"0x0012” or 
Setup.exe /s /L"18” .

/l”<Lang_cod
e>” or
/L”<Lang_co
de>”

Sets language code.

 

The default language 
will be decided 
automatically if there 
is no specified 
installation language 
commanded. The 
default language 
depends on your 
system locale 
information.

Decimal number and 
hexadecimal number can 
be used but hexadecimal 
number must have prefix 
with “0X”. Refer to 
Language Codes section for 
available <Lang_code>.
This command applies to all 
machine’s drivers and 
application software if 
specified language is 
supported. All software 
included in the machine’s 
drivers will be installed as 
the specified language.
• Setup.exe /s /L"0x0012” 

or Setup.exe /s /L"18” ; 
install setup package 
silently with Korean.

/a”<dest_pat
h>” or
/A”<dest_pat
h>”

Specifies destination path 
for installation. 

 

The destination path 
should be a fully 
qualified path.

Since machine drivers 
should be installed on the 
OS specific location, this 
command applies to only 
application software.
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Language code

/i”<script 
filename>” or
/I”<script 
filename>”

Specifies customized install 
script file for custom 
operation.

 

The script filename 
should be a fully 
qualified filename.

Customized script file can 
be assigned for customized 
silent installation. This script 
file can be created or 
modified through provided 
installer customizing utility 
or by text editor.
Note: This customized 
script file is prior than 
default installer setting in 
setup package but not prior 
than command-line 
parameters.

/n”<Printer 
name>” or
/N”<Printer 
name>”

Specifies printer name. 
Printer instance shall be 
created as specified printer 
name.

With this parameter, you 
can add printer instances as 
your wishes.

/nd or
/ND

Commands not to set the 
installed driver as a default 
machine driver.

It indicates installed 
machine driver will not be 
the default machine driver 
on your system if there are 
one or more printer drivers 
installed. If there is no 
installed machine driver on 
your system, then this 
option won’t be applied 
because Windows OS will 
set installed printer driver as 
a default machine driver.

/x or
/X

Uses existing machine 
driver files to create printer 
instance if it is already 
installed.

This command provides a 
way to install a printer 
instance that uses installed 
printer driver files without 
installing an additional 
driver.

/up”<printer 
name>” or
/UP”<printer 
name>”

Removes only specified 
printer instance and not the 
driver files.

This command provides a 
way to remove only 
specified printer instance 
from your system without 
effecting other printer 
drivers. It will not remove 
printer driver files from your 
system. 

/d or
/D

Uninstalls all device drivers 
and applications from your 
system.

This command will remove 
all installed device drivers 
and application software 
from your system.

/v”<share 
name>” or
/V”<share 
name>”

Shares installed machine 
and add other available 
platform drivers for Point & 
Print.

It will install all supported 
Windows OS platform’s 
machine drivers to system 
and share it with specified 
<share name> for point and 
print.

Command- 
line Definition Description

/o or 
/O

Opens Printers and Faxes 
folder after installation.

This command will open 
Printers and Faxes folder 
after the silent installation.

/f”<log 
filename>” or
/F”<log 
filename>”

Specifies log filename.
The default log file is 
created in the system temp 
folder if not specified.

It will create a log file to a 
specified folder.

/h, /H or /? Shows Command-line 
Usage.

Code Language

0X0009 English

0X0012 Korean

0X0804 Simplified Chinese

0X0404 Traditional Chinese

0x040c French

0X0007 German

0X0010 Italian

0X000a Spanish

0X0013 Dutch

0X001D Swedish

0X0006 Danish

0X000b Finnish

0X0014 Norwegian

0X0019 Russian

0X0005 Czech

0X000e Hungarian

0X0008 Greek

0X0816 Standard Portuguese

0X0416 Brazilian Portuguese

0X0015 Polish

0X001F Turkish

0X0001 Arabic

0X000D Hebrew

0x0424 Slovenian 

0X0418 Romanian 

0X0402 Bulgarian 

0X041A Croatian 

0X081A Serbian 

Command- 
line Definition Description
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Frequently Asked Question
Remote Installation related questions

No. Question Answer

1 Client computers are not 
listed in the list when 
logging on as a domain.

Primary DNS address in all client 
computers should be specified as 
your domain server.
If the client computer is turned off, 
turn it on.

2 “Cannot access” error 
message appears during 
workgroup remote 
installation.

This error message appears if access 
was denied. You should check the 
settings of network access; sharing 
and security model for local accounts.
• From the Windows Start menu, 

click Control Panel > 
Administrative Tools >Local 
Security Policy > Local Policies 
> Security Options > Network 
access: Sharing and security 
model for local accounts.

• If the setting is not Classic – local 
users authenticate as 
themselves, change it to Classic 
– local users authenticate as 
themselves.

3 “Cannot access” error 
message appears during 
domain / workgroup 
remote installation

Check if the C drive folder is shared.
C Drive folder should be shared as 
C$ to access remote client 
computers.

Create Customized Installer related questions
No. Question Answer

1 When I try to open the 
CONFIG.CI3 script file, 
the files doesn’t open and 
a warning message pops 
up.

When the Custom utility opens the 
config.ci3 script file, it checks 
manufacture, model and script file 
type. Check the <MFG>,<MDL> node 
of the file you want to open, and if 
<SCRIPT_TYPE> value is ‘Config’.

2 I cannot precede the next 
step at Search Network 
Printer dialog.

It checks if the IP address/hostname 
is valid or not. You can specify only 
the IP address/hostname which is 
connected via network currently. 
Check the connection status of the 
printer to specify.

3 When I execute the 
customized installer 
package, the welcome 
dialog appears and I need 
to select the options 
again.

If you want to install as silent mode, 
check the Install the package as 
silent mode check box in the 
Summary window.

0X0422 Ukraine 

0X041B Slovakia 

0X0421 Indonesian 

0x041E Thai

0X0429 Farsi

Code Language
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contact samsung worldwide
If you have any comments or questions regarding Samsung products, contact the Samsung customer care center.

Country/Regio
n Customer Care Center Web Site

ARGENTINE 0800-333-3733 www.samsung.com/ar

AUSTRALIA 1300 362 603 www.samsung.com/au

AUSTRIA 0810-SAMSUNG (7267864, 
€ 0.07/min)

www.samsung.com/at

BELARUS 810-800-500-55-500 www.samsung.ua
www.samsung.com/ua_r
u

BELGIUM 02 201 2418 www.samsung.com/be 
(Dutch)
www.samsung.com/be_fr 
(French)

BRAZIL 0800-124-421
4004-0000

www.samsung.com/br

CANADA 1-800-SAMSUNG 
(726-7864)

www.samsung.com/ca

CHILE 800-SAMSUNG (726-7864) www.samsung.com/cl

CHINA 400-810-5858
010-6475 1880

www.samsung.com/cn

COLOMBIA 01-8000112112 www.samsung.com.co

COSTA RICA 0-800-507-7267 www.samsung.com/latin

CZECH 
REPUBLIC

800-SAMSUNG 
(800-726786)

www.samsung.com/cz

Samsung Zrt., česká organizační složka, Oasis Florenc, 
Sokolovská394/17, 180 00, Praha 8

DENMARK 8-SAMSUNG (7267864) www.samsung.com/dk

ECUADOR 1-800-10-7267 www.samsung.com/latin

EL SALVADOR 800-6225 www.samsung.com/latin

ESTONIA 800-7267 www.samsung.com/ee

KAZAKHSTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

KYRGYZSTAN 00-800-500-55-500

FINLAND 30-6227 515 www.samsung.com/fi

FRANCE 01 4863 0000 www.samsung.com/fr

GERMANY 01805 - SAMSUNG 
(726-7864 € 0,14/min)

www.samsung.de

GUATEMALA 1-800-299-0013 www.samsung.com/latin

HONDURAS 800-7919267 www.samsung.com/latin

HONG KONG 3698-4698 www.samsung.com/hk
www.samsung.com/hk_e
n/

HUNGARY 06-80-SAMSUNG 
(726-7864)

www.samsung.com/hu

INDIA 3030 8282
1800 110011
1800 3000 8282 

www.samsung.com/in

INDONESIA 0800-112-8888 www.samsung.com/id

ITALIA 800-SAMSUNG (726-7864) www.samsung.com/it

JAMAICA 1-800-234-7267 www.samsung.com/latin

JAPAN 0120-327-527 www.samsung.com/jp

LATVIA 8000-7267 www.samsung.com/lv

LITHUANIA 8-800-77777 www.samsung.com/lt

LUXEMBURG 02 261 03 710 www.samsung.com/lu

MALAYSIA 1800-88-9999 www.samsung.com/my

MEXICO 01-800-SAMSUNG 
(726-7864)

www.samsung.com/mx

MOLDOVA 00-800-500-55-500 www.samsung.ua
www.samsung.com/ua_r
u

NETHERLANDS 0900-SAMSUNG 
(0900-7267864) (€ 
0,10/min)

www.samsung.com/nl

NEW ZEALAND  0800 SAMSUNG (0800 726 
786)

www.samsung.com/nz

NICARAGUA 00-1800-5077267 www.samsung.com/latin

NORWAY 3-SAMSUNG (7267864) www.samsung.com/no

PANAMA 800-7267 www.samsung.com/latin

PHILIPPINES 1800-10-SAMSUNG 
(726-7864)
1-800-3-SAMSUNG 
(726-7864)
1-800-8-SAMSUNG 
(726-7864)
02-5805777

www.samsung.com/ph

POLAND 0 801 1SAMSUNG 
(172678)
022-607-93-33

www.samsung.com/pl

Country/Regio
n Customer Care Center Web Site
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PORTUGAL 80820-SAMSUNG 
(726-7864)

www.samsung.com/pt

PUERTO RICO 1-800-682-3180 www.samsung.com/latin

REP. DOMINICA 1-800-751-2676 www.samsung.com/latin

EIRE 0818 717 100 www.samsung.com/ie

RUSSIA 8-800-555-55-55 www.samsung.ru

SINGAPORE 1800-SAMSUNG 
(726-7864)

www.samsung.com/sg

SLOVAKIA 0800-SAMSUNG 
(726-7864)

www.samsung.com/sk

SOUTH AFRICA 0860 SAMSUNG 
(726-7864)

www.samsung.com/za

SPAIN 902-1-SAMSUNG(902 172 
678)

www.samsung.com/es

SWEDEN 0771 726 7864 
(SAMSUNG)

www.samsung.com/se

SWITZERLAND 0848-SAMSUNG (7267864, 
CHF 0.08/min)

www.samsung.com/ch

TADJIKISTAN 8-10-800-500-55-500

TAIWAN 0800-329-999 www.samsung.com/tw

THAILAND 1800-29-3232
02-689-3232

www.samsung.com/th

TRINIDAD & 
TOBAGO

1-800-SAMSUNG 
(726-7864)

www.samsung.com/latin

TURKEY 444 77 11 www.samsung.com/tr

U.A.E 800-SAMSUNG (726-7864)
8000-4726

www.samsung.com/ae

U.K 0845 SAMSUNG 
(726-7864)

www.samsung.com/uk

U.S.A 1-800-SAMSUNG 
(7267864)

www.samsung.com/us

UKRAINE 8-800-502-0000 www.samsung.ua
www.samsung.com/ua_r
u

UZBEKISTAN 8-10-800-500-55-500 www.samsung.com/kz_ru

VENEZUELA 0-800-100-5303 www.samsung.com/latin

VIETNAM 1 800 588 889 www.samsung.com/vn
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glossary
 

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as well 
as mentioned in this user’s guide.

802.11
802.11 is a set of standards for wireless local area network (WLAN) 
communication, developed by the IEEE LAN/MAN Standards 
Committee (IEEE 802). 

802.11b/g
802.11b/g can share same hardware and use the 2.4 GHz band. 
802.11b supports bandwidth up to 11 Mbps; 802.11g up to 54 Mbps. 
802.11b/g devices may occasionally suffer interference from microwave 
ovens, cordless telephones, and Bluetooth devices. 

Access point
Access Point or Wireless Access Point (AP or WAP) is a device that 
connects wireless communication devices together on wireless local 
area networks (WLAN), and acts as a central transmitter and receiver of 
WLAN radio signals. 

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine can 
scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc for 
computer networking. It was included in the original Macintosh (1984) 
and is now deprecated by Apple in favor of TCP/IP networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher color 
depth gives a broader range of distinct colors. As the number of bits 
increases, the number of possible colors becomes impractically large for 
a color map. 1-bit color is commonly called as monochrome or black and 
white.

BMP
A bitmapped graphics format used internally by the Microsoft Windows 
graphics subsystem (GDI), and used commonly as a simple graphics file 
format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the bootstrap 
process of computers or operating systems running on them. The 
BOOTP servers assign the IP address from a pool of addresses to each 
client. BOOTP enables 'diskless workstation' computers to obtain an IP 
address prior to loading any advanced operating system.

CCD
Charge Coupled Device (CCD) is a hardware which enables the scan 
job. CCD Locking mechanism is also used to hold the CCD module to 
prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in front of 
the machine. 

Coverage
It is the printing term used for a toner usage measurement on printing. 
For example, 5% coverage means that an A4 sided paper has about 5% 
image or text on it. So, if the paper or original has complicated images or 
lots of text on it, the coverage will be higher and at the same time, a 
toner usage will be as much as the coverage.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used to 
exchange data between disparate applications. The file format, as it is 
used in Microsoft Excel, has become a de facto standard throughout the 
industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that will 
automatically feed and turn over an original sheet of paper so that the 
machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its box 
state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration parameters 
specific to the DHCP client host requesting, generally, information 
required by the client host to participate on an IP network. DHCP also 
provides a mechanism for allocation of IP addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing data, 
received fax data.
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DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on networks, 
such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print head 
that runs back and forth on the page and prints by impact, striking an 
ink-soaked cloth ribbon against the paper, much like a typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone line to 
answer several different telephone numbers.

Duplex
A mechanism that will automatically turn over a sheet of paper so that 
the machine can print (or scan) on both sides of the paper. A printer 
equipped with a Duplex Unit can print on both sides of paper during one 
print cycle.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan limitation 
such as pages per year. The lifespan means the average capacity of 
print-outs, usually within the warranty period. For example, if the duty 
cycle is 48,000 pages per month assuming 20 working days, a printer 
limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built into 
Class 1 fax machines or fax modems. It automatically detects and 
corrects errors in the fax transmission process that are sometimes 
caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results as 
another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, which is 
in contrast to simulation, which concerns an abstract model of the 
system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the physical 
layer, and frame formats and protocols for the media access control 
(MAC)/data link layer of the OSI model. Ethernet is mostly standardized 
as IEEE 802.3. It has become the most widespread LAN technology in 
use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is now 
deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine to 
allow a third party device such as a coin operated device or a card 
reader. Those devices allow the pay-for-print service on your machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that fuses the toner onto the print media. It 
consists of a heat roller and a pressure roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure that 
the toner stays on the paper permanently, which is why paper is warm 
when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer or a 
network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are represented 
by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of dots. 
Highly colored areas consist of a large number of dots, while lighter 
areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or hard 
disk, is a non-volatile storage device which stores digitally-encoded data 
on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the advancement 
of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" refers to 
a specific connector type on the end of the parallel cable that attaches to 
the peripheral (for example, a printer). 
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Intranet
A private network that uses Internet Protocols, network connectivity, and 
possibly the public telecommunication system to securely share part of 
an organization's information or operations with its employees. 
Sometimes the term refers only to the most visible service, the internal 
website.

IP address
An Internet Protocol (IP) address is a unique number that devices use in 
order to identify and communicate with each other on a network utilizing 
the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a printer 
can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and so 
forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing solution 
than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives from 
national standards bodies. It produces world-wide industrial and 
commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international radio 
and telecommunications. Its main tasks include standardization, 
allocation of the radio spectrum, and organizing interconnection 
arrangements between different countries to allow international phone 
calls. A -T out of ITU-T indicates telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.

JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 

compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It is the 
format used for storing and transmitting photographs on the World Wide 
Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that indicates 
the status of a machine.

MAC address
Media Access Control (MAC) address is a unique identifier associated 
with a network adapter. MAC address is a unique 48-bit identifier usually 
written as 12 hexadecimal characters grouped in pairs (e. g., 
00-00-0c-34-11-4e). This address is usually hard-coded into a Network 
Interface Card (NIC) by its manufacturer, and used as an aid for routers 
trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes the 
following functionality in one physical body, so as to have a printer, a 
copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax machines 
to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to efficiently 
compress white space. As most faxes consist mostly of white space, this 
minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital information, 
and also demodulates such a carrier signal to decode transmitted 
information.

MR
Modified Read (MR) is a compression method recommended by ITU-T 
T.4. MR encodes the first scanned line using MH. The next line is 
compared to the first, the differences determined, and then the 
differences are encoded and transmitted.
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NetWare
A network operating system developed by Novell, Inc. It initially used 
cooperative multitasking to run various services on a PC, and the 
network protocols were based on the archetypal Xerox XNS stack. 
Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a virtual 
image for print using a laser beam emitted from a laser printer, and it is 
usually green or rust colored and a cylinder shaped. 
An imaging unit containing a drum slowly wears the drum surface by its 
usage in the printer, and it should be replaced appropriately since it gets 
worn from grits of a paper and the drum cleaning blade.

Originals
The first example of something, such as a document, photograph or text, 
etc, which is copied, reproduced or translated to produce others, but 
which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for communications. 
OSI offers a standard, modular approach to network design that divides 
the required set of complex functions into manageable, self-contained, 
functional layers. The layers are, from top to bottom, Application, 
Presentation, Session, Transport, Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic telephone 
switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL has 
been released in varying levels for thermal, dot matrix printer, and 
xerographic printers.

PDF
Portable Document Format (PDF) is a proprietary file format developed 
by Adobe Systems for representing two dimensional documents in a 
device independent and resolution independent format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing areas. - 
that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the computer 
to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which can 
be used in a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for determining 
how fast a printer works, meaning the number of pages a printer can 
produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with the 
device driver using standard input/output system calls, which simplifies 
many tasks. 

Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of the 
world's public circuit-switched telephone networks which, on industrial 
premises, is usually routed through the switchboard.

RADIUS
Remote Authentication Dial In User Service (RADIUS) is a protocol for 
remote user authentication and accounting. RADIUS enables 
centralized management of authentication data such as usernames and 
passwords using an AAA (authentication, authorization, and accounting) 
concept to manage network access.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied to 
share files, printers, serial ports, and miscellaneous communications 
between nodes on a network. It also provides an authenticated 
Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a client-server 
protocol, where the client transmits an email message to the server.

SSID
Service Set Identifier (SSID) is a name of a wireless local area network 
(WLAN). All wireless devices in a WLAN use the same SSID in order to 
communicate with each other. The SSIDs are case-sensitive and have a 
maximum length of 32 characters.
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Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and which 
part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol (IP); 
the set of communications protocols that implement the protocol stack 
on which the Internet and most commercial networks run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible and 
platform-independent format can be used for pictures that have been 
made by various image processing applications.

Toner Cartridge
A kind of bottle or container within a machine like a printer which 
contains toner. Toner is a powder used in laser printers and 
photocopiers, which forms the text and images on the printed paper. 
Toner can be fused by the heat of the fuser, causing it to bind to the 
fibers in the paper.

TWAIN
An industry standard for scanners and software. By using a 
TWAIN-compliant scanner with a TWAIN-compliant program, a scan can 
be initiated from within the program.; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access network 
shares in Window NT and other Microsoft products. The format of a 
UNC path is: \\<servername>\<sharename>\<Additional directory>

URL
Uniform Resource Locator (URL) is the global address of documents 
and resources on the Internet. The first part of the address indicates 
what protocol to use, the second part specifies the IP address or the 
domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and peripherals. 
Unlike the parallel port, USB is designed to concurrently connect a 
single computer USB port to multiple peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that appears 
lighter when viewed by transmitted light. Watermarks were first 
introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WEP
Wired Equivalent Privacy (WEP) is a security protocol specified in IEEE 
802.11 to provide the same level of security as that of a wired LAN. WEP 
provides security by encrypting data over radio so that it is protected as 
it is transmitted from one end point to another.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that is 
originally introduced in Windows Me and Windows XP. A scan can be 
initiated from within these operating systems by using a WIA-compliant 
scanner.

WPA
Wi-Fi Protected Access (WPA) is a class of systems to secure wireless 
(Wi-Fi) computer networks, which was created to improve upon the 
security features of WEP.

WPA-PSK
WPA-PSK (WPA Pre-Shared Key) is special mode of WPA for small 
business or home users. A shared key, or password, is configured in the 
wireless access point (WAP) and any wireless laptop or desktop 
devices. WPA-PSK generates a unique key for each session between a 
wireless client and the associated WAP for more advanced security.

XPS
XML Paper Specification (XPS) is a specification for a Page Description 
Language (PDL) and a new document format, which has benefits for 
portable document and electronic document, developed by Microsoft. It 
is an XML-based specification, based on a new print path and a 
vector-based device-independent document format.
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